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Abstract

This practice-led research focuses on developing a method of  building knitted 
surface topographies using links-links stitch structures and the knitting technique 
of  inlay. The knitted surface topography builds on the dynamic and fluid nature 
of  knitting, where materials, making and maker absorb and translate properties 
from surrounding environments and interactions. A knitted surface is an entity 
constructed through a series of  singular movements; stitch by stitch, the knit and 
the inlay pattern assemble in tandem, resulting in a hybrid surface. A single point 
builds the multiple to inform a collective surface reliant on neighbouring linkages. 
Layers interconnect during the making, and dominant material forces alter the 
knitted surface plane. Weave and knit are embedded digitally and physically in 
an inlay surface. The assembled material performances inherited from the hybrid 
textile technique are visible in the folded fragmentation of  the knitted surfaces. 
Material agency folds and unfolds to reveal hidden inlay patterning, as intersecting 
material forces collide. These oppositional conditions increase the tactility of  a 
knitted surface, providing opportunities for haptic navigation of  the fractured textile 
terrain, allowing the hand to read what the eye omits.

This research follows a digital-craft creative process embracing textile design 
methods of  repetition, traditional weave patterns and digital machine knit tacit 
knowledge. An alliance forms during the making between designer, materials 
and technology. A mode of  making develops, resulting in a temporal practice 
approach, designing with rather than against the heterogeneous knitted surface 
dynamics; the programmed materiality results in linear distortion through inlay 
pattern subtraction and link-links ground interactions. The compositional inlay 
placements further disrupt the knitted surface, exposing pattern traces that map 
material forces. This research journey asks the question: How can the hybrid knit-
weave technique, inlay, be used as an ontological investigative medium into built, 
knitted surface topographies through the assemblage of  heterogeneous material 
forces? The significance of  knitted surface is examined, as alternative approaches to 
making encounter visible and invisible material dynamics that inform topographical 
terrains.
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1.1 Introduction 

Part of  the mystery and beauty of  knitting is the unpredictability of  the medium. 
As a digital knit designer, I seek to harness this unstructured physical characteristic 
through structured coding. This design practice aims to embrace the temporality of  
surface (Bruno, 2020) through encounters with the material dynamics of  knitting. 
The knitted surface is unique, an emergent construction viewed in this research 
as active matter encountered through the links-links and inlay knitting techniques. 
Anthropologist Tim Ingold (2018) asks, “what if  surfaces are the real sites for the 
generation of  meaning?” (p. 137). This perspective of  the knitted ground as a 
site of  critical knowledge relates to an intended interpretation of  these surfaces. 
The textile terrains become materialisations of  knitted surface knowledge used as 
investigative vehicles to answer the research question: How can the hybrid knit-
weave technique, inlay, be used as an ontological investigative medium into built, 
knitted surface topographies through the assemblage of  heterogeneous material 
forces?

This technique-led research is a tactile surface exploration informed by intuitive 
design responses rather than presented as a scientific or mathematical thesis. 
Frameworks central to this practice-led research include: the links-links and inlay 
knitting techniques, materiality, a craft to digital aspect, the singular to the multiple 
and knitted assemblage of  material forces. This practice operates at the edges of  
the design capabilities of  inlay knitting technologies; a location where the technical 
influences design, and the design extends technical applications (Power, 2007). 
The surfaces generated are intended to add to knowledge in the field of  digital 
knitting, specifically instigating conversation around alternative modes of  thinking 
about, and making for knitted surfaces. Multiple textile design approaches are 
incorporated to generate a hybrid crafting (Golsteijn et al., 2014) process. Hybrid 
crafting blends digital and physical design methods to explore the surface effects of  
size, scale and repeating patterns on the assembled material agency.  

Chapter 1: Introducing the Journey

Inherent to a thread is the possibility to be transformed into myriad 
textures and shapes. A thread is pure potential, a kind of  possibility 
space for bringing any kind of  (knitted) surface about – within the 
limits of  the thread’s textile qualities. In knitting we are thus working 
with a continually reconfigurable creativity. (Arantes, 2020a, p. 161)
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Inlay knitting involves the insertion of  an additional yarn, laid horizontally across 
knitted loops. In 2015 the Japanese company Shima Seiki Manufacturing Limited 
developed a specifically designed weft-insertion knitting machine; the N.SRYLP. 
Although inlay as a textile technique has historical roots, digital technologies have 
only recently embraced this as an industrialised construction method. An inlay 
knitted surface inherits characteristics from both textile methods, the knit and the 
weave, exhibiting emergent hybrid material properties. This research considers a 
design approach utilising the assemblage of  heterogenous factors that transform 
each other. A surface through layered, disruptive material forces such as the 
oppositional forces that occur inherently between a knitted stitch and inserted inlay 
yarn. Additional material forces come into play with the inclusion of  yarn varieties 
such as merino, cotton and heat-reactive Pemotex yarn, selected for their inherent 
physical attributes that collaboratively unfold through surface positioning. 

This research aims to design complex knitted surfaces which manipulate material 
forces occurrent between links-links and inlay knitting techniques. The practice 
considers the positioning of  layered singular and multiple design elements, 
studying the effect of  material forces on the agency of  the knitted surface. “Surface 
especially matters as a site in which different forms of  mediation, transfer and 
transformation can take place” (Bruno, 2020, p. xiv). The surface fragmentations 
are constructed stitch-loop by stitch-loop, layered with inlay picks and floats. 
These programmed interactions realign single components, forming alliances with 
neighbouring points (Arantes, 2020a). This practice endeavours to operate in a 
making environment that encourages the stitch structure behaviours and yarns 
to speak for themselves (Albers, 1957). Multiple sections of  interactivity generate 
tangible and intangible design elements programmed to explore dichotomies of  
visible and invisible material forces (Lee, 2020). 

Interpretations of  landscapes from the Coromandel Peninsula, in New Zealand 
inspired the study of  foundational material forces between a built knitted stitch 
and inlay pick. A landscape consists of  elevated, lowered and level landforms 
which exist due to processes and materials that originate in the Earth’s interior 
and surface (Peterson et al., 2017, p. 385).  Landscape imagery sourced from my 
grandmother’s farm located in Te Kouma, Coromandel facilitates exploration of  
surface alliances using a layered design process integrating digital and physical 
making environments. In the knitting process, a built terrain enfolds into the 
artefact; traces of  the act of  making (Ingold, 2016) inform patterned pathways, 
concealed and revealed as knitted surface disruptions unfold. Academic Catherine 
Dormor (2020) notes, “it is in the encounter with the other within the space of  the 
fold that an expression of  that other is created. As one element folds onto its other 
self, its multiplicity and capacity become revealed” (pp. 12–13). Intricate design 
details influenced by traditional weave patterning are used to reveal programmed 
behaviours, emergent as material performers in the act of  making.  
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These knitted surfaces allow viewers to engage haptically as fingers read the knitted 
tactility. The term haptics is derived from the Greek haptikos, meaning able to 
touch.  The physical qualities of  a surface perceived through touch are significantly 
different to those attained through other senses (Prytherch & McLundie, 2002). 
Throughout this research journey, one particular inlay prototype became my 
touchstone knitted surface (Figure 1) providing a tactile focus as I followed the 
tributaries of  my practice. “Our experience of  textiles is sensory, felt and lived 
as much as conceptualised” (Philpott, 2011, p. 101). This prototypes tactility 
epitomised the fragmented movements and encoded material alliances I sought to 
enfold into my knitted surface topographies. The surface tactility of  this sample 
acted as a reminder of  the importance of  haptics within my creative practice 
(Treadaway, 2007). “It is the combination of  kinaesthetic and tactile information 
supplied from hand to brain, blended with sensory information from the visual 
system that enables imaginative thought to occur” (Prytherch & McLundie, 2002, 
p. 37). Utilising a sense of  touch to include haptics as a relational mode encouraged
navigation of  the knitting through reciprocal surface contact (Bruno, 2020).
Although I will exhibit my final surfaces, Metamorphic Series, as proof  of  practice
(refer to Chapter Five, Emergent Terrains), these knitted surface topographies are
perceived not as art; instead, they exist as a personification of  personal knowledge
and an expression of  knitted surface poetics present in a haptic interface.

Figure 1. The touchstone inlay knitted surface topography.
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1.2 Positioning the Researcher

This practice builds on apparel-based knowledge from the perspective of  a 
knitwear designer and lecturer in fashion and textiles disciplines. Before becoming a 
university lecturer, I worked as a knitwear designer and production manager in the 
New Zealand fashion industry. Authors Christopher Crouch and Jane Pearce (2012) 
suggest that “our research position knowingly or unknowingly, underpins all our 
research” (p. 57). This research is reflective of  career experiences,  personality and 
previous textile knowledge. Before undertaking this research, my Shima Seiki Apex-
3 software programming skills focused on stitch structures, jacquards, and shaping. 
Former research investigated seamlessly knitted oversized silhouettes and miniature 
forms. Although I had previous programming experience, none engaged with the 
inlay knitting technique or constructed large scale knitted outputs. Taking on a 
technical role when running the inlay knitting machine often generated challenges 
due to limited input by industry trained technicians. Personal methods of  
engagement with knitting’s two-dimensional and three-dimensional environments 
altered the research trajectory, unfolding as a knowledge building and personal 
development experience. 

1.3 Aims and Objectives 

This research aims to shift the focus for knitted textiles from three-dimensional 
form to the designed surface environment through the generation of  knitted surface 
topographies. The usual focus of  knitted outputs is the ability to cover the body as a 
shaped form. However, the emphasis of  this project shifted to the built surfaces, as 
they provided a larger expanse through which to showcase the interactions of  link-
links ground and inlay knitting techniques. These surfaces are engineered to reveal 
the complex material agency between the inlay knitting, links-links stitch structures, 
materials and technology during the design process. This research is a practice-
led investigation of  knitting techniques intended to extend design opportunities 
beyond the recognisable all-over single bed inlay application. Multiple inlay surface 
possibilities are considered through a series of  knitted surface topographies to assess 
intrinsic knitted material forces and act as a means of  corralling the boundaries of  
the investigation.

These knitted surface topographies introduce an alternative design space for 
creative interaction with inlay knitting through the development of  a mode of  
making that harnesses the structured and unstructured aspects of  knitted stitch 
structures. Through prototyping, the objective is to develop an approach to a 
knitting technique that embraces the material agency of  links-links and inlay 
during surface construction. These prototypes are methods to answer questions 
such as: how can these surface movements be manipulated and controlled through 
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considered design to harness the nature of  the knitted surface’s material forces, and 
how does the scale of  the knitted ground and inlay patterning affect the interactions 
of  the material forces? Manipulation of  material agency (Bolt, 2007) is proposed 
as an alternative approach to knitted surface generation demonstrating how the 
assemblage and scale of  links-links stitch structures and inlay patterning can 
construct active topographies with multiple differences. Numerous variables within 
the knitting process allow the materials and technology to independently influence 
the knitted surface outputs.

Through this research, it is proposed that designers who profoundly understand 
technical programming of  digital knitting can extend their creative practice 
through collaborative design with the technology. Academics Amy Cheatle and 
Steven Jackson (2014) note:

Rather than suggesting that technology is serving the needs of  the artist, 
we can argue that artists and their digital fabrication tools are engaged 
in creative entanglements of  flow where technology and human making 
expand and inform one another. (p. 967)

An essential aim of  this practice is to identify and understand the technical-design 
fulcrum. Digital to physical realms are extended through a series of  practice-led 
experimentations to discover potential technological constraints on the knitting 
design process. This research aims to operate at the edges of  this uncovered cusp, 
incorporating the limits of  the inlay knitting technology into surface designs.

The purpose of  this research is to investigate an alternative making approach, and 
through that foster a making space that encourages less traditional perspectives 
of  knitted surface, the results of  which could appeal to a broader range of  
designers. This research knowledge is intended to be used by makers situated 
outside of  the direct field of  digital knit. Knit specific terminology is generally 
used in the knitwear industry to convey technical information for production. 
Geomorphological terminology is included in this research to interpret and analyse 
the knitted surface activity, offering a more descriptive discourse to encapsulate the 
knitted surface movements.

1.4 Methodological Overview

Textile designers bring a range of  practical skills and tacit knowledge to research 
that are unique to their discipline, a specific blend of  experience amassed from 
the fields of  design, art, craft and technology (Igoe, 2010). This research uses a 
plethora of  textile approaches to afford manipulation of  techniques and “materials 
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in unfamiliar ways or within new contexts” (Marr & Hoyes, 2016, p. 8). Theorist 
Michael Polanyi, in The tacit dimension (1967), describes this tacit knowing as “we 
can know more than we can tell” (p. 4). Hybrid textile making methods fostered 
dynamic exploration and multi-disciplinary perspectives during the evolution of  the 
knitted surface designs and acquisition of  new knowledge in this research. 

In Chapters Two and Three, a hybrid digital-crafting methodology is discussed. 
However, deeper discussions on methods utilised are located throughout Chapters 
Four and Five, while discussing making aspects which respond to the evolving 
practice. This research journey followed a practice-led pathway allowing the knit 
practice to unfold rather than be dictated by preconceived ideas (Philpott, 2011). 
Retrospective analysis of  the making established robust connections between 
the evolving theoretical concepts and practice. In this respect, the research 
project morphed, enriched by a layering of  knowledge. Questions central to the 
practice revealed and concealed themselves. Relationships between ideas formed, 
informed and re-formed, as a hybrid approach blending digital and analogue 
making processes evolved. Using hybrid making methods “does not simply tolerate 
difference but cultivates it as a spark to researcher creativity” (Kincheloe, 2001, p. 
687). This practice combines digital methods of  making from textile and fashion 
design disciplines to generate new knowledge and understanding, integrating inlay 
knitting techniques and knitted material forces. 

This research involves reframing the dichotomy between craft and technology, 
or analogue and digital (Adamson, 2018). The creative process followed a cyclic 
approach, with and against the technology, with and against the design. Each 
of  these factors altered how the other evolved and resolved as I sought the outer 
capability limits of  the inlay knitting technologies. In my creative process, the 
ability to see the curve, to interpret scale and codes as knitted stitches were essential 
factors contributing to a seamless shift of  perspectives from virtual to physical. This 
approach embraced tacit knowledge (Polanyi, 1967; Schön, 1983), where through 
intuitive interaction, the technology became an extension of  myself  and co-
creator. As the research evolved, I emerged as an informed practitioner-researcher, 
following a process of  reflection-in-action and reflection-on-action (Schön, 1983).

Through technique-led prototyping, a hybrid making method incorporating 
multiple digital and physical design aspects was established. Manipulation of  
surface material forces was explored through interpretations of  traditional weave 
designs, repeating stitch structures, scaled patterns and sectional subtractive 
techniques. The assembled interactions of  these design factors informed the 
development of  a surface-block building system, resulting in a layered mode of  
making for knitted surface topographies. The knitted surfaces interpreted the 
Coromandel landscapes as abstracted representations of  the original layered 
terrains. Understanding of  positioned active material forces emerged as physical 



7

knitted terrains, building the knitted surface topography stitch by stitch, resulting in 
crafted disruptions.

1.5 Outline of Thesis

Chapter Two, Traversing the Scope reviews the inlay knitting technique from historical, 
industry usage, design and technological perspectives. The research examines 
surface, knitting, traditional weave patterns, materiality and material forces through 
a literature review. This chapter also considers how theoretical discourse regarding 
assemblage, singular and multiple have influenced the research context.

Chapter Three, Crafting a Knit Framework, outlines the methodological process and 
methods that developed in connection to geomorphological terminology during 
this technique-led practice. Textile design methods for knitted surface generation 
are used to assess the effect of  scale, size and repeating patterns on the interrelated 
material forces. Surface-building blocks and the mode of  making that transpired 
during the research journey are discussed. The researcher’s positioning addresses 
the notion of  tacit know-how and the impact of  interdisciplinary knowledge on the 
design practice.  

Chapter Four, Planes of  Technique, discusses emergent theoretical and practice-led 
strands of  this research. This chapter looks at digital-to-physical engagement with 
links-links stitch structures and inlay knitting technique, and assemblage of  material 
forces resulting in the emergence of  the surface-building blocks. Knitted surfaces 
are generated from photographic imagery using textile print design techniques. 
Through prototyping, analysis and reflection of  material forces, surface-building 
blocks are devised to construct the knitted surface topography.

Chapter Five, Emergent Terrains, applies and expands the acquired knowledge 
from the initial inlay surface practice. The mode of  making for knitted surface 
topographies is developed further and tested using a photographic image to 
generate a series of  knitted terrains. Technical constraints of  the inlay knitting 
machine are identified as the size of  the surfaces push the technology to uncover 
further design potentiality. This research practice culminates in the exhibition 
of  the Metamorphic Series, a five-panel collective landscape demonstrating 
application of  the mode of  making on a larger scale. 

Chapter Six, Unfolded Findings, reflects on the accumulated key research outcomes 
and contribution of  this practice to the field of  digital knitting from a design 
and technical perspective. This chapter concludes the thesis with a discussion of  
potential uses for the developed mode of  making, future research directions and 
industry applications for inlay knitted surfaces.
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1.6 Conclusion

The Introduction chapter has outlined the basic concepts and understandings behind 
this research, and key research questions, aims and applications. This research is a 
journey of  hybridity, blending knit-weave, digital-craft and digital-physical design 
aspects into dynamic knitted surface topographies. Each element touched on in this 
chapter will be explored further, and the entwined connections unfolded during 
practice discussions throughout the exegesis.
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2.1 Introduction

This chapter provides a framework for this study, connecting technical aspects with 
design aspects and practice with theory. Foremost, this research engages with two 
interconnected areas of  focus; the inlay and links-links knitting techniques and the 
emergent knitted surface. This technique-led practice applies the inlay technique 
through a surface medium to investigate designing with material forces which 
links-link stitch structures generate. An understanding of  knitting technologies 
is essential to comprehending generated inlay knitted surfaces. This contextual 
review navigates inlay knitting from a historical and contemporary viewpoint, a 
digital-craft perspective, and explains relevant technical-design aspects of  the inlay 
knitting technologies used in this study. In conjunction with these factors,  surface 
materiality and material forces are discussed to position the significance of  material 
agency within this creative practice. This research positions itself  within the field 
of  knitted textiles in the sub-classification of  digital inlay knitting. A literature 
review examines academic research conducted into this specialised textile technique 
to assess any potential knowledge gaps that this thesis could begin to fill. The 
assemblage of  contextual elements outlined in this chapter unfolded further during 
knitted surface topographical builds discussed in Chapters Four and Five.

2.2 What is Inlay Knitting?

Textiles are surfaces created from fibres, filaments and yarns. Manufactured textiles 
are predominantly categorised according to three main production methods: 
knit, weave and non-woven. According to author Kathryn Hatch (1993), in Textile 
science, knitting is constructed from intermeshing loops formed by one continuous 
yarn, whereas a weave contains many separate strands of  thread and is defined 
as “fabric in which two or more sets of  yarns are interlaced at right angle to each 
other” (Hatch, 1993, p. 317). The third primary production method is non-woven, 

Chapter Two: Traversing the Scope

Instead of  thinking of  material as static or inanimate, textiles propose a 
new thinking of  multiscale performances relying on the inherent softness, 
flexibility, and bending of  the material. (Thompson, 2014, p. 60)
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which consists of  textiles created through various bonding processes. However, 
this research employs a hybrid method of  making, sometimes referred to as ‘inlay’. 
Inlay knitting is an amalgamation of  weft knitted loops and the horizontal insertion 
of  the weft aspect of  weave. As a knitted textile making method, the term inlay is 
also referred to as weave in, inlaid, weave-knit or weft insertion (Spencer, 2001). 
Throughout this thesis, this method of  knitted textile making will be referred to as 
‘inlay’. 

In knitting, there are two types of  classification: warp knit and weft knit. This 
research study investigates weft-knitted inlay textiles constructed on digital knitting 
technologies. Knit fabric is built from a singular point or stitch loop (Figure 2). 
Knitted surface stitch structures and patterns use a continuous strand of  yarn that 
interlinks individual loops. The appearance of  a knitted surface develops from 
structural combinations of  knit loop movements: front bed (knit), back bed (purl), 
rib (knit and purl) and transfer stitches. The knitting process interconnects a series 
of  loops utilising a horizontal and vertical grid system. Knitted loops are arranged 
in horizontal rows, or courses, and vertical wales. The individual knitted stitch relies 
on all neighbouring loops to fully inform itself; the tension, shape or structural 
variation of  any stitch alters all associative relationships (Arantes 2020a).

Single knitted stitch loop.
Figure 2. Weft knitted textile construct.

Wale (vertical loops).Course (horizontal loops).

Single pick.
Figure 3. Woven textile construct.

Warp (vertical threads.)Pick (horizontal threads).
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In contrast to knit, woven textiles (Figure 3) are constructed from multiple vertical 
warps or ends where the ensuing tensions between intersecting horizontal weft 
threads build the material (Persson, 2017). “Weft yarns, weft, picks or filling are 
alternative terms for the set of  weaving yarns which ‘picks’ its way across the 
warp to ‘fill’ the cloth” (Gohl & Vilensky, 1993, p. 246). The point of  intersection 
between the weft and warp is considered a single pick. Warp ends and weft pick 
threads are set in a regulated grid-like system; therefore, weave is essentially a 
structured mathematical process of  programmed co-ordinates (Albers, 1965). The 
quintessential weaving process occurs on a loom, manual or mechanised, where a 
horizontal weft thread passes between tensioned, raised and lowered vertical warps 
in designed combinations (Albers, 1965).

The three structural setups central to constructing woven surfaces are plain weave, 
twill weave and satin weave. The designed points of  warp-weft insertion and 
frequency or manner of  intersections alter the woven fabric’s appearance and 
traits (Albers et al., 2000). As renowned weaver Anni Albers (1965) suggests, the 
appearance of  weave is imposed principally by materials and design of  the weave 
directly influencing the properties of  the woven outputs. Albers (1965) writes:

The formation of  an inlay knitted surface occurs when the weft component of  
a weave combines synchronously with elongated knitted loops (Figure 4). The 
inlay inserted yarn never forms inside the loop (Spencer, 2001), unlike a jacquard 
knit (Figure 5) where colouration occurs when additional yarns are knitted on 
the needles to become stitches. Instead, the inlay yarn positions as a single pick 
or float of  variable length visible in front of  or hidden behind the knitted stitch. 
As inlay yarn does not pass through the knitting needles, this technique provides 
design options that include insertion of  extremely thick or textured yarns across the 
knitted surface (Black, 2005). 

The inlay technique, where the weft weave aspect embeds into the knitted textile, 
is only achievable due to the continuous loops formed in knitting, which create a 
conducive environment allowing yarn placement across selected needles. The inlaid 
yarn can be positioned as an all-over design (Figure 6) or in sections as an intarsia 
inlay (Figure 7), partially positioned across the width of  a textile (Black, 2005). 
Designs suitable for intarsia or tapestry are often appropriate for intarsia inlay 
where an isolated area of  weft yarn insertion occurs (Guagliumi, 1996).

The structure of  a fabric or its weave - that is, the fastening of  its 
elements of  threads to each other - is as much a determining factor in 
its function as is the choice of  raw material. In fact the interrelation 
of  the two, the subtle play between them in supporting, impeding, or 
modifying each other’s characteristics, is the essence of  weaving. (p. 23)
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Parent technique: Weft knit. Parent technique: Weave.

Inlay knitting.

Figure 4. Knitted inlay textile lineage.

Figure 5. Tubular jacquard 
technical front.

Figure 6. Single bed all-over 
inlay.

Figure 7. Single bed intarsia 
inlay.



Intarsia inlay is positioned sectionally as fragments of  a repeating pattern (Figure 8) 
rather than all-over covering of  an entire surface (Figure 9). This reductive method 
of  pattern assemblage is a design equation of  addition and subtraction, a balance 
of  the pattern remaining and what is removed from the surface. Mathematician Ian 
Stewart (1998) states:
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Figure 8. Intarsia inlay 

single bed surface.        
Figure 9. All-over inlay single 
bed surface.       

Pattern is both a noun and a verb but as a verb it is an active way of  
seeing the world, a process by which to take in and make coherent the 
random and often chaotic information the world has to offer. (p. 11)

Intarsia inlay is embedded in the knitted ground, creating the patterned divisions 
of  surface. Interconnected relationships shift between the inlay and knitted ground. 
Pattern subtraction is a variation that generates different surface behaviours 
(Philpott, 2011), resulting in altered knit-weave compositional relationships thereby 
opening up design possibilities for surface activity.

In addition to single bed inlay knits, this research utilises double bed inlay 
techniques. Double bed inlay knitting (Figure 10) is a variant with an inlay yarn 
situated between two ground layers of  tubular jacquard (Figure 11).  Author and 
academic Lydia Arantes (2020a) notes:

Knitted surfaces are material concretisations grown out of  tiny 
repeated movements. They do not hide, cover up or conceal; much to 
the contrary: they reveal. They reveal technical knowledge, skill and 
dexterity, they reveal an empathetic understanding of  materials and 
patterns. (p. 157)



Double bed inlay surfaces are vehicles articulating complex knit coding generated 
by programming a series of  exposed floats rather than embedded picks. Reveal of  
the inlaid yarn occurs through knitted points of  ground removal. Exposure occurs 
when the ground shifts uncovering the inlay yarn; the stitch transfers from back bed 
to front bed, revealing the captured internal yarn (Figure 12).

2.3 What is Links-Links Knitting?

Links-links is knitting terminology for a knitted fabric built from combinations 
of  front bed single jersey (knit) and back bed single jersey (purl) stitch structures. 
Introducing a links-links knitted stitch structure produces an innate folding of  knit 
surfaces. Positioned link-links stitches inform compressional surface movements 
and have been used to produce self-folding textiles (Glazzard, 2014; Knittel et al., 
2015; Scott, 2015; Pavko-Čuden & Rant, 2017). This inherent property of  links-
links knitting is pivotal in Martha Glazzard’s (2014) doctoral research Re-addressing 
the role of  knitted textile design knowledge: Auxetic textiles from a practice-led, designer-maker 
perspective. Glazzard investigated stitch structures to generate self-folding auxetic 
textiles, which alter when stretched to become more expansive than the original 
relaxed state. Programming links-links stitch structures on an SDS-One Apex3 
screen uses red and green colour codes (Figure 13) which can be processed to 
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Figure 10. Double bed inlay 
tubular jacquard technical front.         

Figure 11. Double bed inlay illustrates yarn 

inserted internally.     

Figure 12. Double bed inlay surface and detail revealing the captured inlaid yarn. 



produce a virtual fabric however, it is difficult to digitally convey folding qualities. 
Glazzard’s research demonstrates applied material forces in knit, although the 
forces generated are not prominent in discussions as a design element; instead, 
Glazzard emphasises the auxetic traits of  links-links. 

A links-links surface movement is “based on the structural disequilibrium of  face 
and reverse loops, which cause the fabric to form a three-dimensional structure” 
(Rant et al., 2014, p. 349). Academics Darja Rant, Ramona Ciobanu, Mirela Blaga 
and Alenka Pavko-Čuden (2014) explored scaled links-links zig-zag patterning 
as a potential packaging protection material from a textile-engineering technical 
perspective. Further research by Pavko-Čuden and Rant (2017) discusses the 
relationship of  links-links three-dimensional material behaviours to sound reduction 
and anti-bacterial packaging. Academic Jane Scott’s (2015) research informed by 
biomimicry explores links-links stitch structures as part of  her responsive knit design 
system. According to Scott (2015) “shape change is controlled by yarns and knit 
structure, and the fabric itself  determines the final geometries as it transforms from 
2D to 3D” (p. 17). Scott applies scale from “the level of  the individual stitch and 
the knitted form” (p. 11) generating knitted textiles which respond to environmental 
stimuli. Scale in my practice is approached first from a single point on the on-screen 
grid to multiple neighbouring alliances informing the knitted surface movements.

 In a similar woven context, author Anne Fields (2010) discusses collapse weave, 
a weaving method in which contrasting properties of  fibres and different weave 
structures emphasise surface folding. Released from the linearity of  the loom, the 
rigidity of  tensioned threads alters to emerge as “a cloth that bends, distorts and 
deviates from the usual linear movements of  most cloths” (Fields, 2010, p. 6). This 
release from a tensioned position is similar to the matter movement as the knitted 
surface topographies are liberated from the needle bed, forming multiaxial folds as 
the surface settles.
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Figure 13. Links-links code and virtual simulation of  knitted textile.

Red code = Front bed single jersey knit = knit stitch.

Green code = Back bed single jersey knit = purl stitch.



2.4 Inlay as a Hybrid

The surfaces generated in this research practice manipulate the hybrid 
heterogeneous components of   links-links knitted stitch structures and inlay pattern, 
layering disruptive material properties. Inlay knitting is neither solely a knit nor 
a complete weave set-up; instead, an inlay surface utilises components from both 
techniques, forming a heterogeneous hybrid offspring. The parent textile constructs, 
knit and weave, exhibit opposing behavioural characteristics (Figure 14). The knit 
offers fluidity and multiaxial directional pliability, whereas the weave provides an 
element of  less elasticity and stability to the textile surfaces (Black, 2005). The inlay 
yarn alters the material performance of  the single jersey ground by “destroying 
the lateral stretch” (Kinder,1987, p. 11) causing the knitted surface to exhibit 
behaviours closer to a woven textile. 

Academic Malcolm McCullough (1998) suggests that “an artefact is a phenomenon 
in itself  and not just an exact representation of  an abstract vision. Its expressiveness 
is shaped by the very properties of  the medium” (p. 203). These derivative hybrid 
material behaviours offer alternative inlay design opportunities for pliable stable 
knitted textiles. This research views the hybridity of  inlay as an essential element 
of  design utilising variant material characteristics imbued in a combinatory 
surface environment. This research investigates the amalgamation of  two knitting 
techniques, links-links and inlay, that have quite different material and behavioural 
qualities. An opportunity exists to explore, understand, control and manipulate the 

resultant material forces fostering unpredictable surface interactions.
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Figure 14. Heterogeneous hybrid material properties of  inlay knitting. 
Note. Adapted from “Knit and weave properties information,” in Textiles for modern living  (p.175), by E. P. G Gohl 

and L. D. Vilensky, 1993, Longman Cheshire.  



2.5 The Importance of Surface

Surfaces are all around us, everywhere, and as author Joseph Amato (2013) 
states, “surfaces evade easy definition” (p. 1). Textile yarns and knitted stitches in 
surfaces have not received the academic consideration warranted by the unique 
and complex constructive methods of  making, which differ so radically from other 
surface formations (Ingold, 2007; Arantes 2020a). Knitted surface is unique, in that 
knitting is a built surface rather than a manipulation of  surface (Arantes, 2020a). 
According to Albers (2017), “we will make of  our surfaces textile surfaces” (p. 64). 
A knitted textile has a technical front and technical back face, referencing which 
surface is outward or inward-facing as the knitting exits the machine. Therefore, a 
knit can operate as a double-sided surface. Links-links patterns appear on the back 
face as the inverse of  the front face knit (Riechman, 1966). If  the links-links pattern 
is unbalanced, the two sides afford differing surface aesthetics. The technical back 
of  inlay is always the inverse of  the technical front. When a float is visible on 
the front, the back displays the ground and vice versa. Digital two-dimensional 
knitting code hides the materiality and behavioural quality of  the physical three-
dimensional knitted surface. Authors Douglas Burbank and Robert Anderson 
(2012) note it is “tectonic processes that tend to build topography” (p. 22). This 
research explores how manipulation of  the material forces between links-links stitch 
structures and inlay patterns can inform knitted surface aesthetics. 

This research aims not to dress a surface through embellishment, but instead to 
address the importance of  the knitted surface as an embodiment of  two embedded 
textile techniques. This perspective of  the importance of  knitted surface in 
this study connects with academic Linnea Nilsson’s (2015) discourse on textile 
influences. Nilsson (2015) discusses three approaches to textile design: textiles are 
designed for a purpose; or a purpose is found after the textile is designed; or textiles 
are designed solely for creative practice. Surfaces generated in this research practice 
are designed to be viewed as dynamic knitted surfaces rather than designed for a 
particular application. Hybrid knitted surface becomes the vehicle used to creatively 
navigate combined knitting techniques and tacit knit knowledge. 

Surface has been discussed by academics from a range of  fields such as social 
anthropology (Ingold, 2018), physical geography (Peterson et al., 2017), hand-
knitting (Arantes, 2020a, 2020b), architecture (Semper, 2004), and materiality 
(Bruno, 2014). This research aligns with the outlook of  author Giuliana Bruno 
(2014) in Surface: Matters of  aesthetics, materiality, and media, which places surface at the 
forefront of  the created artefact’s essence. “No longer an ephemeral or marginal 
part of  the work, the surface is pushed to the limits of  its potentiality to become 
the actual core and structure of  the work” (Bruno, 2014, p. 101). Although Bruno 
focuses on architecture, film and body surfaces, this book offers an eloquent 
entrance through which to encounter articulated surfaces as a transformative 
research environment for knitted terrains. 17



18

Skimming the surface, we not only can weave together the filaments of  
visual existence, exposing their traces in layers of  experience but also 
trace patterns of  transformation. Surface especially matters as a site in 
which different forms of  mediation, transfer, and transformation can 
take part. (Bruno, 2014, xiv)

In inlay knitting, textile lines of  weave skim the surface, embedding and threading 
into the knitted ground at connective points, this knitted surface disruption and 
mapping of  points will be discussed further in Chapters Four and Five of  this 
thesis. Ingold (2016) refers to traces as “one or the other of  two kinds: additive and 
reductive” (p. 60). In this practice, the inlay lines are tracked across knitted textiles, 
enabling the viewer to trace the path of  fragmented connections and material 
properties across surface sites. The inlay yarn pathway illustrates the horizontal 
motion of  the knitting machine as knitting needles build the surface. This research 
study applies additive and subtractive methods to manipulate knitted surface 
aesthetics, altering inlay traces and interconnected surface relationships.

As highlighted in Surfaces: Transformations of  body, materials and earth by anthropologist 
Lydia Arantes (2020a), “knitted things do not have a surface, they are a surface” (p. 
163). Hence, surface has a value in knitting, inseparable from the act of  making. 
Arantes (2020a, 2020b) discusses knitted surfaces from a hand-knit perspective, 
highlighting discussion points around form and surface. Although discussing hand-
knits, the concept that knitted surfaces “have to be brought into the final shape 
from the very beginning” (Arantes, 2020a, p. 162) is just as valid for a digitally 
knitted surface, in which coding of  the surface is the beginning. 

Knitted surface builds from multiple individual loops, each stitch communicating 
its material nature to the neighbouring points. Arantes (2020b) outlines how 
parameters such as materials, tools, patterns and yarns form a dynamic relationship 
or web of  relations. Alteration of  design elements within knitting affects all 
connective points and, therefore, sections within the entire built surface. Shifting 
knit parameters adds another layer of  influence that underpins the surface, 
enabling multiple levels of  matter activity to occur. Approached from a hand-knit 
perspective, research by Arantes (2020a) adds validation to the conversation around 
the importance of  knitted surface as a site of  information, where surfaces record 
material transformations, knowledge and layers of  activity.

2.6 Origins of Inlay Knitting

The method of  weaving yarn into a knit, or inlay knitting, is not a new idea; 
designers have previously explored this technique through hand knitting and 
domestic knitting machines. According to author Kathleen Kinder (1987) this 
knitting method first appeared in the 1770’s producing “twilled, brocaded effects 



with silk as the inlay yarn” (p. 11). This research looks to the past as a foundation 
for building knitted textile practices (Kinder, 1987; Turney, 2009). As author Joanne 
Turney (2009) states in The culture of  knitting:
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The past is a reference, a sign amongst many others, which is sourced 
as inspiration but developed rather than copied or reviewed into a new 
form. Knitting frequently refers to its own history and can therefore be 
understood as self-reflective. (p. 61)

There is limited literature about digitally knitted inlay surfaces, unlike many other 
knitting topics, such as: Wholegarment® knitting (Choi & Powell, 2005; Smith, 
2013; Taylor, 2015), knitted dimensional forms (Underwood, 2009; Landahl, 2013), 
form building (McKnelly, 2015; Kaylanji, 2020) or the history of  knitting (Spencer, 
2001; Power, 2007; Matković, 2010). In 1938 Mary Thomas published illustrations 
of  machine knit weaving describing knitweave as positioned above or below 
the stitch loop (Kinder, 1987). Kinder (1987), in Machine knitting: The technique of  
knitweave writes a comprehensive history of  the knitting technique from a domestic 
knitting machine perspective, including references to applications of  the technique 
in the fashion industry. This book was written in the late 1980’s however, current 
literature referencing the inlay technique is still often from a domestic or hand 
knitters viewpoint (Spurling, 2018; Haffenden, 2021). The majority of  references to 
inlay knitting techniques overlook significant recent digital technological advances 
or design opportunities. 

The hand-knitted version of  inlay knitting (Figure 15), also referred to as woven 
knitting (Compton, 1988), is produced on two elongated knitting needles or pins 
(Gohl & Vilensky, 1993). This hand-created method involves placing a secondary 
yarn laid across knitted stitches as individual loops form. The hand-guided 
additional yarn remains detached, floating across and behind stitch loops, rather 
than fixed within the knitted textile (Compton, 1988). Patterns are crafted through 
calculated insertion and positioning of  a horizontal laid-in yarn to build woven 
designs in a knitted surface (Figure 16).  This hand-woven knitting technique was 
popular in the nineteenth century, using two or more yarns (Kinder, 1987).

Figure 15. Woven hand knitting. 
Note. Adapted from The illustrated dictionary of  knitting 
(p. 266), by R. Compton, 1989, Interweave Press.      

Figure 16. Weave laid-in yarn in hand knitting. 
Note. Adapted from The illustrated dictionary of  knitting 
(p. 267), by R. Compton, 1989, Interweave Press.      



In hand knitter June Hiat’s book The principles of  knitting (2012), several versions of  
handcrafted inlay are outlined, including purl knit and intarsia inlay techniques. 
According to Hiatt (2012), the technique is “most often done on a plain stockinette 
fabric because the added material is intended to be the primary focus and draw 
the eye” (p. 344). Plain stockinette fabric is a single jersey front bed knit and 
is commonly used as the ground for inlay knits produced by hand-knit and 
mechanised machines. Usage of  domestic knitting machines peaked during the 
1970s, when craft and hand-constructed methods were used to embrace the 
ambience of  the handmade (Fogg, 2010). Domestic knitting machines are available 
as electronic and hand-operated equipment, capable of  complex stitch patterning 
and colour design work. In the decade 1970 to 1980, many handcraft techniques 
were re-invented into mechanised versions (Fogg, 2010), with the inlay knitting 
technique one of  these.

The domestic knitting machine version of  inlay is referred to as weaving-in (Fogg, 
2010), knit-weaving (Guagliumi, 1996) and knitweave (Kinder, 1987; Haffenden, 
2018; Spurling, 2021). In the early to mid 1960’s the Japanese released a single bed 
push-button knitting machines capable of  producing knitweave (Kinder, 1987). 
These knitting machines use wheel brushes to direct the additional inlay yarn 
towards the needles, with the yarn manually placed into a yarn guide (Black, 2005). 
Author Susan Guagliumi (1966) suggests that, “knitting machine manuals tend to 
present knit-weaving as an all over, selvedge to selvedge technique that produces a 
fabric with limited horizontal stretch” (p. 100). 

Machine needle selection occurs either through insertion of  a punch card (Figure 
17), electronic machine programming, or via the designer’s labour intensive hand 
selection of  needles (Black, 2005). Manual instructions for setting up the machine 
occur in a table or grid-like layout (Figure 18), with knit settings for repeat designs. 
This manual design set-up affords a hand–eye connection to the design, allowing 
designers to exchange inlay colours within the same knitted course (Black, 2005). 
Although knitted textiles are generated on a machine, the making process retains an 
element of  handcraft evidenced in the output. These knitted textiles have reduced 
lateral stretch, permitting sideways usage or cut-and-sew applications similar to 
woven fabrics (Haffenden, 2018).

Digital inlay knitting technology, the focus of  this research practice, is a 
reinterpretation of  inlay mechanisms from hand and domestic machine knitting, 
a form of  digital-craft. As Nilsson (2015) iterates in regards to the influences of  
technology developments on design:
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Thus as textile materials, techniques, and industries change, it is 
important to focus not only on developing new products but also on re-
examining and developing design practice so as to fully realise – rather 
than waste – the potential of  both traditional and new textiles. (p. 9) 
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 Figure 17. Inlay knitting sample with punch-card programmed pattern repeat. 

Note. From Brother punch card pattern (Volume 4) (p. 216), n.d., Brother.    

Figure 18. Inlay knitting sample with manual set-up instructions for pattern repeat. 

Note. From Brother punch card pattern (Volume 4) (p. 210), n.d., Brother.    
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Figure 20. Loop presser bed. 
Photo courtesy of  SHIMA SEIKI MFG. LTD.
Note. From Shima Seiki Mfg. Ltd., 2020 
(https://www.shimaseiki.com/product/knit/

feature/#u2).   

Figure 21. Two parallel needle beds.
Photo courtesy of  SHIMA SEIKI MFG. LTD. 
Note. From Shima Seiki Mfg. Ltd., 2020 
(https://www.shimaseiki.com/product/knit/
feature/#u2).

 Figure 19. Shima Seiki Mfg. Ltd. inlay knitting machine N.SRY123LP. 
Photo courtesy of  SHIMA SEIKI MFG. LTD.
Note. From Shima Seiki Mfg. Ltd., 2020 (https://www.shimaseiki.com/
product/knit/nsry/).
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Although inlay as a textile technique has historical craft roots in hand and domestic 
machine knitting, it is only recently that digital knitting machines have embraced 
this method of  construction. Past hand and domestic usage of  the inlay knitting 
technique offers new possibilities for digital-craft translations  (Haffenden, 2018). 
Although challenging to knit on digital knitting machines, the inlay technique was 
possible to achieve before the development of  inlay-specific technology 
(T. Takahashi, personal communication, January 11, 2020). The Japanese company 
Shima Seiki Mfg. Ltd. released two versions of  weft-insertion digital knitting 
machines in 2014: N.SRY123LP (Figure 19) and N.SRY183LP (Knitting Industry, 
2014). In response to this technological development in 2015, competitor German 
knitting manufacturer H. Stoll GmbH & Co. KG. released a version called the Stoll 
Weave-In® (Knitting Industry, 2015). 

The original Shima Seiki Mfg. Ltd. inlay machines were technique-driven rather 
than end-use-driven, resulting in shaping and design limitations due to the 
specialised knitting mechanisms. This research practice utilises the inlay design 
environment and technical attributes of  the Shima Seiki Mfg. Ltd. SDS-One Apex3 
software and N.SRY123LP knitting machine available at the Auckland University 
of  Technology Textile Design Laboratory. This model is an original version of  the 
inlay machines, with two loop presser beds (Figure 20) positioned above the parallel 
needle beds (Figure 21), and therefore more technologically limited than newer 
versions of  inlay machines.

Inlay fabric is produced by inserting yarn into existing knit fabric 
in a weave fashion, yielding unique fabrics that are neither typically 
knit nor woven. Inlay also suppresses typical stretch characteristics 
of  knitwear, and since new yarns and materials can be used for inlay 
structures, new applications in addition to fashion apparel such as 
sports and medical as well as other industrial applications can be 
anticipated. (Shima Seiki Mfg. Ltd., 2020, para. 5).

According to a statement by Masaki Karasuno from Shima Seiki Total Design 
Centre, at the time of  the original inlay knitting machine release, “New fabrics with 
woven effects offer great opportunities in expanding into other markets. Speciality 
yarns such as metallic and monofilament yarns can be knit as well, opening new 
doors to areas other than fashion” (Knitting Industry, June 27, 2014, para. 4). 
The development of  inlay knitting technologies responded directly to the athletic 
sector’s requirements for strategically placed support through yarns and stitch 
structures (Knitting Industry, 2014), as evidenced in the Nike Flyknit shoe series. 
The inlay knitting technique allows “for the production of  hybrid fabrics that 
feature both knit and weave characteristics, suited to shoe upper applications that 
require formfitting function, comfort, flexibility, breathability as well as strength 
and stiffness” (Knitting Industry, October 30, 2019, para. 4). These unique hybrid 
traits offer alternative material properties, making the inlay technique ideal for 



applications outside knitted apparel, such as upholstery, interiors, sportswear and 
technical textiles.

The SDS-One Apex3 technical program, KnitPaint, creates the inlay design using 
either old-format or automatic software. Old-format software is a blank screen that 
allows specialised coding to be positioned on the page to build each knitted stitch 
(Figure 22). Designs generated in old format require manual processing of  the 
encoded screen through a series of  complex development steps. In contrast, designs 
produced using the automatic software (Figure 23) encompass arrangements of  
pre-set coded information. This pre-programmed set-up determines knitting size, 
stitch structures and finished edges, and incorporates an automatic development 
process. Although the automatic software offers a less complex digital environment, 
design limitations that necessitate programming in old-format software are often 
encountered. An extended discussion on the technical design role of  the SDS-One 
Apex3 KnitPaint software concerning built inlay knitted surface behaviours is 
available in Chapters Four and Five.

2.7 Material-based Forces

Greek in origin, ‘tectonics’ originates from the word ‘tekton’ meaning carpenter 
or builder. This word has since expanded in an architectural framework to 
communicate the science or art of  building (Semper, 2004), the structural and 
constructional relationship of  architecture (Sekler, 1965) and the poetics of  
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Figure 22. Screen in SDS-One Apex3 

KnitPaint old-format software. 	
Figure 23. Multiple screens in SDS-One 

Apex3 KnitPaint automatic software.  



construction (Frampton, 1995). Tectonics is a seminal concept used in architecture 
to define relationships between design, structure and materials (Oxman, 2012).
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When a structural concept has found its implementation through 
construction the visual result will affect it through certain expressive 
qualities which clearly have something to do with the play of  forces 
and corresponding arrangement of  parts in the building yet cannot 
be described in terms of  construction and structure alone. For these 
qualities which are expressive of  a relation of  form to force, the term 
tectonic should be reserved. (Seker, 1965, p. 126)

Physical geographers James Peterson, Dorothy Slack and Robert Gaber (2017) 
describe tectonics as forces that “originate in the planet’s interior, yet they 
contribute significantly to the nature of  the Earth’s exterior topology, affecting 
composition, shape, size and appearance of  the surface terrain” (p. 386). This 
research study applies tectonics as crafted material forces that become surface 
builders, deforming and reforming the knitted surface. Making becomes an 
enquiry into a selected materials potential (Harris, 2005). In my knitted surface 
topographies, material forces are influenced by the fibre composition, yarn weight, 
knitting quality and stitch structure combinations. The material forces emerge as 
individual knitted stitch behaviours altering neighbouring alliances. This research 
practice maps the surface movements, viewing the material forces as an integral 
factor of  the knitted surface topography design process.

Adapting the behaviour of  the individual stitch modulates the multitude to inform 
a larger knitted surface area. Academic Rachel Philpott (2011) notes, “by managing 
the form, material and behaviour of  the single unit, one is able to control the 
complexity of  a larger structure” (p. 29). Manipulations of  disruptions across 
knitted surfaces occur on singular or multiple scales. Ingold (2013) discusses the 
process of  growth with the maker as a participant amongst the active materials. 
The designer works with the material forces during the making processes, “bringing 
them together or splitting them apart, synthesising and distilling” (Ingold, 2013, 
p. 21), generating an emergent outcome through manipulation of  the relational
knitted network. Academics Mike Anusas and Cristián Simonetti (2020) also
embraced this concept of  growth, viewing knit as an organism growing from the
propagation of  individual stitches. Inlay textiles react differently to solely knitted
textiles due to additional variant material forces imposed by the hybrid construction
methods and material properties. The knitted surface topographies in this study
emerge from the interconnected layers of  making, folding onto and into themselves,
materialising as a surface synthesis of  knitting and weave. Each time the physical
knitting settles, it is a new version of  itself  as interconnected material forces
restructure the knitted surface topography.



As Albers (2017) iterates, “sometimes material surface together with material 
structure are the main components of  a work; in textile works, for instance, 
specifically in weavings or, on another scale, in works of  architecture” (p. 45). 
Materials are an essential agent in the making of  the textile, with materials 
playing a fundamental part in the assembly and transformation of  knitted surfaces 
(Arantes, 2020b). “Materials generally denote substances that will be further 
processed, it points to the forces of  production at the time” (Lange-Berndt, 
2015, p. 15). The term ‘material’ depicts elements subject to alteration through 
interaction with handling, their surroundings or physical properties (Lange-Berndt, 
2015). Programmed manipulation of  the material performance through stitch 
combinations is key to the built knitted surface topographies developed in this 
research study. All materials bring individual traits to design amalgamations during 
knit production. However, inlay has an additional layer of  interaction generated by 
the hybridity of  the two-parent technique. Building a knitted textile is dependent 
on the combinatory choices of  materials and construction techniques. The surface 
reacts to the density of  materials, the tactility, and the space and voids generated 
(Persson, 2017).

Material can also be immaterial; an instance of  this is digital coding (Wagner, 
2001). Digital material holds no physical existence but contributes to the physical 
output when generating digital knitting. It is through two-dimensional virtual 
coding that the three-dimensional physical emerges. The “dynamic matter and 
digital data become materials for a generative design process where matter is 
decoded and recoded as new knit structures are explored” (Stephens, 2016, 
p. 13). The flow of  material properties in a knitted textile is visible as the surface
grows, revealing itself  course upon course and building stitch by stitch. Arantes
(2020b) follows the flow of  materials (Ingold, 2007), and advocates the value of
following the flow of  material properties. This research expands on Arantes’
(2020b) perspective, following the flow of  material properties with arising material
forces seminal to the built knitted surface topographies. The material properties
have a voice that shifts as material alliances, and the knitting machine technical
environments change. In knit, unlike most textile production processes, surface and
structure are constructed in one process, and the material is an active participant
from the beginning. Individual controlled loops exhibit properties from their yarn
and stitch structure lineage, directly affecting local and global knitted surface
topography and the mechanical result (Markande et al., 2019). Digitally knitted
surfaces are material concretisations grown from precise programmed movements
that illustrate technical knowledge and an in-depth understanding of  materials
(Arantes, 2020a).

Ingold (2020) suggests that form [or surface] is generated “through the gradual 
unfolding of  that field of  forces set up through the active and sensuous engagement 
of  practitioner and material” (p. 342). The process of  making transpires as 
a conversation between maker and material (Ingold, 2013). These entangled 26



relationships between materials and maker are not always conducive to perfect 
or harmonious outputs. Often frictional issues arise from a myriad of  negotiated 
relationships between material design factors and technology (Arantes, 2020b). 
These oppositional aspects of  crafted design escalate material forces in knitting, 
intensifying disruptions within the surface plane. Knitted surfaces become sites 
of  narration, recording the interaction between material, maker and technology. 
Philosopher Manuel DeLanda (2004) discusses material-form relationships:
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We may now be in a position to think about the origin of  form and 
structure not as something imposed from the outside on an inert 
matter, not as a hierarchical command from above as in an assembly 
line, but as something that may come from within the materials, a 
form that we tease out of  those materials as we allow them to have 
their say in the structures we create. (p. 21)

In knitted textiles, an element of  material speech is present within the surface itself. 
The conversations between the knitting machine, technological knowledge, designer 
and materials merge into the knitted surface. To build on this concept of  material 
speech, Professor of  Architecture Juhani Pallasmaa (2000) states, “Materials and 
surfaces have a language of  their own. Stone speaks of  its distant geological origins, 
its durability and inherent symbolism of  permanence; brick makes one think of  
earth and fire, gravity and the ageless traditions of  construction” (p. 4). What 
knitted surfaces can articulate hinges on the characteristics of  material or yarn 
selected. Natural fibres retain memory of  their origins; woollen yarn remembers 
the crimping of  sheep fleece as elasticity, and silk fabric derived from finely spun 
fibres preserves an element of  weightlessness.

Vibrant matter (Bennett, 2010) or active matter (Delanda, 2004; Ingold, 2013; 
Küchler, 2020), are materials and processes that dynamically participate in the 
assemblage of  transformative knitted surface topographies. This creative practice 
considers the “possibility that materials possess a vitality and agency independent 
of, and yet entangled with, humans” (Preston, 2019, p. 32). This research draws on 
these notions of  materiality, where materials actively contribute to the designer’s 
practice. Knits emergent “matter-energy” (DeLanda, 2004, p. 19) is evident when 
the knit-weave aspect of  links-links and inlay trigger dynamic surface interactions. 
Control of  material forces through informed knowledge of  material performance 
and the “systematic behaviour of  its assembly” (Kolarevic & Klinger, 2013, p. 7) 
shifts resultant knitted surface topographies. 

Anthropologist Susanne Küchler (2020) discusses the linkage between 
neighbourhood points, the inside and outside of  surfaces hidden amongst folds and 
a manifestation of  surface geometries. Surfaces reveal and conceal. The knitted 
surfaces in this project result from a multiplicity of  colliding points, a “mapping of  
temporal processes” (Küchler, 2020, p. 187) or a tracing of  active material forces in 



motion. A knitted surface is not passive; it morphs, realigning as a different version 
of  itself  each time it resettles. Discussion concerning active matter is often from a 
stimuli-reactive, material or interactive, electronic, programmable perspective that 
contributes to the creative process (Bergstrom et al., 2010; Stephens, 2016). Viewing 
textiles as interactive materials, Küchler’s paper ‘Technological materiality: Beyond 
the dualist paradigm’ (2008) provides a focused outlook on textiles with reactivity 
generated by an additional electronic stimulus. Knitted surface topographies in this 
practice rely on inherent material characteristics and heat-reactive properties of  
selected fibres combined with stitch structures to realise surface transformations. 

This research aligns with the role of  materials and technology being collaborating 
agents (Cooper, 2014) that provide a level of  autonomy to the surface design 
process. The maker and active material work together as participants rather 
than imposing their will upon the output (Delanda, 2004; Lange-Berndt, 2015). 
Following the properties of  the materials (Arantes, 2020b) promotes conversations 
between assembled heterogeneous material performers (refer to Figure 14, page 
16). Materials have agency. They move and act as if  with a life of  their own (Lange-
Berndt, 2015), reacting to material forces transforming the knitted surface. In 
digital inlay knitting, active matter emerges through the material flux and digital 
coding as material forces disrupt surface equilibriums.

2.8 Craft Influences

Assemblage of  the dynamic material forces occurs through methods of  hybrid 
crafting (Golsteijn et al., 2014 ). Hybrid crafting refers to making where “both 
crafting process and result will include both physical and digital elements” 
(Golsteijn et al., 2014 p. 594). Crafting in this sense is not handmade; instead, it 
references original textile-making techniques that are reinterpreted and assembled 
as digital data. This research is positioned at the juncture intersecting craft-based 
textile knowledge and digital textile technologies. “Digital fabrication methods are 
opening up new [hybrid] possibilities for craft, art and design” (Zoran & Buechley, 
2013, p. 5). The application of  craft knowledge and ethos to technology and 
production offers opportunities to produce “continuous innovation and repeated 
uniqueness” (Woolley, 2011, p.  20) in mass production environments (Niedder, 
2009). As academic Jenny Underwood (2009) states:

28

The role of  textiles is changing...What we are seeing is perhaps 
a return to the designer as a material innovator. Innovations and 
advances in textile fibres and tech are influencing how textiles are 
being used. Traditional techniques and technology, the ornamental 
and structural, and the micro and macro are blurring. Textile 
techniques, once associated with being hand-crafted are being 
transformed into high tech automated processors using sophisticated 
and complex technology and machinery. (p. 156)
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In this research, craft, crafting and craftmanship are applied expert knowledge and 
mastery of  a technique or material (Dormer, 1997). Author Peter Dormer (1997) 
notes, “it is craft not as ‘handcraft’ that defines contemporary craftsmanship, it 
is craft as knowledge that empowers a maker to take charge of  technology” (p. 
140). Craft applications expand through the inclusion of  technologies: “a driving 
factor of  digital craft is its combination of  new technology with physical hands-
on experience” (Nitsche et al., 2014, p. 720). The digital knitting technologies 
employed in this research are seen as materials to empower the maker-researcher 
when combined with designerly knowledge informing digital outputs (Cross, 1997; 
Nitsche et al., 2014). Academic David Pye (1968) discusses craftsmanship offering a 
meaning applicable to contemporary digital making:

Craftmanship…means simply workmanship using any kind of  
technique or apparatus, in which the quality of  the result is not 
predetermined, but depends on judgement, dexterity and care which 
the maker exercises as he works. The essential idea is that the quality 
of  the result is continually at risk during the process of  making. (p. 20)

McCullough (1998) states, “we build up digital artefacts one step at a time, one 
piece on top of  another, with what is already there affecting what is to come” 
(p. 155). This idea of  built artefacts relates to inlay knitting, where layering the 
connective material forces of  singular points affects the neighbouring surface 
dynamics. This controlled building of  componentry to craft the whole begins at 
programming stage, with assemblage of  coded information required to produce the 
knitted surfaces. The knitted surface being virtual before being made physical, the 
intangible code builds tangible outputs. 

Hybrid digital-crafting is not new, it is now over 20 years old as a concept; 
however, as digital tools have become more accessible the debate around craft and 
computing practice has grown (Harris, 2012). In relation to digital-craft practice, 
academic Jane Harris (2012) notes:

Progressing beyond the technical range of  digital media, the craft sector 
is arguably just beginning to demonstrate how computing output may 
benefit from an ethos of  making that incorporates poetic and aesthetic 
concepts akin to more conventionally crafted forms. It could also be 
argued that through experimental engagement with digital media, 
computing is to some extent indirectly repositioning, perhaps even 
reinvigorating, craft practices, highlighting strengths. (p. 109)

In many textile industries, the application of  digital technologies such as computer 
numerical control (CNC) machinery and digital textile print have refined a 
connection between virtual and actual making. However, digital knitting has 
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always struggled with the virtual-to-physical translation due to the complex 
computer interface and the inherent physical material properties of  knit. Many 
makers struggle with designing on-screen, citing a disconnect caused by a lack of  
haptic stimuli digital-crafting offers (Prytherch & McLundie, 2002; Harris, 2005). 
“Inherent in such practitioners is the compulsion to interrogate materials and 
tools, defining new languages of  construction and process” (Harris, 2012, p. 92). 
I discovered that my making operated in a fluid virtual-physical space, where my 
digital skills became more intuitive, contributing to a broader range of  potential 
material practice (Harris, 2005).

Digital creative methods are more often associated with mass manufacturing 
than the craft-making environment (Harris, 2012); however, this research aims to 
increase awareness of  the potential of  inlay knitting technologies to produce hand-
like aesthetics, triggering conversations around future usage by craftspeople. The 
personal skill and in-depth knowledge of  knit programming I possess is a unique 
opportunity to contribute to the digital knit environment from design and technical 
perspectives.

2.9 Contemporary Inlay Practice

There is limited research about inlay digital knitting techniques and technologies, 
with the main focuses in this area found to stem from architectural, engineering 
and medical applications. These functional inlay applications have directed 
research into areas such as textile reinforcement for concrete structures (Balea et 
al., 2014; Lee et al., 2020), compressional medical garments for therapeutic and 
sports applications (Bera et al., 2016; Xiong & Tao, 2018) and buoyancy fabrics 
(Li et al., 2018, 2020). One of  the functional applications for the inlay technique 
is research investigating low-density, high-buoyancy fabrics for swimwear (Figure 
24) conducted by engineers Li et al. (2018, 2020). The production of  the buoyant
knitted textiles uses inlay knitting technology to insert hollow tubes inside stitched

The technical front view.              The technical back view.
Figure 24. Inlaid tube in half  milano knitted stitch structure. 
Note. From “Development of  laid-in knitted fabric for buoyant swimwear,” by N. W. 
Li, C. P. Ho, K. L. Yick, and J. Y. Zhou, 2020, Journal of  Industrial Textiles, p. 6.
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layers. Li et al. work with a half  milano knitted stitch structure. Half  milano knit 
is constructed from two courses of  double jersey and one course of  single jersey 
knitting. The stitch structures result in interior space between front and back knitted 
layers, allowing placement of  a tube inside the stitches. This research follows a 
formulaic, regimented process of  testing the floatation efficiency of  the textiles. 
Although this is a functional approach to inlay applications, insertion of  yarn inside 
knitted textiles is relevant to the double bed developments with interiorly placed 
yarns discussed in Chapter Four.

Master’s student Viviana Hohenstein (2017) includes a design approach to inlay 
knitting in her thesis The Space in between: Exploring weave knitted textiles by constructing 
surface patterns on three-dimensional shapes. This research was conducted at the 
University of  Borås, Sweden, and used the H. Stoll GmbH & Co. KG. Weave-In® 
technology in a technical facility similar to the Auckland University of  Technology’s 
Textile Design Laboratory. Hohenstein created shaped pieces and stitched the 
separate panels to generate three-dimensional silhouettes. The inlay technique in 
Hohenstein’s research explores colour, yarn and shape (Figure 25). However, the 
inlay designs only apply the technique across the textile from edge to edge, as all-
over inlay with a front bed knitted ground. This approach to inlay design imitates 
the application techniques demonstrated by the knitting machine manufacturer, 
with a similar aesthetic to domestic machine swatches. Therefore, I believe the 
positioning of  the inlay knitting technique constrains the research outputs achieved 
by Hohenstein. This constraint highlights opportunities for an alternative design 
practice utilising inlay knitting technologies to extend inlay techniques into more 
unique directions through weave replication, placement, scale and compositions of  
variant ground stitch structures.

As with Wholegarment® technology, where the knitting industry was slow to 
embrace technological potential (Hunter, 2004; Black, 2005; Power, 2007; Smith, 
2013), I believe inlay knitting technology is technically more advanced than 
the designs released by Shima Seiki Total Design Centre and used by industry 
designers. Academic Jess Power (2007) states in her review of  knitting technologies 
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Figure 25. Inlay knitting of  pleated circle. 
Note. From The space in between: Exploring weave knitted textiles by constructing surface patterns on three-dimensional shapes, by 
V. Hohenstein, 2017, Student Thesis, University of  Borås, Faculty of  Textiles, Engineering and Business, p. 3.
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through the ages, “throughout history there appear to be periods of  innovation 
where technology leads design, followed by periods of  development where design 
exploits the technological capability and then the cycle repeats“ (p. 10). Many 
knitted sample swatches distributed to companies primarily portray all-over inlay 
knitting with jacquard-like repeating patterns. These selvedge to selvedge inlay 
swatches remain primarily within a jacquard aesthetic similar to examples of  all-
over inlay knitting found in domestic machine knitting books (Guagliumi, 1996). 
This jacquard-based design aesthetic was reinforced in the inlay training I received 
in January 2020 at the Shima Seiki Mfg. Ltd. facility in Wakayama, Japan. Samples 
generated in training sessions followed a strict formula that referenced jacquard 
designs previously created by the technical tutor. In the main, this inlay knitting 
technology has been used for replication, rather than for creative design generation.

More creative and advanced inlay knitted developments are emerging, usually 
from Shima Seiki Mfg. Ltd. (Figure 26) and H. Stoll GmbH & Co. KG. (Figure 
27) technical research and design departments. These designs extend technical
boundaries of  inlay application, shifting into design areas such as woven-lookalike
apparel, footwear and products. Knitted designs viewed at the Shima Seiki
Total Design Centre in January 2020 showcased complex shaping and knitting
techniques blended with inlaid yarns. However, designers who undertake the official
Shima Seiki Mfg. Ltd. training are encouraged to use pre-programmed patterns
from the SDS-One Apex3 design-software pattern library. These pre-set inlay
designs are similar to the stitch structure library available for pre-programming
knitted surfaces. Although initially helpful in expanding knit knowledge, these pre-
programmed patterns can prevent creative leaps (Archer, 1964) and limit design
innovation. This method of  creating with pre-set designs is a recognised design
issue, as witnessed in the programming of  Wholegarment® knitting, where pre-set
shapes have significantly reduced creative design developments (Black, 2005; Smith,
2013; Kalyanji, 2020). 32

Figure 26. Inlay-knitted shoe by 
Shima Seiki Mfg. Ltd., exhibited at 
Pitti Filati, Florence, 2019.

Figure 27. Weave-in knitted bag by   
H. Stoll GmbH & Co. KG., exhibited
at Pitti Filati, Florence, 2019.



Contemporary designer Kitty Pennybacker’s creative practice blends textile skills 
of  knitting, weaving, cording and felting. The predominantly interior focused 
outputs are created on domestic knitting machines using the knit-weave technique 
(Figure 28). The knitted textiles primarily consist of  100% wool and employ an 
intarsia approach. The designed sections of  inlaid yarns positioned into the knitted 
ground explore texture and colour (Pennybacker, 2021), forming large intarsia inlay 
pattern repeats. An old cording machine has developed a unique process which 
generates thick cording from wool (Pennybacker, 2021). The cord is manipulated 
into designs with large floats, unlike the practice in this research, which adapts 
traditional weave patterns using small picks and floats. Although Pennybaacker uses 
mechanised domestic knitting machinery, the making process is labour intensive, 
“a scarf  can take two days to make, a throw a week and cushion covers a couple of  
days” (Scott, 2019). These handmade textiles are an example of  where digital inlay 
knitting could mimic analogue knit aesthetics, providing time-saving production 
opportunities for bespoke knits.

2.10 Building a Language

Knit language in academia tends to communicate in knit specific technical 
terminology based on the mechanics of  production used by technicians 
and designers in an industry situation. The issue of  communication of  knit 
information amongst knit designers and technicians (Eckert, 1997; Underwood, 
2009; Yang, 2010) and between knitters and other disciplines (Glazzard, 2014) is 
widely acknowledged. Glazzard (2014) discusses the influence language had on 
participants in her doctoral research focus groups, with engineers, scientists, and 
textile and product designers reacting differently to commonly used industry knit 
terminology. This issue of  understanding highlights discipline demarcations in 
thinking and the need to access a less field-specific language for interdisciplinary 
discussions around knit design extension and practice. Underwood (2009) and 
Kalyanji (2020) both refer to architectural terminology to contextualise the built 
components of  their shape-focused research. 33

Figure 28. Kitty Pennybacker knitweaving with large floats, knitted on a domestic knitting machine. 
Note. From Etsy, 2021 (https://www.etsy.com/uk/listing/940289527/pink-blue-scarf ?ref=shop_home_
active_18&frs=1).

This image has been 
removed by the author 

due to copyright reasons.

This image has been 
removed by the author 

due to copyright reasons.



This research draws on geomorphology, the study of  “Earth’s landforms and its 
surfaces processes” (Rosenburg, 2019) for language to analyse the knitted surface 
movements and navigate this design practice. Geomorphology, a sub-field of  physical 
geography and geology, shares terminology with multiple Earth sciences disciplines 
(Rosenberg, 2019). Discourse in this thesis refers to three principal types of  tectonic 
forces. Compressional forces push together, tensional forces pull apart in opposing 
directions, and shearing forces slide past each other (Figure 29). These Earth based 
tectonics are also known as convergent, divergent, and transformational forces 
(Plummer et al., 2018). Compressional forces create symmetrical and asymmetrical 
folds (Peterson et al., 2017). In this research, knitted material forces observe similar 
surface movements affected by the positioning and scale of  links-links stitch 
structures. 

Folding transforms surface depth, width, length and volume and divides the surface, 
blurring edge boundaries (Philpott, 2011). Geomorphology offers an expanded 
vocabulary to traverse the deformative knitted surface. Tight folds occur when 
the space between links-links stitch structures is small and broad folds when wider 
spacing is evident between links-links stitch structures (Figure 30). Examples of  
language similarities between disciplines are ‘ground’, referencing the Earth and 
knitted surface and ‘fault’ used to describe an area of  rupture caused by stresses 
(Burbank & Anderson, 2012). The built surface movements in this practice exhibit 
textural qualities similar to the Earth’s topographical characteristics. Topography is 
“the arrangement of  high and low elevations in a landscape” (Peterson et al., 2016, 
p. 631). The Earth’s exterior topography is changed by the composition, shape,
size and appearance of  the surface (Peterson et al., 2016). The word topography
is used in this research to identify knitted surfaces which result from the collision
of  tensions, stresses and material forces transferred within a knitted pliable plane.
Peterson et al. (2016) suggest that “primary geomorphic mechanisms increase the
topographic irregularities on Earth’s surface” (p. 386). A hybrid vocabulary derived
from the glossary of  terms (refer to page 144), and geomorphic terminology (refer to
Appendix A) assists navigation of  the knitted surface practice in Chapters Four and
Five.
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Figure 29. Three types of  surface forces. 
Note. Adapted from Physical geography, (p. 389), by J. F. Peterson, D. Slack, & R .E. Gabler, 2017, Cengage 
Learning.



2.11 Conclusion

This chapter, Traversing the Scope, positions links-links and inlay knitting techniques 
and highlights the significance of  knitted surface, valued for its surface factor 
rather than its textile application or form. An examination of  relevant literature 
established a contextual background for this research. These theoretical strands 
embed further into this study as the practice developments unfold, revealed and 
concealed through the built knitted surface topographies. In addition, a descriptive 
language emerged, blending knit and geomorphologic terminology to articulate 
crafted material forces and resultant surface aesthetics. The research generated 
through this technique-led journey amalgamates practice-led knowledge which 
builds on the research milieu outlined in this chapter.
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Figure 30. Geomorphic folds formed by tectonic forces
Note. Folded rock structures become increasingly complex as the applied compressional forces become more 
unequal from the two directions. From Physical geography (p. 395), by J. F. Peterson, D. Slack, and R .E. Gabler, 
2017, Cengage Learning.

This image has been 
removed by the author 

due to copyright reasons.
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3.1 Introduction

This chapter outlines broader methodological framing of  the research before 
addressing the design methods and processes that underpin key phases of  
the practice. This study is primarily a technique-led investigation through the 
generation of  crafted knitted surface topographies. As highlighted in Chapter 
One, the fundamental aim of  this research was to investigate the links-links and 
inlay knitting techniques and their potential to build knitted surface topographies 
through the assemblage of  material forces. The overarching framework in this 
research aligns with action research (Schön, 1983; Frayling, 1993; Swann, 2002), 
particularly the subcategory known as practice-led research (Gray & Malins, 2004). 
The subjective nature of  practice-led research means that using several research 
approaches is typical, but inevitably the practice develops its own distinct blended 
methodological identity (Gray & Malins, 2004). Constant reflection-in-action and 
reflection-on-action (Schön, 1983) occurred in this practice-led research to build 
technique and technological know-how through digital-physical making. A hybrid 
methodological approach was applied utilising tacit knowledge (Merleau-Ponty, 
1965; Dormer, 1997) and influenced by traditional craft contexts and my unique 
textile-design and knit background. 

Although literature written specifically on knitting methodologies in a design-
research context is limited (Bye, 2010; Glazzard, 2014), the very act of  knitting 
requires physical practice and therefore becomes a method, used to generate 
new knowledge. According to academics Jon McCormack, Alan Dorin and 
Troy Innocent (2004), “generative systems offer a methodology and philosophy 
that views the world in terms of  dynamic processes and their outcomes” (p. 1). 
Rather than approaching the question of  surface transformation from a calculable 
perspective, this research manipulates layered elements to build material forces 
in dynamic knitted surfaces. This practice was influenced by my textile design 
background and the introduction of  a geomorphic language base, resulting in 

Chapter Three: Crafting a Knit Framework

The identification of  an analytical method allows us to suppose that 
the artistic object no longer appeared to the eyes of  logic painters as 
something fatally and mystically all-encompassing, homogeneous, 
and unanalysable, but rather it established itself  as a producible and 
analysable entity, in its heterogeneous factors, in relation to a model of  
construction and decoding. (Celant, 2009, p. 13)
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a new approach to knit design. The knitted surface becomes an articulation of  
knowledge (Seago & Dunne, 1999; Mäkelä, 2007; Finn, 2014), as noted by fashion 

academic Angela Finn (2014):

The design aesthetic, methods of  construction – both textiles and 
garment – and the quality of  materials form part of  the knowledge 
encapsulated in garment objects. Decoding this knowledge requires 
the researcher to draw on their expert knowledge to place objects 
within a market or make deductions about its quality. (p. 141)

Designed artefacts collect and preserve information. However, objects are mute and 
need ways to tell their story to become actual research. As enlarged upon in this 
chapter, this research study uses materials and technologies to record the making 
process, with knitted surfaces seen as articulations of  the accumulated knowledge. 
Arantes (2020a) adds to the discourse around knitted surfaces as valid sites of  
experience that record material transformations and activity. The hybrid knitted 
surface and the creative process, in turn, become signifiers, places of  discovery and 
vehicles of  knowledge (Mäkelä, 2007; Nimkulrat, 2013). 

3.2 Designer’s Tacit Intuition

This practice-led research operates from the point of  accumulated tacit knowledge 
(Merleau-Ponty, 1965) within the field of  digital knitting. “Tacit knowledge 
is personal know-how, and it exists in people” (Dormer, 1997, p. 147). Tacit 
knowledge is intuitively applied in this ‘making’ and amassed from years of  
personal knit experience and engagement with physical textiles. Independent of  
our minds, our bodies are a means “through which we come to know the world and 
articulate our sense of  self ” (Negrin, 2015, p. 115). My accumulated experiential 
learning across multiple textile disciplines has created a knowledge nexus that forms 
a research bridge between craft-making skills and technological knitting abilities.

In textile design, haptic connections form between the maker and the materials 
(Igoe, 2010). “Haptic sensibilities, by their very nature defy reductionist methods 
of  investigation, yet are demonstrably highly significant in the perception of  
our reality.” (Prytherch & McLundie, 2002, p. 38). For me, part of  knowing and 
understanding knit qualities is acquired through repetitive haptic stimulation 
(Prytherch & McLundie, 2002). Interpretation of  on-screen codes requires physical 
prototyping to understand the actual knitted surface. Direct interaction and bodily 
engagement with materials, craft techniques, tactile surfaces and textile technologies 
leads to innate tacit knowledge or experiential knowledge (Albers, 1965; Igoe, 
2010). Tacit knowledge is acquired physically and intellectually as a “result of  
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using both intellectual and material tools” (Crouch & Pearce, 2012, p. 38). This 
form of  knowing is difficult to quantify, as it is subjective. Still, academics Kristina 
Niedderer and Catherine Townsend (2010) suggest documentation and visual 
evidence recording the experience can support intangible facets of  tacit knowledge 
in research. 

Academic Elaine Igoe (2010) “warns of  the dangers of  reliance on tacit knowledge 
and the importance to question the tacit”, endorsing “the ability to begin to 
objectify, articulate and challenge assumptions” (p. 2). Although tacit knowledge 
embeds in my practice, it can also be a design constraint. Knit programming is 
taught in a structured and controlled manner that can limit experimentation of  
alternative approaches to the technology. Hence, design freedom arose from a 
lack of  formal training or prior knowledge of  inlay knitting technologies at the 
beginning of  the research, just a basic conceptual understanding of  the technique. 
The experiences gained through self-instruction were pure technology, material 
and designer versus outcomes obtained by following the structured programming 
notes found in the SDS-One Apex3 KnitPaint help menu. The learning acquired 
during this design autonomy or freedom has remained visible in the knitted surfaces 
produced. However, the technical knowledge obtained during the Shima Seiki 
Mfg. Ltd. structured training in January 2020 has also significantly influenced the 
practice-led research outputs.

3.3 Making in a Hybrid Environment

This research applies a hybrid crafting (Golsteijn et al., 2014) approach to 
qualitative research similar to bricolage (Kincheloe, 2001; Lincoln, 2001), through 
interdisciplinary practice. Practice-led research focuses primarily on the act of  
making and the generation of  new outputs (Scrivener, 2000). Knitting is a practical 
craft with physical, tactile outputs. The digital knitting environment lends itself  
to practice-led research due to the extreme difference between two-dimensional 
and three-dimensional surfaces. In addition, design variables such as materials, 
stitch structure, machine gauge and knitting tension influence the physical knitted 
surface. Constant reflection-in-action and reflection-on-action (Schön, 1983) 
occurred in this practice as a methodology of  building know-how through digital 
and physical making to generate complex knitted surfaces emerged. Donald Schön, 
in The reflective practitioner (1983), proposes the idea of  reflective research activity as a 
practice-based epistemology with the reflective practitioner central to the research. 
This practice-led accumulative approach fostered a greater understanding of  the 
physically connected material behaviours that occurred in this study between 
positioned material forces.



3.4 Interlinked Research Phases

This hybrid practice evolved through intersecting research phases into a knit 
surface-building methodology. Although mapping the research into phases (Figure 
31) enables the practice to be structured, the actual pathway followed was less linear 
and contained cross-over points as ideas interlinked and knowledge increased. 
Phase One, Initial Knowledge Acquisition, focused on initial learning of  the inlay 
technique and technology through stitch structures, materials, repeating patterns, 
traditional weaves and scale investigations. Phase Two, Understanding Material Forces, 
used geomorphic language to analyse knitted material forces and articulate surface 
deformations that occurred during layering of  knitting techniques and material 
behaviours. Phase Three, Developing a New Design Strategy, informed the generation of  
the surface-building blocks and a pick-and-mix design process. Phase Four, Synthesis 
of  Practice, explored the application of  material forces and surface-building blocks to 
assemble larger complex knitted surface topographies. This technique-led approach 
to the research fostered a greater understanding of  the digital-physical material 
behaviours that occurred in this study between positioned material forces and the 
knitting techniques; links-links and inlay.

In this research study, reflective analysis of  the knitted surfaces and encountered 
material forces provided a critical focal point to the research methodology. Author 
Nigel Cross (2006) describes “the study of  form and configuration of  artefacts” 
as “design phenomenology” (p. 101). Cross (2006) implies that understanding the 
output is “where design knowledge resides in products themselves: in the forms 
and materials and finishes which embody design attributes” (p. 101). This research 
builds on this concept of  understanding beyond the object to include a material 
force assemblage process that combines multiple methods of  creation. Although the 
research pathway was at times indistinct, as I ventured into the role of  a designer-
researcher these linkages between methods and practice strengthened. As Philpott 
(2011) notes, “it is essential that these documentation methods be systematically 
integrated with reflective practices in order to evolve the practice in a meaningful 
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Figure 31. Research phases of  the practice.



way” (p. 33). Multiple mind maps throughout the research journey revealed and 
modified relationships between the making and theoretical concepts, consolidating 
the practice pathway.

3.5 Role of Reflective Practice

Retrospective connectivity through reflection-on-action (Schön, 1983) permitted 
an element of  the creative leap (Archer, 1964) or intuitive shifts of  perception to 
manifest as altered viewpoints in the research process. Cross (1997, 2006) writes 
about design thinking and views moments of  illumination as a ‘creative bridge’ 
building connections between creative designs. These inspirational instances 
occurred during exploration of  inlay techniques, between ideas and the actual, 
the digital screen and physical textile, the active materiality of  the knitted surfaces. 
Recording processes acted as a structural boundary to ensure practice-led rigour 
through the creative practice as an evolving ‘reflection-in-action’ and ‘reflection-on-
action’ cycle (Schön1983; Scrivener, 2000). Academic Maarit Mäkelä (2016) writes:
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When documenting their creative processes, they consciously reflect 
on their current experiences during the process (reflection-in-action) 
and on the documented experiences once the entire process has been 
completed (reflection-on-action). In this way, documentation can assist 
in capturing the experiential knowledge in the creative process so that 
what the practitioner learns from within her practice becomes explicit, 
accessible and communicable. (p. 2)

Reflective practice occurred throughout the creative process, with reflection-in-
action during the making and reflection-on-action (Schön, 1983), capturing my 
analytical process through journals and mind mapping. In Doing research in design, 
authors Christopher Crouch and Jane Pearce (2012) suggest that “practice is a 
combination of  tacit and explicit knowledge, and it is the researchers job to try 
and unravel the two” (p. 38). When first programming my process followed a series 
of  consciously created designs to understand the inlay technology. However, as 
my knowledge increased, programming became more intuitive. An element of  
unconscious creativity emerged enhanced by an ability to read the two-dimensional 
screen as a three-dimensional knit. Operating the knitting machine provided 
additional opportunities to acquire tacit knowledge from immediate interaction 
with stitch quality, tactility, knit handle and material behaviours. This design 
approach encouraged creativity as prototypes were emergent and evolved through 
generative feedback loops between maker and technology (Stephens, 2016). 

Additionally, practice-review sessions occurred during several research phases, 
highlighting interrelated key findings and the significance of  particular knitted 



surface techniques for further experimentation. The practice was positioned in 
non-hierarchal groupings on tables and frames (Figure 32) for viewing by other 
designers. This practice-review process engaged with multiple perspectives and 
allowed an additional level of  objectivity to enter this development process. 
Inclusion of  progress critiques in the research approach was immensely beneficial, 
as often my perception was too intertwined with the knitted technical factors to 
see significant design aspects. The inclusion of  alternative voices reinforced the 
importance of  the digitally knitted surfaces and aided in building robust conceptual 
connections between the practice, theory and design. This review process enabled 
me to structure the research, establishing fundamental linkages within the practice 
while also reordering my design thinking.

Christopher Frayling’s (1933) discussion on research methods in design questioned, 
“How can I tell what I think until I see what I make or do?” (p. 7). I would rephrase 
the question to include the need to touch what I create: How can I tell what I think 
until I see and touch what I make and do? The tactility and the physical touch of  the 
knitted surface provided additional information and more profound understanding 
(Harris, 2005). Albers (1965) discusses tactility, stating that material surface and 
structure are the main components of  textile work. The physical, pliable handle 
and ability to fold, unfold, and refold as alternative knitted surfaces is conveyed 
through the fingers, a physicality perceived not solely by the eye. One of  my 
methods of  reflective practice is to touch, my fingertips absorb information (Igoe, 
2010); therefore, the physical engagement with the knitted surface topography is 
integral to knowledge acquisition in this research (Harris, 2005).

41

Figure 32. The practice-review process.



3.6 The Act of Making 

3.6.1 Inlay Investigations

A personal ability to navigate the virtual and physical environments of  digital 
knitting knowledgeably was critical to fostering a stronger design position (Philpott, 
2012). Developing this understanding of  new technologies was seen as an 
opportunity to craft and extend known knitting techniques beyond the expected 
(Niedderer, 2009). Exploration of  the inlay technique started with all-over inlay 
designs using the SDS-One Apex-3 automatic software to understand inlay 
programming and possible visual aesthetics. The prototypes investigated the length 
of  floats (Figure 33) and placement of  different combinations of  inlay pick and 
float. Initial prototypes naively mixed knitted stitch structures, purl, rib, lace transfer 
and needle racking with inlay knitting (Figure 34, 35). These deviations from the 
typical single stitch structure generally used for inlay designs were considered 
peculiar by experienced knit technicians at the Shima Seiki Mfg. Ltd training 
facility in January 2020. However, a deeper understanding of  inlay techniques’ 
potentiality and knitting machine knowledge evolved through programming these 
all-over inlay prototypes. (The technical steps for programming a single bed all-over 
inlay knitted surface are available in Appendix B.)

Initial practice mapped the inlay knitting applications and built connections 
between techniques, informing a lineage chart (Figure 36). Initial inlay prototyping 
provided an overview of  single-bed, double-bed and rib knitted grounds with 
various inlay surface aesthetics. These inlay knitted surfaces embody hybrid 
material properties from the parent textile techniques: knit and weave. The knitted 
surfaces manifest variable material characteristics (refer to Figure 14, page 15), 
depending on the placement and inlay pattern selected. Control of  the design 
process from an idea into a two-dimensional code to a three-dimensional prototype 
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Figure 33. All-over inlay knitting 
with float variations.

Figure 34. All-over inlay knitting 
with striped racked stitch structure.

Figure 35. All-over inlay knitting 
with lace stitch structures.
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provided bodily knowledge through haptic analysis (Harris, 2005) of  the knit 
handle. Initial practice evaluated colour opportunities, materials, scale, and trialled 
knitting with half  gauge and full gauge on the 14 gauge N.SRY123LP knitting 
machine to produce multiple knitted surface adaptations.

Prototypes used neutral shades of  grey, with the inlay yarn ranging from muted 
hues to pops of  bright colour. High contrast colours increased the visibility of  
pattern traces across the disrupted knitted ground with inlay appearing to float on 
top of  the knitted surface. In comparison, monochromatic prototypes provided 
subtle versions where ground and inlay blended, creating an effect of  weave 
embedded in the knitted surface. These prototypes looked at potential applications 
of  multiple inlay colours (Figures 37, 38), or two ground colours on a single surface 
(Figure 39). However, although colour entered the design equation, it was “only as a 
by-product - since of  course nothing is colourless - not as a focal point. Any colour 
effect is, for the moment, incidental, not intentional” (Albers, 2017, p. 46). Colour 
was applied to demonstrate the technique and extend knowledge rather than a 
critical design factor. This research journey’s colour pathway has scope for future 
research expanding on this initial experimentation.

3.6.2 Digital-crafting

The act of  making requires decisions around the artefact’s structure and 
appearance and a strategy for its creation (Dormer, 1997). Inlay knitting technique 
trials used traditional plain and twill weave patterns (Figure 40). These patterns 
were selected in response to self-imposed design questions: Could identifiable 
analogue woven patterns be translated into digitally knitted versions that 
maintained a hand aesthetic? Could these weave patterns afford the effect of  a 
weave embedded into the knitted surface? 44

Figure 39. One colour all-
over inlay with two colour 
grounds.

Figure 37. Two colour all-
over inlay with one colour 
ground.  

Figure 38. Two colour 
intarsia inlay with one colour 
ground.  



To explore the juxtaposing idea of  woven fabric in a knitted surface, I applied a 
digital-craft approach utilising weave patterning from Sharon Alderman’s Mastering 
weave structures: Transforming ideas into great cloth (2004). Sharon Alderman is a 
handweaver, artist and author whose grid layout of  fundamental to intricate weave 
patterns provided a comprehensive woven-design process. These woven instructions 
were guidelines for inlay pick and float coded arrangements transferred to the 
technical SDS-One Apex3 environment. Purple and white squares representing 
picks and floats translated as inlay points in the digital grid, forming a coded 
pattern (Figures 41, 42). This process involved implementing traditional plain and 
twill weave layouts such as the dornick twill illustrated in Figure 43 as a woven 
fabrication and Figure 44 and 45 as an inlay knitted construct. As physical inlay 
knitted surfaces, the selected patterns offer a close aesthetic representation of  
original woven textiles. Small picks and floats appear more embedded in the knitted 
ground than longer surface floats. These all-over inlay prototypes informed the 
inlay pattern component of  the surface-building blocks (refer to Appendix C).

The inlay technique and technology prototyping incorporated scaled designs with 
varying float lengths on front bed knitted grounds to initially determine the effect of  
inlay on material behaviours and surface aesthetics. The inlay pattern was scaled up 
using the SDS-One Apex3 scale function, which allowed X and Y axis controlled 
scaling (Figure 46). The colour exchange function enabled efficient prototyping 
of  inverse inlay patterns (Figure 47), which aided visualisation of  inlay colour 
balance from two-dimensional screen to three-dimensional knitted surface. A shift 
towards making and crafting with digital materials is becoming more recognised as 
a constructive method in which making becomes as significant as the made artefact 
(Turney, 2009).
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Figure 40. Traditional twill weave patterns interpreted as digital all-over inlay knitting.
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Figure 41. Woven dornick twill pattern grid. 
Note. From Mastering weave structures: Transforming 
ideas into great cloth (p. 35), by S. Alderman, 2004, 
Interweave Press.

Figure 42. SDS-One Apex3 all-over inlay 
dornick twill pattern translation. 

Figure 43. Woven dornick twill fabric. 
Note. From The dornick project, by A. Stratton, 
2011, Tangles and Webs (http://tanglesandwebs.
blogspot.com/2011/12/dornick-project.
html).	

Figure 45. All-over inlay knitted dornick twill detail of  texture. 

Figure 44. All-over inlay knitted dornick twill 



3.6.3 Materials and Materiality 

This research is a quest for knowledge unique to digital knitting, which is crucial 
to advancing a discipline (Bye, 2010). Professor Bruce Archer (1979) argues that 
“there exists a designerly way of  thinking and communicating that is both different 
from scientific and scholarly ways … and as powerful as scientific and scholarly 
methods of  enquiry when applied to its own kinds of  problems” (p. 17). Textile 
design research draws on an understanding of  materials from an experiential and 
technical perspective (Mori, 2012). Architect Toshiko Mori (2012) notes:
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Figure 46. Traditional weave patterns as all-over inlay in two scales. Figure 47. Regular twill all-over 
inlay with inverse patterning.

By exploring the tectonics [material forces] of  textiles, one not only 
appreciates an impressive multiplicity of  its methods and applications, 
but also recognises the potential embedded in a seemingly primitive 
technique and its emergence as a major material technique of  the 21st 
century. (p. 76)

Two-dimensional and three-dimensional making environments combine during all 
phases of  this research practice. It is through exploration, play and making, either 
through the abstract (virtual) or final output (physical), that material behaviours 
begin to be understood (Armitage, 2011). The act of  knitting and the resultant 
outputs were informed by the intrinsic characteristics of  the fibre and yarns 
selected. New material knowledge was generated through a hands-on approach 
to material manipulation and a deep understanding of  the design practice (Marr 
& Hoyes, 2016). Understanding material agency (Lange-Berndt, 2015) required 
physical engagement with multiple knitted surface transformations.

A knitted swatch replication and analysis method produced comparable samples 
knitting the same prototype multiple times, exchanging yarn compositions (Figure 
48). Merino, acrylic, cotton, wool blends and Pemotex (polyester) yarns were 
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investigated for ground knitting, with nylon-core cotton for the inlay patterning. 
Merino retains properties inherited from the crimped fleece; memory held in the 
yarn and consequently evidenced as an elastic quality in knitted samples. The 
Pemotex yarn requires heat activation to artificially trigger convergent forces 
in the knitted plane through applied sectional shrinkage (Figure 49). Tubular 
jacquard prototypes included Pemotex yarn, resulting in deformation of  the 
double bed knitted surface, similar to links-links surface aesthetics. The material 
testing procedure confirmed yarn choices by observing agency levels that different 
materials offered the knitted surface movements. Each material speaks (Pallasmaa, 
2000) a different language: the interactive dynamics of  material agency (Bolt, 2007) 
encourage emergent transformational surfaces.

This process of  material testing was not a measurable analysis of  material 
behaviours. Instead, it was subjective, based on the fibre’s visual effect on the 
knitted surface and its tactility. These factors relied on amalgamation of  co-
emergent yarn properties to produce requisite surface movements. Academic 
Barbara Bolt (2007) discusses the notion of  ‘acting ensemble’, exploring emergent 
material practice by applying co-emergent properties set by the designer, materials 
and tools. Thereby informing a situation where the outcome is unknown in 
advance but instead characterised by interactive play between the agency of  matter 
(Bolt, 2007). In knit practice, to understand the programmed digital you need the 

After applied heat.                                                        After applied heat.
Figure 49. Tubular jacquard merino and Pemotex yarn.

Cotton ground.			        Merino ground.		            Acrylic ground.
Figure 48. Single bed intarsia inlay testing different ground yarns.



corresponding physical prototype. The coded to decoded, generates emergent 
material practices that foster a dynamic environment set by the designer and 
technology.

Materials experimentation trialled reactive yarns, producing rigid dimensional 
forms (Figure 50). Although the knitted surfaces were considered too inflexible at 
this practice stage, this experimentation supported materials selection discussed 
in Chapter Four. Artefacts perceived as significant to the extension of  my practice 
emerged from this entangled environment. These directional leaps necessitated the 
cyclic blending of  phases in the research. This practice triggered the inclusion of  
material forces and reactive yarns as essential design elements in double bed knitted 
surface topographies.

3.7 Building Material Forces

3.7.1 Generating the Knitted Ground

In Phase Two of  the research, Understanding Knitted Material Forces the research 
investigated potential surface movements generated by self-folding links-links stitch 
structures. This practice builds on prior knowledge of  textile practices encapsulated 
in a folded or assembled form (Philpott, 2011; McKnelly, 2015),  and auxetic 
knitted textiles (Glazzard, 2014). Textile design repeating pattern formats foster 
material and stitch behavioural knowledge. The development of  pattern repeats 
offered this practice an ordered and replicable design process for constructing the 
knitted grounds. 

In knitting, the potential of  an infinite repeat is constrained by the width of  the 
knitting machine’s needle bed. Initially, various shapes were trialled in repeat 
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Figure 50. Rigid dimensional form produced during material experimentation with reactive yarns. 



however, regular geometric shapes were most suitable for repetition on-screen as 
the gridded design environment makes curves challenging to achieve. Construction 
of  links-links repeating patterns used digital print unit-repeat arrangements: block, 
half  drop and brick (Figures 51, 52). Coded red and green areas represent front and 
back bed single jersey, respectively. Unlike print, whose motifs are often separated 
by background colour, there is no background in the knitted versions. As evidenced 
in Figure 52, this causes the square shapes in the half-drop and brick repeat to 
merge at points of  intersection. This merging creates a visual effect in which the 
individual links-links unit is no longer a set geometric shape. Red and green colour 
codes represent stitch structures that are not static as they physically translate into 
surfaces, generating knitting with vertical or horizontal dominant compressional 
material forces. 

In a discussion on knitted textiles, academics Shashank Markande, Michael 
Dimitriyev and Elisabetta Matsumoto (2019) note:
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Block repeat. 
Figure 51. Textile design print repeating pattern techniques. 

Block repeat. 
Figure 52. SDS-One Apex3 knit repeating patterns for links-links square.

Half-drop repeat. Brick repeat. 

Half-drop repeat. Brick repeat. 

Not only can stitch pattern control the local and global geometry of  a 
textile, but the creation process encodes mechanical properties within 
the material itself. Unlike standard additive manufacturing techniques, 
the innate properties of  the yarn and the stitch microstructure has 
a direct effect on the global geometric and mechanical outcome of  
knitted fabrics. (p. 1)
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Integration of  links-links behavioural knit knowledge entwined with scale 
investigations during exploration of  the base repeat unit at 100% pattern size 
through to 500% pattern size (Figure 53). Initial photographic records (Figure 
54) instigated the generation of  a digital library representative of  the physical 
prototypes. These links-links prototypes informed the geometric pattern component 
of  the surface-building blocks applied in Phase Four to test material forces and inlay 
pattern relationships. The links-links knitted practice provided a visual library of  
knitted material forces, translating coded screen combinations into physical surface 
disruptions (refer to Appendix D). The links-links layouts additionally formed 
a geometric pattern reference for designing double bed inlay tubular jacquard 
grounds.

3.7.2 Reading Materials Forces

The knitted surface practice progressed through layering the links-links and inlay 
knitting techniques. Textile design is underpinned by mathematics as physical 
textiles manifest grids and calculations between pattern and technique. In knit, 
programmed patterns are multiple combinations of  individual stitch loops that 
sequentially construct a surface. To visualise the interconnected knit and weave 
points of  patterning, I initially mapped the two techniques together in a grid format 
(Figure 55). The automatic software’s stitch structure codes and the inlay pattern 
are programmed on two separate screen pages with the information combined in 
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Vertical rectangle half-drop. 
(vertical compression) 
Figure 53. Scaled knitted links-links ground patterns.          

Vertical rectangle brick. 
(horizontal compression)           

Figure 54. Photographic record 
of  physical links-links grounds.
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the development process. Figure 56 illustrates the on-screen structure and inlay 
colour pages and corresponding physical knitted surface for a version of  Crystal 
Twill inlay. These link-links with intarsia inlay prototypes tested deformative 
relationships between pattern designs, positioning, and scale within the knitted 
surface. (The technical steps for programming a single bed intarsia inlay knitted 
surface topography are available in Appendix E.)

The knitted surface topography the Crystal Twill inlay pattern contains short 
floats and is recognizable as a traditional woven fabric design. The twill setup and 
amount of  inlay used in this prototype allowed the stitch structure beneath to shift 
in places with the material forces but the static nature of  this inlay changed these 
forces. Reduced folding resulted in a weave-dominant effect with increased stability 
of  the knit surface. The inclusion of  horizontal and vertical linear subtractions of  
inlay facilitated shared material forces generated by the links-links ground. Single 
courses of  inlay follow the recumbent folds, along the ridges and into the folded 
peaks and dips. Initial prototypes contained holes due to programming an uneven 
number of  courses between the subtracted inlay and knitting with a tight stitch 
quality (Figure 57).

The links-links sections collide as juxtaposing forces arise between the heterogenous 
pliable stitch and stabilising inlay surface characteristics. During analysis of  the 
complex surface folds, commonalities between inspirational landscape imagery 
and knitted surface movements emerged. Similar surface aesthetics between folded 
land and the knitted surface formed visual connections to geomorphology (refer to 
Appendix A). Knit compressional material forces occur horizontally, vertically or 
angled with multiaxial used to encapsulate multi-directional surface movements. 
Through the use of  photographs, material forces can be seen beyond that which 
the natural eye captures. In the photographs, surface disruptions are static, allowing 
examination of  material alliances between individual stitch structures and points 
of  inlay knitting. Analysis of  these images increased understanding and awareness 

Figure 55. Personal interpretation of  grid illustrating knit, weave and inlay technique connections.
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Figure 56. Analysing convergent and divergent force between knit and Crystal Twill intarsia inlay.

Stitch structure coded layer.                                                        Inlay pattern coded layer.

Figure 57. Holes in Crystal Twill intarsia inlay



of  material forces which became a key design component of  the knitted surface 
topographies. The knitted surfaces were mapped with arrows to highlight changing 
material force activity (Figure 58). These visual records of  the experiments and 
the analysis yielded a pattern-synthesis method (Cross, 1997), a process of  active 
engagement with the puzzle pieces that I had to connect or disconnect. 
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Figure 58. Reading assembled material forces in intarsia inlay knitted surface topography.

Designing is a process of  pattern synthesis, rather than pattern 
recognition. The solution is not simply lying there among the data, like 
the dog among the spots in the well-known perceptual puzzle; it has to 
be actively constructed by the designer’s own efforts. (Cross, 2006, p. 24)

During this process of  pattern synthesis, I discovered an internal paradox. This 
enigma arose from being the subjective designer so fully immersed in the making 
and the objective researcher observing and delineating tacit and explicit knowledge 
findings. Reflection allowed time to step back and observe the results dispassionately 
yet remain connected to the theoretical underpinning and subsequent design shifts.

3.7.3 Approach to Subtractive Design

Initial experimentation investigating the effect of  inlay patterns and knit structures 
on material forces generated prototypes of  varying success. Trials explored large 
areas of  intarsia inlay in proportion to solely knitted ground (Figure 59). These 
original material force explorations applied linearly arranged patterns of  intarsia 
inlay with a single stitch structure beneath with combinations of  links-links grounds 
constructed the surrounding knitted surface. These prototypes resulted in a weave-
dominant aesthetic, displaying properties of  surface stability rather than surface 



deformation. Introduction of  subtractive design methods and reduction of  inlay to 
knitted ground ratios countered this flattened surface effect.

Horizontal and vertical subtractive methods used the SDS-One Apex3 KnitPaint 
clear function to delete inlay patterning fostering folded corrugations and pattern 
fragmentations across the knitted surface (Figure 60). The first subtraction 
prototypes occurred due to the inaccurate positioning of  inlay patterning. I realised 
this opened up opportunities for increased fragmentation of  the inlay pattern, 
and designs shifted to include a systematic deletion approach. Subtractive design 
instigated a systematic approach engaging with layered links-links and inlay on a 
stitch-by-stitch basis. Float length and the amount of  inlay pattern fragmentation 
required influenced vertical subtractions. Carrier direction and the number of  
courses between inlay sections influenced horizontal subtractions. What began as a 
programming design oversight became a surface-building block in the pick-and-mix 
mode of  making.

Digital making in knitting often involves missteps and miscalculations. Textile 
design academics Anne Marr and Rebecca Hoyes (2016) “identify risk-taking 
and ‘unlearning’ as essential strategies to invite valuable setbacks as well as happy 
accidents” (p. 5). The value of  being the programmer and seeing the results of  
programming errors that arise from not knowing added to design possibilities 
in this research. An example of  this occurred during the subtraction of  inlay 
process when I initially left behind random courses of  inlay as I did not zoom in 
on the area. Once knitted these pattern remanets added a trace of  the maker and 
making method to the knitted surface. These mistakes would be viewed as flaws 
by a traditional technician and are often removed without sharing. According to 
McCullough (1998):
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Figure 59. Large area of  intarsia inlay patterning 
in proportion to links-links ground. 

Figure 60. Knitted surface topography with 
increased inlay pattern fragmentation.

Experimentation is especially useful for becoming familiar with 
constraints: we learn from our mistakes. We must accept that beginning 
work in a new medium will be full of  setbacks. There will also be 
fortuitous discoveries, however, particularly of  affordances. Design is not 
only invention, but also a sensitivity to a medium. (p. 225)
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Design connections between initial practice and material forces were partially 
intuitive and included creative leaps bridging understanding (Archer, 1964). One 
creative leap resulted in lines of  connection, illustrating the journey of  the inlay 
yarn. These lines are the result of  pattern subtractions which cause long inlay 
floats between the remaining inlay pattern. Trials investigated linear and curved, 
horizontal and vertical subtractions to generate minimal or multiple inlay traces 
(Figure 61). The traces became a design element adding to my surface-building 
block options. These would never have happened if  I had entered the research as a 
technically proficient programmer of  the inlay knitting technique. Inlay long yarn 
trails are usually perceived as a programming mistake or machine malfunction 
and removed by technicians. This self-taught faction of  the research shifted the 
knitted outputs in an unexpected and unique direction. As a reflective practitioner, 
I assessed the design value of  the inadvertent surface traces of  the inlay yarn that 
emerged. A lack of  know-how can work as a catalyst for greater understanding; 
understanding how and why the issue occurred means adding or subtracting these 
yarn pathways within the inlay surface designs.

3.8 Emergent Design Strategies

3.8.1 Establishing Surface-building Blocks

Phase Three of  the research process, Developing a New Design Strategy, was influenced 
by material forces, knitting techniques and geomorphic language. Built knitted 
surface aesthetics were informed by photographed landscapes, geometric repeating 
grounds, surface movements and inlay patterning. The positioning of  crafted design 
components became a key factor in the layering of  material behaviours, letting 
materials speak (Lange-Berndt, 2015) and fracturing pliable knitted planes. The 
initial links-links knitted surface prototypes and inlay weave-like patterns generated 
a reference library of  material forces, scale and pattern knowledge with digitally 
programmed counterparts for future applications (refer to Appendix C and D). The 
two-dimensional screen contains a static representation of  the fluid dimensional 
knit in digital knitting. The stitch codes reference physical knitted surface constructs 
which generated the links-links ground and inlay surface-building blocks (Figure 62).

Figure 61. Trace pathways of  the intarsia inlay yarn.
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Figure 62. Surface-building blocks for building a knitted surface topography. 



Application of  the surface-building blocks as a pick-and-mix method of  creative 
practice emerged as the complexity of  the knitted surfaces increased. The knitted 
surface topography constructs layer surface-building block components selected 
from; materials, inlay type, ground type, ground pattern repeat and scale, traces, 
subtractive design, weave type, and photographic division. Surface-building blocks 
and the mode of  making derive from all phases of  the research. The assemblage 
process focuses on layered relationships of  the design components and their 
effectual performance in the assembled environment (Beaubois et al., 2015). Due 
to heterogeneous relationships between layered surface-building blocks, the single 
bed and double bed inlays’ assemblage requires divergent design approaches. These 
advanced assemblage methods are discussed in detail in Chapters Four and Five.

3.8.2 Generating a Mode of Making

A method of  building knitted surface topographies emerged significantly influenced 
by the prototypes’ aesthetics, in which links-links surface movements fractured 
inlay patterning. The land and seascapes of  the Coromandel (Figure 63) connect 
to my life in New Zealand with imagery illustrating the natural layering of  physical 
factors. Throughout this research, the landscape photographs translate from digital 
to physical, back to digital, and then back to physical formats. Through a series of  
generative processes, natural geomorphic landscapes informed the knitted surface 
topographies.

In this research, photography was integral to the design process: as a method of  
inspiration, and as a system for designing the knitted surface topographies and 
mapping material forces (Figure 64). Landscape images informed sectioning 
templates for placement of  the knitted ground. The actual photographed landscape 
shifts to the virtual coded screen in a hybrid-making process emergent as physical 
knitted surfaces. Different design approaches to combine multiple links-links 
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Figure 63. Thumbnails of  Coromandel terrains.
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 Colour-blocking sections .                                           Fill with links-links patterns.
Figure 64. Creative process of  collaging sectional links-links ground.

Physical swatch collaging.                                            Hand-drawn sectioning of  photograph. 



grounds trialled collaging methods in which photographs, abstracted lines, sectional 
coding and tactile samples blended to produce knitted surface movements. The 
physical and digital formats of  the links-links grounds and inlay patterns are 
valuable resources to share with other designers,  to enable codes to be read as 
knitted surfaces. The collaging method references digital and physical design 
elements informing knitted surface selections. Initial applications of  the geometric 
pattern surface-building blocks collaged physical links-links options considering the 
tactility, aesthetics and material forces.

Practice-led action research is “distinct from other forms of  reflective research in 
being deliberately planned and systematic, with a distinct purpose and deliberate 
strategies for moving from reflection to research” (Crouch & Pearce, 2012, p. 114). 
My structured nature disseminated the reflective practice and emergent approach 
to knitted surface design into step-by-step procedures. Steps for building a single 
bed, rib and double bed inlay knitting contain similar approaches to the surface 
design; however, each inlay type contains several design-technical variances (refer 
to Appendix B, E, F and G). This approach to digital making applies a pick-and-
mix method selecting design components from the surface-building blocks. Both 
automatic and old-format software require the inlay and the stitch structure to be 
generated as separate layers. Automatic software retains these separations, whereas 
the old-format software merges the layers to enable the programmed codes to 
process.

Layering emerged as a method of  creation at multiple prototyping stages; layering 
of  knitting techniques, aesthetics, and material forces. Codified placement of  the 
inlay technique on the layered digital screens generates surfaces where knitting 
rules distort. Programming operated in a multi-tiered realm, with individual pages 
holding design information for stitch structure, inlay and colour. The overlapped 
syntax of  coded pages is visible on-screen in composite view (Figure 65), allowing 
designer-programmer input and activation between specific knit and inlay points, 
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Figure 65. On-screen composite view showing layered structure and inlay page codes. 



manipulating singular points of  material force. Through alternative combinations 
of  these surface-building blocks, the agency of  the surface is manipulated (Lange-
Berndt, 2015), resulting in knitted surface topographies when virtual coding 
becomes actual.

Photographs informed interconnected sectional divisions through either linear or 
curved lines.  This initial transference of  sections from physical imagery to digital 
explored several creation methods: direct hand-to-screen delineation, importation 
of  the image into the knit-design program, creating index image colours in 
Photoshop and drawing lines using the SDS-One Apex3 tablet. I experienced a 
sense that, as the number of  computerised steps increased, the digital dictated 
the generated aesthetic, resulting in an artificial look. To prevent this, I preferred 
to proceed with a more direct hand-to-screen interpretation of  my designed 
sections. Printing the photograph and hand drawing the sectional divisions in 
preparation for transference to the structure or colour page on screen maintained 
the handmade aspect and instilled an intuitive design presence. This approach 
allowed proportional adjustments to occur with opportunities to merge sections. As 
evidenced in Figure 66, direct hand-to-screen surface drawing facilitated greater 
retention of  the original image layers than the knit software generative method.

These hand-drawn sections are filled with solid colours in a colour-blocking 
method that allows systematic pattern filling during knitted surface creation. The 
colour blocks offer opportunities to gauge the placement of  intersecting lines and 
patterning relationships to neighbouring sections. Multiple colours allowed testing 
of  alternative pattern options, each knitted surface encountering a different set 
of  material behaviours. Using the colour-blocking method facilitates an ability 
to pattern the entire panel, rapidly filling sections, similar to a paint-by-numbers 
approach. The SDS-One Apex3 KnitPaint base pattern repeat function allows 
efficient sectional patterning once a single pattern-unit repeat is identified. 

Figure 67 illustrates physical-digital-physical steps used to create a rib intarsia inlay 
in automatic software using the surface-building blocks. In this prototype curved 
sectioning derived from the photograph was hand-drawn on-screen. Colour-
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Original Photograph.
Figure 66. Visual results of  actual to digital image-sectioning methods.

SDS-One Apex3 digital knit design. SDS-One Apex3 direct on-screen.        
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Figure 67. The creative design process steps for rib intarsia inlay in automatic software.

Step 1. 
Photograph with sectioning  lines.             

Step 2.
Hand-drawn on-screen sectioning.        

Step 3. 
Colour blocking.         

Step 4. 
Fill inlay pattern page with pattern.                             

Step 5.
Fill structure page with rib structure.                    

Step 6.
Physical knitted prototype.         



blocking of  these sections occurs on the inlay pattern page before each colour is 
exchanged for an inlay pattern or colour zero representing no inlay. (The technical 
steps for programming a rib intarsia inlay knitted surface topography are available 
in Appendix F.) The application of  these outlined steps is dependent on the inlay 
type selected from the surface-building blocks. Single bed and rib inlays use 
variations of  colour-blocking and fill techniques in automatic software. Double bed 
inlays apply similar steps, although are built-in old-format software which requires 
additional coded knit information. (The technical steps for programming a double 
bed inlay knitted surface topography are available in Appendix G.) 

Affiliation with the digital environment and abilities fosters crafting with knit codes. 
The screen and programmed codes have become my materials, and technology 
is a tool used to draw knitted surfaces. The act of  making generates a “material 
consciousness” (Sennett, 2008, p. 123), assimilated over time into tacit knowledge. 
Technical aspects of  creation are embedded in the knitted surfaces as visual 
references of  knowledge and intuition. Tacit knowledge guides programmed 
performance and interactions of  material forces and knitted surface topographies; 
this application of  material knowledge is a form of  the thought unknown (Bollas, 
1987). My design process occurs as a direct transference from hand to the digital 
screen, similar to sketching on paper. These digital lines form traces of  either 
additive or reductive layers (Ingold, 2016) embedded into my knitted surface. As 
this practice progressed, the number of  intersecting colours and patterns increased 
in complexity. This approach provided a sense of  digital-physical engagement 
through direct involvement in the programming and engaged an intuitive design 
approach. The practice and design strategies evolved in response to encountered 
design-technical aspects which are expanded on in Chapters Four and Five.

3.9 Assembled Topographies

Phase Four of  the research, Synthesis of  Practice, encompasses assemblage methods 
to create increasingly complex knitted surface topographies. Application of  the 
surface-building blocks into considerably larger prototypes facilitated practice which 
tested the scope of  the mode of  making. I intended to extend the Shima Seiki 
Mfg. Ltd. knitting technology into designs that required advanced programming 
and technological learning. Compositional surfaces demonstrate material forces 
“modulated in a single surface” (Kolarevic & Klinger, 2013, p. 8). Composition 
infers the assembly of  elements either according to rules or by chance (Smith, 
2013). The repeating patterns, scale, materials and stitch structures were assembled 
with layered manipulation, affording known and unknown surface movements. 
Programming influences knit and weave creation rules; this applied effect increases 
material activity, disrupting the knitted surface. Intangible factors of  knitted textiles 
are difficult to calculate or quantify, yet these characteristics directly impact the 
design aesthetic: pattern, texture, and the surface’s tactility. Knitting becomes a 63



way of  thinking through material engagement with these intangible elements and 
understanding the technical environment. 

To extend the technology and the practice, extremely long panels were set up at the 
full needle-bed width. Prototypes investigated different patterns, scales, and tactility 
assemblages across interconnected knitted surfaces. The larger knitted surface 
topographies presented technical and programming challenges not encountered in 
smaller samples. A collective knitted surface design built across five panels informed 
a method encompassing both old-format and automatic software. Each panel in the 
series is an individual informing neighbouring pattern alliances. The relative size of  
the screen hindered the ability to translate on-screen to an actual knitted surface. 
A divisional method of  drawing five vertical lines to represent the five panels and 
dividing the image horizontally into quarters (Figure 68) countered the issue of
proportion. This provided half  the length of  my long panels which could then 
be doubled to generate the full length. Individual panels set up in old-format 
form the interconnected knitted surface series. Links-links and inlay designs are 
built separately in old-format across multiple panels before being layered in the 
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Figure 68. Proportional sectioning for colour-blocking in series of  longer knitted surface topographies.

Block repeat.                              Mirror repeat.                          Chevron repeat.   
Figure 69. Repeating pattern methods trialled for intersecting ground sections. 



automatic software as single panels for additional tweaking. (The technical steps 
for programming a single-multiple knitted surface topography are available in 
Appendix H.)

Textile print techniques were applied to complete the full length colour-blocked 
sectioning for the elongated surfaces (Figure 69). The long panels allow multiple 
interactions between oppositional material forces and variant dynamics space to 
disrupt the knitted surface topography. To test design variations block, mirror and 
chevron repeating pattern techniques were applied generating full panel lengths, 
before selecting mirror repeat. The mirrored repeat of  half  the panel allows a 
flipped and mirrored duplication of  the coloured sections within the knitted surface, 
thereby creating the length desired. Using these replication methods reduced the 
programming time while ensuring no visible repeat in every panel. This prepared 
the patterns for the paint-by-numbers approach filling colour-blocked with links-
links or inlay patterns.

A method was developed to generate the placement of  the inlay patterning. A 
range of  digital manipulations using Adobe Photoshop focused on foreground 
features of  the photograph (Figure 70). These design approaches investigated a 
blend of  level adjustment functions to accentuate the foliage in the photograph. 
The posterise image adjustment setting was selected as it provided clear areas 
to translate into inlay patterning. Dark areas became blocks of  inlay transferred 
into the digital milieu. On-screen designing relied on intuitive design choices to 
aid the compositional balance of  inlay patterning and to work with technological 
boundaries. Research methods and practice evolved, responding to design and 
technical issues encountered. The assemblage methods employed to build knitted 
surface topographies across multiple panels are discussed further in Chapter 
Five, Emergent Terrains.
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Figure 70. Image adjustments trialled for placement of  inlay patterning.



3.10 Conclusion

When situating this research, I continually re-evaluated my role, shifting from a 
technical perspective to a design-focused lens. Traditionally in the knitting industry, 
these roles have held different skills and knowledge; however, I am a blend of  
technician and designer, not entirely one or the other. As a knit programmer and 
technically capable of  running the digital knitting machine, this was my initial 
default research position. However, the more I engaged with the practice-led 
research approach, the more the lines between technical and technique blurred, 
and I acknowledged my designer viewpoint. This shift in thinking led to a 
conceptual expansion of  the research practice trajectory. There was an unfolding of  
additional theoretical layering in the work as perspectives shifted into the reflective-
practitioner realm (Schön, 1983).

As a knit methodology and methods emerged, I began to recognise the unique 
situation I was in to generate and impart new knowledge in the field of  digital 
inlay knitting as a designer-practitioner-researcher. The hybrid methodologies 
used enhanced this research, encouraging an interweaving of  interdisciplinary 
practice through digital crafting. My textile design background and prior knitting 
experience have substantially influenced the research process and outputs. Textile 
design methods provided a base knowledge to develop the links-links grounds 
and weave patterns into a library of  knitted surface-building blocks. During the 
project, acknowledging existing and new tacit knowledge generated questions 
about personal contribution to the construction of  inlay knitting techniques and 
surfaces: How do I affect the inlay knitted surfaces that evolved in this research? 
How does knit tacit knowledge manifest as surface knowledge? Constructing 
compositional knitted surfaces with the designed units allowed a homogenous input 
to transform into a heterogeneous output. The outlined mode of  making discussed 
in this chapter is evolutionary, as each application of  the surface-building blocks 
encountered new design-technical constraints to create with. The methodological 
approach, methods and design strategy outlined above are articulated in more 
depth through Chapters Four and Five as the practice extended.
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4.1 Introduction

This chapter discusses new applications of  traditional textile practices that 
transpired as my creative process evolved. The inlay knitted surfaces apply blended 
textile and craft practice fostering a dynamic design dialogue.  Material forces are 
generated and assembled through a series of  layered interactions. The knitted 
surface topographies articulate a process and output, accentuating tacit knowledge 
enfolded and embedded into the physical artefact (Nimkulrat, 2009). Dormor 
(2020) notes, “the term unfolding reveals the complexity of  events and hints at a 
more processual situation within which elements become uncovered, hidden and 
recovered by parts, not necessarily in any chronological or logical order” (p. 11). 
This chapter is not a chronologically ordered discussion of  practice; instead, the 
chapter addresses three interlinked research phases; Initial Acquisition of  Knowledge, 
Understanding Knitted Material Forces and Developing a New Design Strategy (refer to Figure 
31, page  39). Dialogue regarding the technique-led practice occurs in conjunction 
with parallel conceptual strands that emerged during the research journey. The 
reflective technique-led practice doubles back on itself  in a labyrinth of  thoughts 
and design connections materialise from the echoes of  thinking through making 
(Dormor, 2020).

The artistic freedom obtained through this haphazard mode of  making was often 
difficult for my ordered personality to embrace. At times I felt lost and unsure 
of  the relevance of  some aspects of  the testing process, struggling with design 
autonomy after years of  design restrictions imposed by industry and academia. 
However, practice developments helped consolidate the core surface focuses; 
material forces, textured knitted surface topographies and materiality. These 
focused on extending inlay knitting techniques through the subsequent phases 
of  design and increased technological understanding. Although the research has 
been structured into phases, the practice overlapped and blended cyclically, linking 
backwards and forwards between phases as knowledge increased.

Chapter Four: Planes of Technique

Surface quality of  material, that is, matière, being mainly a quality 
of  appearance, is an aesthetic quality and therefore a medium of  
the artist; while quality of  inner structure is, above all, a matter of  
function and therefore the concern of  the scientist and the engineer. 
Sometimes material surface together with material structure are the 
main components of  a work. (Albers, 2017 p. 45)



4.2 Phase One: Initial Knowledge Acquisition

4.2.1 Technique and Technology

A greater understanding of  design components leads to greater awareness of  
the design conditions that make textile surfaces (Albers, 1965). Technological 
interaction is central to this research practice. Programming of  digital inlay 
knitting occurs in two ways: via automatic software or the old-format programming 
interface. These methods require specialist knowledge of  knitting and the 
technology, which was achieved through iterative cycles of  experimentation and 
assimilated knowledge from knit experts in this research. Initial experimentation 
stemmed from self-taught prototyping focusing solely on the automatic software. 
To extend design potentiality beyond all-over single bed inlay knitting (Figure 71), 
I undertook two weeks’ tuition at the Shima Seiki Mfg. Ltd. Training facility in 
Wakayama, Japan. This instruction significantly expanded prior programming 
knowledge and provided an insight into the inlay technique’s usage. Coding 
acumen resulting from prototypes developed in Japan provided a foundation for 
alternative knitted design techniques and surface outputs. The understanding and 
inclusion of  complex double bed inlay knitting (Figure 72) shifted the research 
potentialities beyond encountered automatic software constraints. Old-format 
software facilitates programming on a blank page using advanced knit coding 
knowledge. The inclusion of  old-format methods of  making knitted surfaces 
introduced double bed inlay design opportunities into this practice. 68

Technical front.                                                            Technical back.
Figure 71. Single bed all-over inlay knitted surface. 

Figure 72. Double bed inlay knitted surfaces.



As a technical knowledge base of  inlay technique was established through initial 
knit practice (refer to Figure 36, page 43), the research focus shifted to the designed 
surface aesthetic. Several digital-craft based making methods were folded into the 
creative process investigating inlay surface aesthetics, providing new possibilities for 
design outputs (Niedderer, 2009). Knitted and woven textiles are historically craft-
based techniques. Architecture academic Mette Thomsen (2014) notes:
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The term digital crafting suggests the intersection between digital 
design tools and the capacity for precision, variation, and control 
within the craft tradition. Designing for digital fabrication necessitates 
an embedded understanding of  the craft tradition. (p. 61)

This research blended digital repeating patterns and woven-craft approaches to 
making, looking to the past as a catalyst to reinvent a shift into the future (Kinder, 
1987; Turney, 2009). Academics Connie Golsteijn, Elise van den Hoven, David 
Frohlich and Abigail Sellen (2014) observe that although crafting was historically 
centred around functionality, there is also a recreational aspect that is more about 
the reflective journey of  creation rather than the end function.

In the knitted surface, inlay traverses multiaxial material forces that fracture the 
knitted plane, viewed as configurations patterning the surface. The viewer’s eye 
navigates the intricate weave designs, recognising the organisation and balance 
of  multiple pattern units perceived as an “embodiment of  order” (Jefferies, 2012, 
p. 126). Some of  my most successful weave replications were visual articulations 
of  intricate twill patterns. In particular, the diamond twill where the inlay floats 
and picks embedded in the knitted ground, often as single points of  intersection. 
This point-by-point layering of  inlay pick and stitch loop preserved a rigorous 
weave aesthetic. The knitted diamond inlay is emergent as a defined portrayal of  
the original woven version. The small floats in the initial all-over inlay prototype 
maintain the weave aesthetic better than in the increased scale version (Figure 
73). Woven textiles generally consist of  a series of  short rather than long floats, so 
although these inlay versions are still identifiable patterns, they transgress through 
scaled digital translation from their point of  origin. 

Figure 73. All-over inlay diamond twill pattern, original scale and 200% scale. 



Weave-based prototypes sought a balanced relationship between the inlay and 
knitted ground and displayed visually organised patterns. According to Albers 
(1965), in these patterns, the viewer can see “the essence of  designing, a visually 
comprehensive, simplified organisation of  forms that is distinct from nature’s 
secretive and complex workings” (p. 71). The recognisable weave factor remained, 
acting as a signifier to the viewer, the eye interpreting and reading the known even 
when parts of  the pattern were deleted or fragmented. The inlay knitted surfaces 
display variable inherited properties implemented by float lengths, pick placements 
and materials affording a higher degree of  elasticity than a woven textile. As this 
research journey progressed, these foundational digital interpretations of  the craft-
based technique informed decisions through an implicit understanding of  materials 
(Adamson, 2018) and technology to generate desired knit aesthetics. During the 
initial inlay technique exploration, I discovered the visual effect of  varying the 
stitch structures underneath the inlay pattern. Stitches such as lace transfers, rib or 
links-links can be programmed to disrupt the inlay pattern, re-positioning singular 
points within the knitted surface. In particular, the intarsia inlay prototypes allowed 
surrounding areas of  knitted ground to retain links-links material behaviours. 
Knitted surfaces built combining intarsia inlay and links-links stitch structures 
triggered memories of  the Earth’s tectonics. This connection, combined with the 
need to articulate surface movements provided a geomorphic focus for the designed 
knitted surface topography aesthetics. 

Although this research follows a technique-led design perspective rather than a 
technical lens, some prototypes were impossible to knit without in-depth knowledge 
of  the knitting machine obtained through the initial practice. One such technical 
fault materialised during preliminary investigations of  the intarsia inlay causing 
knitting issues on the pattern edges (Figure 74). The N.SRY123LP knitting machine 
has swing carriers, which cause knit issues for intarsia inlay due to additional 
carrier movement between the knitted stitch and inlay float. This carrier side 
swinging motion is responsible for tearing on the inlay pattern edges. During Shima 
Seiki Mfg. Ltd. sessions, my trainer resolved this problem by introducing yarn 
feeder fixed blocks. These are moulded metal pieces that screw onto the carriers 
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Swing Carrier.				                 Non-Swing Carrier.
Figure 74. Knit issue on edge of  intarsia inlay due to carrier type.



preventing the mechanical swing action and converting the swing carriers to non-
swing carriers. The latest inlay knitting machines all contain non-swing carriers. 
This carrier adaptation was a major technological breakthrough for intarsia inlay 
surfaces on the N.SRY123LP knitting machine, significantly reducing knitting 
issues. The inclusion of  blockers was also a turning point in my perspective of  the 
design-technical balance, each aspect feeding the other in a collaborative making 
environment.

4.3 Phase Two: Understanding Knitted Material Forces

4.3.1 Building Surface Movement

In this practice, a single stitch informs a collective knitted surface through 
neighbouring networked connections. “A module never works alone but as 
an aggregation of  a multitude of  instances. Thus, the whole emerges out of  
the interaction of  a series of  individual objects” (Tessmann, 2009, p. 52). The 
prototypes aimed to capture compositional occurrences of  assembled material 
forces on singular and multiple levels. Individual knitted loops are dependent on 
networked relationships to transform from linear stable points into heterogeneous 
stitch sequences. Heterogeneous knitted surface behaviours resulted from the 
exploitation of  positioned material mechanics built from links-links textile print-
based repeats: block, half  drop and brick. An alternatively positioned square offset 
repeat tested less structured repeats, resulting in indeterminate material forces 
inconducive to controlling knitted surface movements. Each straight-sided geometry 
was tested as multiple scaled versions ranging from 100% to 500% to explore 
resultant effects on material forces. The repeating links-links patterns additionally 
informed the double bed inlay grounds. Applying a direct transference of  links-links 
patterns into the tubular jacquard knitted ground resulted in overly complicated 
visual compositions due to the initial scale and colour combinations prototyped. 
Further sampling of  the double bed inlay technique applied increased scales of  the 
original links-links pattern repeats, resulting in less-overcrowded surface patterning. 

Emergent compressional and tensional material forces informed the geometric 
shapes and scales of  links-links in variant repeating unit arrangements. For 
example, the links-links rectangle replicated in a brick repeat exhibits horizontal 
convergent material forces (Figure 75), decreasing the surface width. The scaled 
variants offer a range of  surface behaviours ranging from tight to broad elongated 
folds with twisted torsions. The same rectangle in a half-drop repeating pattern 
(Figure 76) produces vertical surface compressions. These convergent forces 
create vertical recumbent folds in waves that extend the surface width. Links-links 
knitting with balanced amounts of  knit and purl such as square produce the same 
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Figure 75. Interplay of  material forces in brick vertical rectangle, scale 100% to 500%.

Figure 76. Interplay of  material forces in half-drop vertical rectangle, scale 100% to 500%. 



appearance on the technical front and back surfaces. Triangle and the diamond 
links-links designs are unbalanced, and the technical front and back knitting afford 
different surface effects. The material forces reduce as the pattern ratio of  knit to 
purl stitch structure increases. Textures for single bed inlay prototypes were selected 
to accentuate material force collisions and tactility in the larger knitted surfaces.

Reflective analysis of  knitted surface deformations revealed convergent and 
divergent folded material forces. “Nonlinear behaviour needs non equilibrium 
conditions to become manifest” (DeLanda, 2004, p. 17). The material forces 
result in imbalanced surface conditions generating asymmetrical folding that 
shift the stitch loops from the programmed two-dimensional grid.  The resultant 
fractious material behaviours were generated not through my will imposed upon 
the surface; the knitted surface deformations arose as a collaboration between 
material behaviours, technique and designer during production (DeLanda, 
2004). Transforming the flat plane towards a site of  active matter highlighted the 
importance of  understanding the material forces through the mapping of  knitted 
stitch configurations and movements (Figure 77). Folding and unfolding knitted 
surfaces established a map of  temporal events (Küchler, 2020) containing traces 
of  the maker’s material interaction. Material forces resulted in subduction zones 
generating peaks and troughs where the line curves and the grid distorts as the 
knitted surface folds over itself  (Figure 78).
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Figure 77. Mapping relationships of  multiaxial material forces. 

Figure 78. Transformative material forces resulting in peaks and troughs. 



The surface becomes “a site where complex forces meet” (Adamson & Kelley, 2013, 
p. 1). Asymmetrical folds react to convergent forces generated by the placement of  
the links-links repeat. In contrast to this compression, the inlay creates divergent 
forces that extend and stabilise the surface. Interconnected to these material forces 
are collisional subduction zones where torsions are evident in the knitted surface. 
Photographic mapping of  the interplay between knit and inlay material forces 
highlights the material convergence (green), divergence (blue) and subduction 
(yellow) surface movements (Figure 79). Dimensional knitted surface topographies 
encapsulate multiaxial and unbalanced convergent, divergent and transformational 
forces.

4.3.2 Material States 

Material fibres were selected based on behavioural properties, in which the 
materials emphasised the knitted surface ‘texturology’ (Bruno, 2014). After testing 
various fibres, I selected merino and a wool-acrylic blend for the ground knits, due 
to their properties of  matter emergent agency. These fibres embrace the surface 
deformations that the links-links stitch structures influence. The surface folds 
achieved by cotton were less distinct and prone to unfolding (refer to Figure 48, 
page  48). In contrast the merino knitted ground maintained its knitted surface 
topography even when the overall surface scale increased and suspension of  the 
textile occurred. Experimentation with materials resulted in informed design 
decisions based on the “material performance and the systematic behaviour of  its 
assembly” (Kolarevic & Klinger, 2013, p. 7). Inlay textiles react differently to solely 
knitted textiles, due to the variant material properties of  the opposing construction 
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Figure 79. Mapping the material forces between knitted ground and intarsia inlay.



methods. Inlay knits are assembled in the digital grid as interconnected layers of  
making, folding onto and into themselves, encountered as a disrupted surface. 
According to researcher Claire Pajaczkowska (2005), the grid becomes “a matrix of  
intersecting verticals and horizontals, as systematic as graph paper, and yet it is soft, 
curved and can drape itself  into the three-dimensional fold” (p. 233). The digital 
coding emerges from the knitting machine as a pliable knitted textile with surface 
conditions acquiescent to the material stresses and forces present. 

This practice folded and enfolded material thinking through crafted programming 
of  the material forces to generate knitted surface shifts. According to Dormor 
(2020), textile practice occurs at, on and within the folding surface, recognising the 
fluidity and layering that this approach requires. The materials, the knitted loop 
and the inlay are always in a behavioural relationship (Jefferies, 2008). The balance 
of  this liaison relies on the ensuing material forces. The materials in my surfaces 
are not static or inanimate but connected by vibrant material forces. Understanding 
the dynamic material behaviours provides opportunities for innovative structural 
thinking and extension of  potential designs (Thomsen, 2014). This practice relies 
on understanding the interactions between the knitting technology, techniques and 
material forces that result in knitted surface topographical folding. Knowing how a 
reaction occurs means a reaction can be replicated, altered and manipulated during 
the act of  making. 

Tactility emerged as a critical design factor. The double bed grounds generated 
minimal surface movements. A heat-reactive polyester yarn, Pemotex, was 
introduced to the knitted grounds to increase surface deformation in double bed 
inlays (Figure 80). In my practice, the reactive yarn formed a linkage between 
initial knitted surface prototypes and the double bed inlay surface designs, evidence 
of  this research’s cyclic journey. Initial prototyping with Pemotex yarn trialled 
all-over steam, resulting in rigid solidified parts of  the knitted surface. Zonal heat 
application fostered a process affording multiple surface options in the active knitted 
matter from a single design. While double bed inlay surfaces with Pemotex yarn 
visually navigate similar multiaxial material forces, they are less predictable than the 
single bed links-links grounds.
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Before heat is applied to Pemotex yarn.                       After heat is applied to Pemotex yarn.    
Figure 78. Double bed inlay with heat-reactive surface deformation.



An alternative double bed inlay design aesthetic originated from solid colour-
blocking investigations (Figure 81). Knitting issues occurred when exposing the 
inlaid yarn in the tubular jacquard ground during the colour exchange. Although 
this surface aesthetic was considered effectual, it was viewed as a significant shift 
from the intersecting ground sections employed in the single bed knitted surface 
topographies. These solid blocks of  colour offered fewer opportunities for tubular 
pocket formation and possessed an element of  disconnect with the photographic 
landscapes. The surfaces retained a high level of  structured pattern organisation, 
rather than the fracturing and folding required to situate within my crafted 
knitted surface topographies. Heat-reactive fibres countered these flatter surface 
conditions. The performative characteristics of  the reactive material enhanced the 
programmed matter activity, allowing folds and fragmentation to enter the double 
bed inlay surface equation through external influences. 

Bolt (2007) challenges the idea that materials and a designers tools are simply 
a means to an end. Creative practice is portrayed “as a performance in which 
linkages are constantly being made and remade. Whilst each actor has the same 
praxiological status, each has its own character and contribution to make as part 
of  the work of  art” (Bolt, 2007, p. 3). In this sense, the materials selected became 
active participants in the creative process, with characteristics and quirks that enter 
the design equation. Knit, weave, yarn, and technology are all performers enlisted 
in the generation of  knitted surface topographies. Knitted surface topographies are 
articulations and sculptural interpretations of  the manipulated materials embedded 
in their making. 

Digital knitting is programmed in a virtual structured grid system however, the 
linear structure morphs as the static two-dimensional screen informs the dynamic 
three-dimensional matter agency that exits the knitting machine. The coded 
material becomes uncodified in the shift from virtual to physical presence. At what 
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Technical front.                                    Technical back.      
Figure 81. Double bed inlay prototype with sections of  solid colour blocking. 



point does this change occur? Is the matter agency activated as the knitted surface 
falls from the needles, free from constraints as a dimensional surface (Figure 82), 
constrained by knitted edges but not held within a frame? According to Pavko-
Čuden and Rant (2017), “in flat knitting, some link-links structures exhibit self-
folding after exiting the take-down zone. The folded state represents the relaxed, 
that is, the passive state” (p. 60). However, I view this emergent knitted surface as 
active as it morphs as the programmed combinatory material stresses and forces 
come into effect.

Similar to DeLanda’s (2004) perspective, the knitted surfaces become active 
material forming an evolutionary collaboration with, or sometimes in opposition 
to, the design and designer. This perspective is evidenced in the knitted surfaces: 
the digital screen illustrates an ordered coded design; however, the introduction of  
physical factors such as the knitted loop, inlay pick and materials create an interplay 
of  forces that inject their own will into the design equation. As Bolt (2007) suggests;
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Figure 82. Knitted surface topography released from machine constraints.

Our relation to technical things is inevitably characterized by a play 
between the understandings that we bring to the situation and the 
intelligence of  our tools and materials. This relation is not a relation of  
mastery but one of  co-emergence. (p. 3)

The virtual simulation of  the inlay knitted surface does not display the fluidity of  
knitting, where the technique is an active participant in the creation of  surface 
folding. I become a director of  the material forces while the tactile output is 
dependent on the performance and interaction of  many factors such as the 
machine gauge, yarn and stitch quality. An argument begins, a battle between 
the constructed affordances and the appearance of  shifting allegiances between 
subsequent material forces. The hierarchy of  techniques generates dynamic 
interactions. In combination with design decisions related to stitch structures, 



weave floats and positioning, the surface morphs into multiple options. The 
knitted surfaces are articulations and sculptural interpretations of  the manipulated 
materials incorporated in their making. The complex surface illustrates the 
assemblage revealed. The individual knitted stitches collectively entwine to build a 
multitude or entire terrain.

During the making process, layers occur consecutively, “multiple and mutable 
layers enfold meaning within and between modes of  practice” (Dormor, 2020, p. 
20). One of  the procedural questions that arose during this research concerned 
these interrelated material relationships: Are these layer relationships affected 
by a layering of  command? Is there a hierarchy of  activity with invisible rules 
applied? Do the materials shift first with the knitted stitch structure before the 
weave counters with stability? Which component of  the technique has more 
influence, the knitted loop or the inlay pick? When the inlay pattern has a longer 
float, the knitted loop can afford more movement, but the inlay holds more stability 
when applied en masse, overriding surface shifts. Understanding and influencing 
these interconnected relationships is key to designing with the knitted material 
forces. The dominance of  knitted ground or inlay pattern became evident as the 
prototypes moved into territories of  material force exploration.

4.3.3 Additive and Subtractive Design

The research examines this idea of  a hierarchy or dominance through the 
assemblage of  intarsia and double bed inlays, where the inlay yarn partially 
breaks the surface plane. Material behavioural manipulation correlates directly 
to the inlay placement, pattern, and quantity achieved through additive and 
subtractive design. To allow material forces to enter the inlay and encourage zonal 
or partial subservient interaction with the knitted ground, I experimented with 
reductive derivatives of  the intarsia inlay pattern. Ingold (2016) notes, “lines that 
are scratched, scored or etched into a surface are reductive since in this case they 
are formed by removal of  material from the surface itself ” (p. 44). Fragmentation 
across the knitted surface topography transpires when the compressional, tensional 
and shearing forces collide. Reading of  material forces occurs across the vertical 
and horizontal axes. Reciprocal relationships emerge between oppositional material 
forces generated by the positioning of  knit and weave-like textile structures. 

Programmed horizontal and vertical subtractions (Figure 83) fracture the inlay 
patterning, allowing the ground material activity to dominate the knitted surface 
folds. Larger blocks of  subtracted inlay patterning shifted the inherent stability of  
inlay, encouraging the ground deformation. The composite screen-view of  both 
inlay and stitch structure layers allowed informed design decisions when positioning 
material force alliances. Knitted loops push and pull the neighbouring stitches, 
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and the interlocked singular inlay picks enmesh to inform the surface dynamics 
(Figure 84). This pattern-modification method is critical to vertical and horizontal 
surface fragmentations, allowing dominance of  weave or knit characteristics for 
each programmed point, informing a component of  the surface-building blocks. 
The ability to position a weave-like structure in designated areas offers designers the 
opportunity to alter the knitting’s material behaviour, and extends future pattern, 
surface and application opportunities.

The removal of  considerable amounts of  the inlay pattern results in the knit 
becoming dominant in the overall aesthetic (Figure 85). In these combinatory 
prototypes, the reduced inlay pattern provides too little design for the eye to 
navigate towards the immaterial completion of  the pattern layout. Understanding 
the ratio of  inlay to knit and the layered relationship is essential to generating the 
desired material forces and a balanced aesthetic. This “designerly way of  knowing” 
(Cross, 2006, p. 5) is partially tacit learning acquired innately. My practice shifted 
between digital and physical realms, increasing my understanding and ability to 
envision two-dimensional codes as three-dimensional knitted surfaces.

Aspects of  the designs disrupted and warped the vertical and horizontal elements 
of  the digital-programming grid. A successful grid disturbance method was 
created by introducing horizontal trails of  points of  inlay across the knitted surface 
(Figure 86). Inlay dashes or dots that remain negotiate the knitted surface peaks 79

Figure 83. Programmed vertical, horizontal 
and block subtraction of  intarsia inlay.

Figure 84. Intarsia inlay pattern subtraction 
with links-links knitted ground dynamics.

Figure 85. Minimal intarsia inlay pattern 

with links-links dominating the surface.

Figure 86. Intarsia inlay negotiating links-
links material forces.



and troughs, revealing and concealing the ends of  intarsia inlay. These subtracted 
individual points serve as remnants of  the inlay knitting, traces of  patterns with the 
ability to blur the linear edges and follow the material properties (Arantes, 2020b). 
The barely visible inlay picks effectively connect the inlay knitting across the entire 
width of  the needle bed, affording pathways from one side to the corresponding 
edge. When these traces are layered over horizontal courses of  purl stitch structures 
the inlay follows the knitted surface ridge. The variations of  subtraction added to 
the surface-building block design options.

4.3.4 Visible Surface Traces
 
My initial interaction with the inlay technique was self-taught, resulting in 
unexpected findings, such as the yarn visibly tracing connective inlay pathways. 
As author Richard Sennett (2008) notes, “machines break down when they lose 
control, whereas people make discoveries” (p. 113). Trace connections between 
elements initiated a shared choreography and co-authorship of  a mapped surface 
trajectory. These yarn float pathways resulted from my subtractive design approach 
to inlay patterning. “In our terms the trace is any enduring mark left in or on a solid 
surface by a continuous movement” (Ingold, 2016, p. 43). In my prototypes, trails 
of  connection are visible as continuous strands on the knitted surface’s technical 
back-face, revealing the inlay yarn’s migration. The two-by-two rib ground with 
curved inlay areas illustrated in Figure 87 demonstrates the concertina effect of  
a ribbed ground on multiple traces of  inlay yarn. The length of  the inlay yarn 
stretches across the knitting needles; however, once released from the machine’s 
constraints, these strands relax, forming longer, curved linkages.

These traces can be eliminated, minimised or multiplied depending on the 
programming and positioning of  the intarsia pattern. Linear inlay designs with 
straight edges can be programmed to produce minimal inlay linkages (Figure 
88). These trails are a residue of  the making process, relying on the knitted inlay 
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Figure 87. Rib ground with curved 
intarsia inlay illustrating multiple knit 

linkages. 

Figure 88. Single bed knitted ground with 
linear intarsia inlay illustrating minimal 
knit linkages. 



design’s directional location on an odd or even course. The locational relationship 
between each intarsia inlay section to the neighbouring pattern is critical to 
revealing or concealing yarn pathways. The number of  traces generated is 
controllable, with curved inlay divisions generating more inlay points of  connection 
between trough and crest bands than linear territories. Inlay linkages appeared 
as uncontrolled maps in the initial surfaces, occurring due to limited inlay-
programming knowledge. However, as my technical inlay programming knowledge 
progressed, this creative mistake allowed a unique element to enter the surface-
building blocks and mode of  making. 
 
Inlay yarn draws the pathway between intarsia areas, remaining inside the edges 
of  the knitted surface. This trajectory is invisible on-screen, becoming visible when 
making the virtual into physical. “Whilst vision gives a detailed description of  the 
surface features of  our environment, a superficial mapping of  the landscape, touch 
provides insight as to how these elements are interrelated” (Philpott, 2012b, p. 
55). Following the material traces with fingertips, the point-to-point connections 
between inlay patterns are disclosed and understood. Academics Roland Johansson 
and Randell Flanagan (2009) note;
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When humans manipulate objects, the brain uses tactile afferent 
information related to the time course, magnitude, direction and 
spatial distribution of  contact forces, the shapes of  contacted surfaces, 
and the friction between contacted surfaces and the digits. The inside 
of  the human hand is equipped with four functionally distinct types of  
tactile afferents. (p. 345)

Knowledge attained through haptic interaction with the concealed surface is 
required to understand different facets of  the knitted surface; the topography is 
tactile. The patterns and materials are understood as active participants imbued 
with complex behaviours offering new design potential (Thomsen, 2014). 
Experience and reflection fold into the twists and torsions as material forces collide. 
The knitted surface topographies rely on programmed replication, alteration and 
know-how to assemble the inter-relational material forces.

4.4 Phase Three: Developing a New Design Strategy 

4.4.1 Language Influences

The material forces that occurred through links-links repeats and scale testing 
evoked visual connectivity to land movements. The geomorphic language selected 
to articulate the material forces and encapsulate surface aesthetics informed this 



design practice. “Our planet’s surface topography, the distribution of  landscape 
highs and lows, is complex and intriguing” (Peterson et al., 2017, p. 385). 
Translation of  landscape photographs inspired knitted surface topographies which 
explore complex surface relationships on a micro and macro level, building an 
innate understanding of  surface movements. Applying material forces as an integral 
part of  knitted surface design generates a new perspective on links-links and inlay 
interactions with knitted surface processes. Figure 89 is a textural snapshot taken at 
Te Kouma, Coromandel, capturing the sand caught in time yet fluid in its ability to 
shift with the next tide. “After it is built, structure is still not a fixed entity. It moves 
and changes, depending on how it is used” (Grosz 2001, p. 7). Knitted surfaces 
shift and morph with each positioning. The knitted surfaces in this study retain the 
ability to manifest as active sites constantly emergent due to the structural flexibility 
of  knitting, emulating the fluidity of  nature (Figure 90).

A fluid design approach was applied to intuitive knowledge during the digital 
creative process, directly responding to technical and material design issues. The 
research was a journey of  material thinking through practice. Theoretical context 
evolved through reflective practice, parallel with the material thinking behind 
the creative process and the connective relationships that emerged. Subtracted 
fragments of  the inlay pattern in the knitted surface topographies cause the human 
eye to attempt to complete pattern configurations and build regularity from the 
irregular. The fragments consist “of  elements that can be dislocated, manipulated, 
cloned and endlessly mutated” (Hedges, 2012, p. 57). My pattern design method 
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Figure 89. Sand textures from Te Kouma, Coromandel, New Zealand.

Figure 90. Material forces in the knitted surface emulating nature’s fluidity. 



disrupted the knitted surface. The assembled units increased the potential for novel 
design solutions (Philpott, 2011), as heterogeneous knitted terrains. In the knitted 
surfaces, design compositions followed repeating patterns. These patterns are not 
merely ornamental but intrinsic to building a knitted surface topography.
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The repetition of  working units, whether understood as repeat or not, 
generates the textile object. Consequently, all textile techniques are 
based on the idea of  patterning: an isolated unit (repeat) is repeated 
with potential infinity. So, we can state patterns are not accidental but 
substantive to textiles. (Kraft, 2004, p. 281)

Material forces imbued in the links-links ground are built with the inlay pattern 
positioned as separate yet interrelated to the knitted loops’ behavioural properties. 
These patterns can be infinitely variable and like encoded language, the textiles 
arbitrarily converse (Barber, 1994) with the designer in an open-ended exchange. 
Consideration of  the inlay positioning and proportion occur synchronously with 
the development of  ground patterning in these knitted surfaces. A knitted inlay 
is a hybrid textile constructed from intersections that build one point from two 
autonomous factors, tracking paths that react to different material rules and forces; 
the subsequent surface embodies coerced disruptions. “Landforms represent the 
interplay of   one set of  processes that elevate, depress, or disrupt the Earth’s surface 
creating topographic inequalities” (Peterson et al., 2017, p. 386). The programmed 
links-links grounds and scales afford intersectional collisions influenced by surface 
movements contained in natural environments. 

Initial hybrid surfaces investigated programmed material behaviours positioning 
intarsia inlay into a single links-links ground. These investigations provided a base 
understanding of  inlay edge technical knitting issues but lacked a design emphasis. 
Single motif  repeating grounds promptly progressed to complex divisional 
placement of  multiple links-links grounds (Figure 91), increasing knitted surface 

Figure 91. Progression of  the links-links patterning complexity single to multiple ground collisions. 



disruption. Multiaxial material forces from a single links-links ground resulted in 
more fabric drop from the weight than multiple intersecting patterned surfaces. 
The vertical drop of  the knitted surface is an encounter between multiple elements 
with interconnective relationships, a dynamism of  assembled alliances. The surface 
manifests “as both action and artefact, process and product, becoming and being” 
(Carlin, 2018, p. 11). The heterogeneous knitted surface topography conditions 
exhibit multiple matter configurations.

4.4.2 Building a Single Bed Topography

The organic patterns of  natural landscapes have informed my practice, offering 
an alternative interpretation of  pattern and placement for knitted surface. 
Classification of  surface movements draws from geomorphological terminology 
relating to directional material forces, navigating complex folding over the knitted 
surface topographies. The building of  the single bed inlay surface designs utilised 
structured digital processes to create unstructured physical outputs (refer to 
Appendix E). The design approach layers linear-digital grids to produce surface 
transformations during the conversion to physical knitted surfaces. This method 
of  making relies on intuition in a way I struggle to articulate, as it is a connection 
between myself  and the technology. This unarticulated tacit knowledge (Polyani, 
1967) has become personal knowledge acquired through intense engagement with 
the links-links and inlay knitting techniques.

During this topographical investigative practice stage, several links-links ground 
scales and intarsia inlay designs were built using the layered automatic software 
method. These prototypes taught reflective approaches to construct single bed 
knitted surface fragmentation through material force manipulation. Design 
componentry selection for the construction of  knitted surface topography occurred 
in a formulaic pick-and-mix approach from the identified surface-building block 
components; for example, the design components selected for the Block Twill 
knitted surface topography (Figure 92). 

The library of  links-links prototypes reinforced design decisions based on tactility, 
force direction, and surface aesthetics. These links-links grounds were collaged 
directly onto the screen into the sections inspired by the layered photographs. 
Initial selection of  the ground structures was  based on the screen aesthetic and 
proportion, without consideration of  the disruptions multiaxial forces could cause. 
With a growing understanding of  the sectional surface interactions, opposing 
directional material forces generated surface deformations that maximised the 
collision of  designed horizontal and vertical stresses. The Block Twill prototype 
contains a distinctive weave origin built from inverse and standard coded inlay 
in alternating rectangular blocks. Solid areas of  inlay patterning establish weave-
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Figure 92. Surface-building blocks for single bed intarsia inlay Block Twill knitted surface topography.



dominant characteristics that influence the stability of  the knitted surface (Figure 
93). Programmed collisions rapidly exchange link-links grounds over short 
distances instigating multiaxial active boundaries (Figure 94). These fractured areas 
demonstrate evidence of  the dominant properties of  merino yarn in the resultant 
dynamic knitted surface activity. 

Layering of  material forces transpired to reveal and conceal surface patterns 
in which horizontal and vertical linear deletions of  the inlay allow oppositional 
convergent and divergent material forces to materialise as active folds. These linear 
deletions follow the folding tract of  the links-links ground, allowing disruption 
of  the linear grid through biaxial compressions. Crafted two-dimensional knit 
codes built an environment conducive to the transference of  vibrant matter 
(Bennet, 2010) into complex three-dimensional surface disruptions (Figure 95). 

86

Figure 93. Block Twill intarsia inlay with 
weave-dominant material forces.

Figure 94. Block Twill single bed intarsia 
inlay with multiaxial material forces.

Figure 95. Fragmentation of  links-links ground and inlay pattern in Block Twill intarsia inlay. 



Fragmentation of  material forces and patterning deform the entire surface, where 
the fragment, according to Barnett (1999),
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bears witness to a broken whole; yet it is also a site of  uncertainty from 
which to start over; it is where the mind extends beyond the fragile 
boundaries, beyond frayed and indeterminate edges, expanding in the 
fluidity of  the smooth. (p. 188) 

The fragmentation of  the inlay pattern breaks the programmed surface affording 
an element of  ambiguity in my design process as an unstructured knitted surface 
emerges. The compressional or tensional edge conditions increase or reduce the 
width of  the knitted textile. These active boundary conditions are responses to 
the componentry decisions formulated during assemblage, generating non-linear 
surface movements.

This practice observed surface folds and fractures generated as a response to 
the merino’s material performance; similar to how surface relief  is informed by 
the Earth’s behaviour when subjected to forces and stresses. “Folding, which is a 
bending or crumpling of  rock layers, occurs when compressional forces are applied 
to rocks that are ductile (bendable) rather than brittle” (Peterson et al., 2017, p. 
389). The knitted loop formation is conducive to a malleable material where the 
resultant matter demonstrates dynamic fluid traits within the knitted surface. The 
knitted loop is coerced in multiaxial directions in response to the inlay and the 
push and pull of  neighbouring links-links loops. The key to knitting a single bed 
intarsia inlay topography is the technical clearing of  the edges. Areas of  back bed 
stitch structure and inlay overlaps require alteration to front knit to remove knitting 
issues at these technique edges. This blend of  technical and design knowledge is 
essential to the development of  this research practice. Without this deeper technical 
understanding of  inlay and material force assemblage, digital knitting design 
remains limited. In discourse relating to hand knitting, Arantes (2020a) writes:

Not just due to the fractal character of  knitted surfaces but also due 
to the various ways of  building them up through using different types 
of  stitches and patterns, knitted things are far from being flat, two-
dimensional phenomena, even if  the term surface – particularly in an 
elementary mathematical sense – might imply such a geometric state. 
Knitted surface textures present us with a whole textile landscape in 
and of  themselves. (p. 163)

My designed surfaces illustrate and support the acquisition of  material forces 
knowledge through a physical vehicle (Mäkelä, 2007; Nimkulrat, 2009). These 
constructions of  material forces inform topographies that encourage navigation by 
touch across the entire surface. The hand embraces surface disruptions as Dormor 



88

Fill layer with links-links pattern.                                    Fill layer with inlay pattern. 
Figure 96. Interpretation of  photograph of  land, sea and sky across two knitted surface topographies.

Landscape photograph.                                                    Sectional colour-blocking.



(2020) notes, “the caress is a seeking to know” (p. 104). Physical encounters explore 
the notion that haptics offer multiple information exchanges for the maker during 
the crafting process (Harris, 2005). I absorb information through touch, responding 
to the tactility and understanding more than vision alone comprehends (Prytherch 
& McLundie, 2002). As Philpott (2011) suggests, “our intimate and ubiquitous 
daily bodily contact with textiles fosters a particularly close relationship between 
textile designers and the materiality of  their discipline” ( p. 101). The virtual coding 
decodes as physical form, the material forces between knitted stitch and inlay are 
navigated as fingertips unfold the hidden surface. 

Although the original photographic images are horizontal, my knitted panels tend 
to be vertical layouts due to needle bed constraints of  width whilst the length is 
limitless. Digital manipulation of  the photographs occurred through processes 
that cropped, transformed and divided the images. The interrelated sectioning 
interpreted the photographic divisions evidenced in nature’s layers of  land, sea 
and sky across two knitted panels (Figure 96). Colour-blocking of  these sections 
allowed a paint-by-numbers approach and efficient filling of  the digital surface 
with numerous links-links grounds. The realisation of  zonal proportion on-screen 
was critical; sometimes, the size of  the divided sections increased or lines shifted 
to improve the overall aesthetic balance. These design adjustments relied on an 
ability to convert on-screen codes into the physical knit. The increased panel size 
encountered diminished surface disruption when smaller-scaled grounds positioned 
in larger knitted surfaces (Figure 97). Increasing the surface size required some 
links-links grounds to be scaled up to maintain an overall design equilibrium, as 
achieved in smaller prototypes. 
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Figure 97. Diminished surface pattern disruption in the larger knitted surface topography.



The inlay pattern and the ground structures provided border design crossover 
of  pictorial scenes over multiple panels, yet each textile’s edge conditions reacted 
independently. This design extension across multiples encouraged a collapse of  
the framed boundaries through the embedded surface’s specifically positioned 
conditions. Crafting the knitted surface across borders uses “the idea of  
connectedness in terms of  paths between points” (Messer & Staffin, 2018, p. 209). 
To design an effective transference of  the inlay patterning across interconnected 
panels, it was necessary to preserve the aesthetic of  the inlay beyond the knitted 
panel edges. If  the pattern subtraction method removed significant amounts of  
the identifiable weave appearance, the eye dissipated the inlay design, rather than 
tracing pathways and connecting across knitted surfaces. At this length, the multiple 
interconnected knitted surfaces were programmed directly into the automatic 
software.

4.4.3 Building a Rib Topography

During the additional exploration of  the inlay technique using the automatic 
software, I discovered the potential to shift the grid’s programmed vertical linearity 
by introducing rib as a knitted ground (refer to Appendix F). The rib inlay offers 
design opportunities for subtle surface fragmentation as individual stitch loops 
warp, deforming neighbourhood stitches and mapping a distortion of  the vertical 
linear. Initial rib-based prototypes applied a two-by-two rib structure, covering 
the entire ground with twill and plain intarsia inlay patterns. These inlay patterns 
maintained the weave aesthetic even when the rib emitted the illusion of  partial 
concealment of  design. Obscuring the intarsia inlay pattern occurred due to the 
tight folds of  consistent convergent forces informing the rib’s regular vertical ridges 
(Figure 98). These tight folds informed pattern effects, with specific points mapping 
back on themselves (Messer & Staffin, 2018). The intarsia inlay positioning 
imparted surface disruption, imposing a displacement of  the rib’s movement 
to a positioning outside the virtual programmed site. Through an increased 
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Technical front.                                                            Technical back.
Figure 98. Two-by-two rib with diamond twill intarsia inlay, illustrating the displacement of  linear rib.
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Figure 99. Surface-building blocks for rib intarsia inlay Strata V1 and V2 knitted surface topography.



understanding of  the heterogeneous behaviours of  the knitted loop and inlay, I 
could code the knit’s compositional performance, informing the active surface 
matter. The material forces of  the intarsia inlay produced the visual conveyance of  
linear rib to the left or right in response to the inlay application. Twill inlay is very 
tactile, exhibiting an embroidery-like appearance, and feels similar to reading the 
surface as braille. The resultant visual effect holds a QR-code-matrix quality as the 
eye attempts to decode the inlay pattern.

Assemblages explored multiple overlapping intersections to intensify collision 
between knitted material forces. A series of  strata-inspired prototypes utilised the 
pick-and-mix technique to select components from the surface-building blocks: 
plain weave inlay with inverse pattern and sections of  purely knitted two-by-two rib 
(Figure 99). As Dormor (2020) proposes, woven surfaces are “a space for thinking 
through the interplay of  textile structure and its behaviour” (p. 65). Ribbed 
ground prototypes allowed me to recognise the importance of  balance between 
the inlay pattern and plain rib areas of  relief. Prototype Strata V1 did not contain 
enough inlay patterning to significantly disrupt the knitted surface, due to an over-
merging of  the divisional sections on-screen. The inclusion of  inverse inlay in 
the design increased the pattern contrast and aided in defining zonal separations. 
The prototype Strata V1 contains several inlay sections that incorporate a partial 
subtraction comprised of  deleted linear blocks, producing squared edges (Figure 
100).

Behavioural relationships in the ribbed surface increased by multiplying the 
number of  interconnected layers sketched on-screen. Pattern impacts the way we 
interact with, see and negotiate our environment (Jefferies, 2012). The structured 
squaring of  the intarsia inlay edges, as evidenced in Strata V1, was not effective at 
maintaining the layered sectional contours of  the original photograph. According 
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Figure 100. Strata V1 knitted surface topography with squared inlay edges. 



to DeLanda (2015), “nonlinear patterns represent a variety of  possibilities of  
which the linear case is but a limiting one” (p. 17). The nonlinear design approach 
to surface division used in Strata V2 produced multiple traces of  the inlay yarn 
pathways and maintained a stronger connection to the inspirational source 
(Figure 101). The two-by-two rib creates the illusion of  longer floats, bringing the 
foreground knitted surface closer together through the tight vertical folds.

This practice progressed to incorporate knowledge of  material forces gained 
from previous prototypes. The juxtaposition of  the tightly regulated rib folds with 
active matter generated through the links-links grounds created an environment 
of  contrasting material forces. The horizontal rib compressions sit beside 
the multiaxial forces of  the links-links grounds, increasing the knitted surface 
deformation and altering the edge conditions. Dormor (2020) notes “as a structure 
and an action, folding resists occupying a singular space, preferring a space that has 
the capacity to stretch, fold and inflect” (p. 11). The layering of  components from 
the surface-building blocks generated the knitted surface topography of  Strata V3 
(Figure 102). Using colour-blocking and pattern fill the compound ground was built 
on the structure page through intuitive positioning of  the two-by-two rib and the 
dynamic links-links ground repeats (Figure 103). The inlay pattern was then aligned 
to the mixed ground and viewed as a composite screen to check the designed 
behavioural interactions (Figure 104).

The emergent surface reveals the intersectional reactions of  knit and inlay, 
demonstrating relational material forces that generate symmetrical and 
asymmetrical folds. “In their unfolding, the pleats reveal their formation, in their 
formation their unfolding is created. This is the temporal field of  the fold. It holds 
within itself  an unfolding event: folds within folds” (Dormor, 2020, p. 12). The 
links-links ground increases the distortion of  the edge conditions, and convergent 
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Figure 101. Strata V2 knitted surface topography with curved surface sections.
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Figure 102. Surface-building blocks for Strata V3 rib intarsia inlay knitted surface topography.
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Figure 103. Converting colour-blocking to rib and links-links grounds.

Figure 104. Layered relationships of  inlay colour and structure viewed as a composite page. 



and divergent forces become evident. The rib areas behind the inlay pattern 
provide consistency within the ground while allowing a subtle distortion of  the 
pattern (Figure 105). The technical surface back illustrates the pathway of  inlay 
yarn as traces are drawn over the surface (Ingold, 2016). The rib’s accordion-like 
surface affects the pathway curves as the trace is longer than the folded ground 
it lies behind. The built knitted surface navigates the yarn and stitch agency, 
generating active boundaries that settle and resettle, concealing and revealing the 
nuances of  embedded material forces.

4.4.4 Building a Double Bed Topography

Inlay knitting technology is used in double bed surface prototypes to position 
strands of  yarn inside two grounds rather than embedding them within a single 
ground. The construction of  double bed grounds consists of  tubular jacquard 
knitting techniques that allow two surfaces with varied appearances to be created. 
Complex old-format programming applies packages that dictate the inserted 
yarn’s visible points in the double bed knitted surfaces (refer to Appendix G). The 
double bed inlay designs are modulated interpretations of  weave patterns, due to 
technical coding issues involving the number of  needles and courses required for an 
individual juncture of  reveal. Single bed inlay patterns require a sole code to form 
an inlay point, whereas double bed inlay entails a group of  four codes to generate 
one point of  surface exposure. These double bed inlays remain level planes with 
limited visible disruption of  material forces until reactive yarns such as Pemotex 
enter the surface assemblage process.
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Technical front.		                        Technical back.
Figure 105. Strata V3 knitted surface topography.



These double bed knits require external activation to generate dormant material 
forces contained in the reactive yarn. As noted by DeLanda (2015), “morphogenesis 
can only take place if  an external agency acts on inert matter” (p. 21). In this 
research, heat is the catalyst used to activate the deformative behaviour of  the 
Pemotex yarn, triggering other material states (DeLanda, 2015). The thermal 
reactive properties of  the prototypes were stimulated through a heat source, 
allowing an increased level of  control in the crafted material forces. As observed in 
the double bed inlay prototype, combining a ground yarn with Pemotex yarn allows 
yarn activation with variant colour opportunities (Figure 106). The tubular pockets 
combine with the convergent material forces of  the Pemotex yarn, informing 
asymmetrical folds and troughs.

Academic Jane Scott (2015) states in response to programmable reactivity in knit:
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Before heat is applied.			                After heat is applied.
Figure 106. Double bed inlay demonstrating merino combined with Pemotex yarn.

Shape change is controlled by yarns and knit structure, and the 
fabric itself  determines the final geometries as it transforms from 
2D to 3D. The careful application of  all aspects of  the textile: fibres, 
yarns, fabric, and form, means that rather than applying additional 
technology to a knitted substrate [surface], my work embodies the 
nature of  knit itself  as a responsive form. (Scott, 2015, p. 17)

Like author Anne Fields’ (2010) collapse weave technique, the double bed inlay 
surfaces use the dynamic behaviour of  the fibres to distort the linear making 
process, following the material’s properties (Arantes, 2020b). The surface stability 
emerges from the positioning and activation of  compressional yarn characteristics 
rather than the knit or weave surface aspects. The inclusion of  Pemotex yarn in 
the ground knitting creates a surface awaiting activation, a “site where complex 
forces meet” (Adamson & Kelley, 2013, p. 1). The activated Pemotex yarn captures 
the material forces and individual stitch movements as a singular preserved state 
of  matter flux. Once heat activated, the knitted surface becomes a permanent 
representation of  the material’s dynamic affordances.



Double bed inlay techniques apply a layered assemblage of  designed components 
within old-format software on a single screen (Figure 107). The terrain layout for 
the preliminary tubular jacquard grounds used cropped and merged sections from 
a photographic landscape (Figure 108). These partitional lines were altered on 
the digital screen, shifting the balance between interconnected surface conditions. 
Philpott (2011) writes that “attention to details of  surface texture in the design 
process establishes the material, tactile object as central, rather than the image of  
the object” (p. 120). This tacit response to the screen emerged through knowledge 
and the ability to interpret the coded digital as the built physical surface’s tactility. 
Academic Peta Carlin (2018) refers to building a relationship between surface and 
place, noting that “the resultant web can be read as a structure, surface or pattern, 
or often a combination of  these, for the concept like a fabric is pliable and is given 
shape via deft manipulations” (pp. 10-11). Although Carlin references weave, this 
applies to the encountered relational layers between the surface linearity of  the 
knit and inlay components entwined with the material behaviours, maker and 
technology.

Shima Seiki SDS-One Apex3 software packages hold essential knitting machine 
information in a coded format required to develop knit designs. These double 
bed inlay surfaces cannot be generated via automatic software due to the complex 
knitting information required. Surface-building blocks selected for the initial double 
bed inlay prototypes (Figure 109) were adaptive derivatives of  a prior single bed 
prototype. The previously used inlay and links-links ground patterns were copied 
to an old-format programming page. The coded colours of  the ground were 
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Figure 107. Programming of  separate inlay 
pattern and ground layers on a single screen 
in old-format software.

Figure 108. Cropped Coromandel landscape 
photograph for ground sections.
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Figure 109. Surface-building blocks for double bed inlay Lace Twill V5 knitted surface topography.



exchanged with tubular jacquard package colours, altering the single bed to double 
bed knitting (Figure 110). 

Replicating the diamond twill pattern in the Lace Twill V5 double bed inlay 
surface required an increase in the original pattern scale (Figure 111) and the 
placement of  programmed packages for the lace holes. The weave-inspired pattern 
is disclosed across the exterior of  the surfaces, detailed but inert in larger sections 
unless horizontal or vertical fragmentation allows the material forces to enter the 
surface equation. This crafted manipulation of  material forces informs the textural 
manifestation of  design intent. The double bed inlay technique required too many 
needles and courses per package to knit an exact representation of  the complex 
diagonal twill pattern shifts. 

The separately crafted ground and the inlay pattern components were positioned 
layer upon layer, merging design and technical knowledge. The double bed inlay 
pattern’s interrelated arrangement in relation to the jacquard ground can be on 
an even or odd course, as the inserted yarn is positioned internally across the 
entire surface. During double bed inlay trials, it was discovered that the visible 
points of  the positioned yarn must remain within the knitting area of  a single 
carrier, as multiple carriers interchanging inside the inlay pattern caused technical 
knitting issues. Subtraction of  inlay patterning entailed deletion of  entire package 
groups, horizontally and vertically. In this respect, the technical disclosed design 
possibilities, with packages positioned in response to technological and tacit 
knowledge. This practice transpired not as the search for an optimal solution; 
instead, the technique-led design was exploratory (Philpott, 2011). The knitted 
surfaces marked the passage of  my knowledge-building journey. 

The design assemblage process for the double bed inlay technique tested 
assemblage variations of  inlay patterning. These double bed inlay prototypes 
trialled singular and multiple points of  yarn exposure, generating surface 
knowledge through variant additive and reductive exploration. According to Albers 
(1944), free material experimentation provides a space for material performance 
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Figure 111. Diamond twill pattern coding conversion for double bed inlay Lace Twill V5.



which “can result in art, or it can result in the satisfaction of  invention in some 
more technical way” (p. 52). The material behaviour of  Pemotex yarn is necessary 
for transformative surface shifts. Material forces become physical manifestations of  
coding placements, in which the surface transforms “as the digital manifests itself  as 
a material surface” (Rauch, 2020, p. 59).

The scales of  the geometric ground patterns are critical in the double bed practice, 
as assemblages using small scale repeats produced predominantly inflexible surface 
deformations. Scaling up the geometric pattern surface-building blocks increased 
the volume of  material in tubular pockets, encouraging a more flexible folding 
behaviour comparable to the multiaxial links-links surface disruptions (Figure 
112). This design replication process utilising surface-building blocks generated 
for single bed grounds provided a comparative environment between knitting 
techniques, regarding the successful inclusion of  material forces and resultant 
surface topographies. The thermally activated Pemotex folds are semi-controlled, 
partially directed by the maker assisting the unpredictable heat activation processes 
that dictate surface disruptions. The activated surface shifts are emergent within the 
design process rather than a pre-existing condition.

The double bed inlay packages result in enclosed yarn mapping beneath knitted 
surfaces, selvedge to selvedge, emerging through crafted lace holes to reveal 
encoded patterns. Ingold (2016) discusses traces drawn over a surface; however, 
my double bed techniques conceal inlay traces between surfaces, appearing, 
disappearing and reappearing. The inlaid yarn establishes pathways built from 
regular knitting machine movements forming irregular layering between grounds. 
Double bed inlay edges can be closed with the inlay yarn visible as a series of  
taut vertical loops, fully closed edges using tubular jacquard colour exchanges or 
open tubular edges revealing longer traces of  the internal yarn (Figure 113). The 
emergent edge conditions are “zones of  interactivity” (Halliwell, 2020, p. 63), 
becoming either structured planes or unstructured biaxial compressions disrupting 
visibility of  the inlay yarn’s path.
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Figure 112. Comparison of  a single bed intarsia inlay and double bed inlay knitted surface topography. 



4.5 Conclusion

This research has developed to combine theoretical and material practices inspired 
by geomorphological surfaces. This knitted surface practice is underpinned by in-
depth knowledge of  designed material forces and inlay knitting techniques. The 
assemblage of  material forces discussed in this chapter offers an alternative to 
stable planes, transforming surface aesthetics by visibly warping linearity through 
individual stitch deformations. My practice was fluid, with reflections folding into 
an intuitive experience through a series of  creative leaps, drawing on new technical 
and tacit know-how. The manifestation of  knowledge has become a personal, 
contextual journey, occurring over time and through direct engagement with the 
technology and knitted surfaces.

This research journey highlighted an internal conflict involving the precipice 
between technical and design knowledge. Does the technical lead the design, or 
does the design lead the technical? (Power, 2007). In this research practice, the 
technical initially guided the design; however, this shifted when the technical 
learning responded to the designed inlay knitted surfaces. The knowledge balance 
has altered, allowing the design to occur outside the known technical locale. Rather 
than programming being an impediment to potential creations, resolution of  
design issues occurred during this process as designer and technology co-created. 
This investigative development process looped back to the beginning, enfolding 
the knowledge gained from preliminary prototypes into the advanced knitting 
techniques learnt along this research journey. The research route followed a series 
of  cyclic iterations, with interconnective points of  design discovery along practice 
pathways. The theoretical context of  this practice evolved through the analysis 
of  making, in parallel with the thinking behind emergent interconnective process 
relationships.
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Closed side edges.                                         Closed side edges.                                     Open side edges.
Figure 113. Double bed inlay, closed and open side edge knitting options.



Using the surface-building blocks to design the knitted surface topography 
established a creative process utilising the interrelated responsive behaviours of  the 
components to generate multiaxial surface activity. The material forces of  knitted 
surfaces fracture the surface as tactile representations of  photographic landscapes. 
The design components form a “web of  relations that, on closer inspection, turns 
out to be a web of  relations of  relations” (Arantes, 2020b, p. 196), in which multiple 
dynamic relationships arise between yarn, knitted stitch structure, inlay, technology, 
materials and designer. The knitted surface topographies enfold the knowledge and 
showcase the links-links and inlay knitting techniques becoming sites of  technical-
design know-how (Nimkulrat, 2013). The next phase of  this practice was an 
informed practice synthesis to extend surface assemblage testing with the surface-
building blocks.
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5.1 Introduction

This chapter encapsulates the design methods and technical knowledge discussed 
previously in Chapter Four by investigating the effect of  size and scale on knitted 
surface topographies. The synthesis of  my practice utilised extreme elongation 
of  the surface lengths to discover the intersecting point of  balance between the 
technical and technological design boundaries. This research is positioned at this 
pivotal junction of  knowledge, embracing uncovered technological constraints 
interwoven with the assemblage of  the hybrid inlay technique. 

A series of  prototype panels investigate the generational process of  a collective 
landscape in which material activity negotiates multiple surfaces. “The play 
between the physical and the digital is recursive, experimental, and interpretative; 
each informs the other while never truly resulting in the same output” (McKnelly, 
2015, p. 3). Each panel is an individual persona interconnected to neighbouring 
surface conditions through the links-links ground and inlay pattern positioning. 

The task of  interpreting a physical landscape, via a photograph taken of  my 
grandmother’s Coromandel farm, into a knitted surface topography transpired. 
The intent of  this translation of  physical to digital to knitted surface was an 
extensive exploration of  the programming and processing abilities of  the Shima 
Seiki Mfg. Ltd. inlay knitting technology. During programming, a collaborative 
relationship emerged between the inlay knitting technology, design and material 
properties. The knitted panels are embodiments of  individual points of  disrupted 
materiality modulated in a single surface (Kolarevic & Klinger, 2013), becoming 
sites of  textile knowledge (Mäkelä, 2007). The landscape is programmed to be read 
across the multiple terrains, navigating the interconnected material behaviours. The 
exhibited Metamorphic Series become terrains informed by intangible and tangible 
design components as technology and designer work in partnership.

Chapter Five: Emergent Terrains

Knitted surfaces are material concretisations grown out of  tiny 
repeated movements. They do not hide, cover up or conceal; much to 
the contrary: they reveal. They reveal technical knowledge, skill and 
dexterity, they reveal an empathetic understanding of  materials and 
patterns. (Arantes, 2020a, p. 157)
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5.2 Phase Four: Synthesis of Practice

5.2.1 Surface-building Block Selection 

The elongated surfaces illustrate my ability to construct inlay designs at the edge of  
the capability of  inlay knitting technologies, utilising disruptive positioning of  the 
agency of  matter (Bolt, 2007). The single bed knitted inlay intarsia technique was 
selected as the most effective surface to demonstrate this juncture of  technology 
and design components. The programming incorporates the notion of  following 
the flow of  material properties (Arantes, 2020b), activating divergent performances 
of  the hybrid textile technique, inlay knitting. The Metamorphic Series uses scaled 
link-links grounds and a traditional diamond twill weave pattern (refer to Appendix 
G). By applying the surface-building block process (Figure 114) the collective 
surface assemblage of  links-links repeating patterns facilitates a mixture of  vertical 
and horizontal compressions, demonstrating a range of  textural qualities. Collaging 
multiaxial material forces counteracts a significant reduction of  knitted surface 
length or width. 

Designing the single and multiple panels required an on-screen process of  pattern 
synthesis (Cross, 2006). Variable scales prevent the monotony of  similar textures 
when viewed next to each other. Composition of  the tactility sometimes meant 
modifying the colour-blocking to increase collisional material behaviours. The 
intricate pick and float configuration of  Diamond Twill inlay facilitates the 
appearance of  a woven textile embedded into a knitted surface. The length of  
the Metamorphic Series afforded room for additional active boundary collisions 
between link-links grounds and inlay patterning. These programmed surface 
deformations and pattern fragmentations built on surface movements suggested by 
smaller samples and advanced personal material force knowledge.

5.2.2 Layer One - The Collective Ground

Landscapes from my grandmother’s farm on the Coromandel Peninsula, New 
Zealand, inform the multiple knitted surface topographies in the Metamorphic 
Series. The selected photograph was divided vertically into five equal sections, 
translating into five sequentially knitted panels. The sectional division of  the 
imagery operated as a temporal mapping (Küchler, 2020). Layers were used to 
decode the landscape and to separate contoured ground and embedded networks 
of  foliage. These components informed the links-links stitch structures and the inlay 
pattern placements. The extreme length of  the programmed panels in the series 
necessitated the formulation of  visual coping mechanisms. These methods included 
vertical and horizontal lines to provide a computational gauge for my eye and 
mind. Breaking the surface into hand-drawn sections provided a relational guide 



106

Figure 114. Surface-building blocks for the Metamorphic Series knitted surface topographies.



to the actual length and width of  the panels as separates and as one collective. A 
divisional grid system similar to techniques used for proportional drawing divided 
the image for this multiple-surface application (Figure 115).

The individual panels in the Metamorphic Series are a collective assemblage 
built in the old-format software. Old-format programming has the advantage of  
performing as a blank page, without the interference of  the software automatically 
reading the colours as coded information. The panels were set up at full needle-
bed width and the maximum length programmable in the automatic software. 
Five vertical lines separated the individual panels on-screen, and eight horizontal 
divisions enabled navigation of  the extreme length. This proportional division 
aided physical scaling during the transference of  continuous curved contours 
across multiple surfaces. The sections informed multiple terrains built from singular 
parts, where “its reality is defined by the structure formed by differential elements 
and distributions of  singularities” (DeLanda, 2015, p.17). These linear divisions 
were then recurved, eliminated and reformed, building stitch loop alliances while 
maintaining connectivity to the layered landscape. 

The balance of  ground colour-blocking harnesses intuition during the virtual 
placement of  the variant links-links patterns. The stitch structure arrangements 
foster multiaxial material forces. These entwined material forces travel internally 
to knitted surface boundaries. The selected, scaled links-links patterns exhibit 
juxtaposing behavioural characteristics, forming heterogeneous alliances that 
generate surface fragmentations. Author Anne Smelik (2016) notes that “becoming 
is about creating alliances or encounters” (p. 167). The transformative knitted 
surfaces become through built agency, enabling emergent activity between 
neighbouring knitted loops. The frequent interchanging of  ground patterns 
increased virtual surface disruptions in a “stabilizing and destabilizing process of  
iterative intra-activity” (Barad, 2003, p. 822).
  
Physical swatches were collaged to select the links-links grounds from the previously 
developed geometric pattern surface-building blocks (refer to Chapter Four). This 
method ensured a medley of  contrasting scales and patterns, providing a range 
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Figure 115. Vertical and horizontal lines dividing the photograph for multiple panel design.



of  tactility and material interactions. Once applied to the digital environment, 
active boundaries were evaluated in terms of  visual discordance between border 
patterning. Developing the knitted surface aesthetic is a subjective design approach 
in which my “visual system is working to match its input with…prior knowledge 
to arrive at the best guess of  what is being seen” (Pepperwell, 2019, p. 117). The 
digital knit coding is decoded into an approximation of  the resultant physical 
knitted surface topography, applying tacit knowledge and experience to reveal the 
hidden material activity.                                                                           

Crafted geometric units exploit the intrinsic properties of  materials and links-
links stitch structures, activating surface; the interaction is “an enfolding and 
unfolding relationship, between materiality, material and the processes of  their 
construction” (Dormor, 2020, p. 18). The colour-blocking for the links-links ground 
was designed as half  the panel length before applying a mirror block repeat 
to establish sectioning for the full length (refer to Chapter Three). The colour-
blocked sections were filled with eight links-links grounds using the devised paint-
by-numbers method (Figure 116) prototyped in previous practice. The complex 
pattern arrangement considered the directions of  material forces and the textures 
of  neighbouring patterns. Assembled ground structures traversed multiple panels 
to facilitating oppositional material forces, maximising surface fracturing. The 
Metamorphic Series colour-blocked image was saved as a separate file before 
the ground patterns were applied. Saving at the colour-blocked stage facilitates 
a proficient exchange of  the links-links grounds to test alternative aesthetics for 
the topography from a single image. Substitution of  the performative surface 
behaviours (Scott, 2015) activates the process of  becoming other (Smelik, 2016).
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Figure 116. Colour-blocking paint-by-numbers process, filling with links-links stitch structures. 



This programming reinforced my understanding of  material forces through 
combinatory displacements of  vertical and horizontal asymmetrical material forces 
over a longer length of  programmed data. Too many horizontal compressional 
forces positioned together significantly reduced the length of  the panels and 
increased their width. In contrast, too many concurrent vertical convergent forces 
reduced the width of  the panels while increasing their length. Using ground 
structures of  a similar scale resulted in similar visual effects of  low contrast between 
surface sections. In this Metamorphic Series, the topographies of  the landscape 
manifest following the flow of  materials (Ingold, 2013), enfolded in fragmented 
surface dynamics. Each programmed surface navigates a distinct assemblage of  
acquired knowledge, communicated through vibrant matter (Bennett, 2010) and 
generated surface movements.

5.2.3 Layer Two - The Collective Inlay Pattern

The collective knitted inlay placement over multiple surfaces used the old-format 
software and the same proportion division set-up as the collective ground. Initial 
designs considered knitted inlay as curved divisions; however, these generated 
numerous technical knitting issues due to the horizontal linearity of  the inlay 
knitting technique. Instead, block portioning was used, with the original positioning 
following the foliage layout over the landscape, traversing across multiple panels 
(Figure 117). The base pattern repeat function filled all colour-blocked areas with 
the selected inlay pattern. After the collective additive and subtractive stages, 
the knitted inlay pattern fill occurred to maintain a constant pattern across the 
panels. The diamond twill inlay used the traditional woven scale initially tested, to 
maintain the recognisable woven aesthetic embedded into the knitted ground.

Due to the extreme surface elongation, the intarsia inlay positioning occurred 
across half  the length of  the panels before a vertical block repeat was applied to the 
designed layout to generate the second half  of  the design. This design approach 
proved a time-efficient method for covering each panel length with pattern 
variations without entailing the drawing of  every knitted inlay section. Although 
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Figure 117. Foliage in the photograph of  the landscape converted to blocks of  inlay. 



a block repeat creates a double-up of  the inlay positioning in the panel length, 
layered interactions vary due to the knitted grounds beneath and the subtraction 
process. The edge conditions link directly to the patterning of  the neighbouring 
edge, and the cumulative knitted surface of  the entire series becomes more than the 
sum of  the individual panels (Kolarevic & Klinger, 2013).

Additive and subtractive methods were applied at the collective stage in the old-
format programming allowing inlay edge pattern and surface conditions to align 
across the multiple panels (Figure 118). Inlay can be drawn in any colour however 
I replaced the initial purple colour with vivid yellow to increase on-screen visibility 
and minimise random points of  inlay pattern that sometimes remained after the 
subtraction process. The generalised inlay placement rules included situating 
the first pattern on an odd-numbered course, and an even-number of  courses 
between all inlay patterned areas. Due to the design complexity, these rules were 
often manipulated to suit the individual inlay subtractions and arising relationships 
between neighbouring patterns (Figure 119). The trails of  knitted inlay used 
minimal courses of  the diamond twill pattern to trace entry and exit pathways 110

Figure 118. Collective placement of  areas of  inlay patterning across the multiple panels.

Figure 119. Inlay vertical, horizontal and block subtraction areas.



across the ground within individual panels. The final carrier directions were only 
visible on-screen after automatic processing. However, it was possible to reduce 
issues and refine the positioning during the individual assemblage stage by using 
even courses of  patterning.

The pattern was dispersed and gathered (Stenner, 2012), creating a transformative 
environment for multiple surface encounters. The design process consisted of  
several cyclic phases, with adjustments emerging during the layering construct of  
singular panels. The design components were examined individually and together, 
ensuring crafted material activity transpired between overlapping points of  knitted 
inlay and ground. The Metamorphic Series panels embrace the notion of  the 
individual and the multiple being interconnected. Academic Paul Stenner (2012) 
notes that “by playing with the difference between gathering and dispersal, pattern 
can add a little order to chaos and a little chaos to order” (p. 137).  The patterning 
was positioned, folding the structured programmed surface into the unstructured 
physical surface. These revised patterns followed a cyclical process, copied back 
into the collective design, permitting the modification of  boundary linkages (Figure 
120). The assemblage process was fluid, utilising programmed materiality (Scott, 
2015) to harness singular and multiple components’ characteristics (Philpott, 2011).

5.2.4 Individual Surface Points 

This knitted surface topography generation method considered the collective and 
the individual, analysing individual componentry layering, collective inlay and links-
links interactions aligned within multiple knit panels. The relationship between the 
singular stitch loop and the corresponding inlay point was examined on-screen in 
a grid. The composite viewing function aided the clearance of  structures layered 
beneath the edges of  the inlay pattern. The stitch structures positioned on the 
edges of  the knitted inlay pattern were changed to front bed knitting. The coded 
amendment on the edges countered knitting issues that occurred as the inlay carrier 
changed direction course after course. The Metamorphic Series practice unfolded 
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Initial inlay linkage.                                                      Adjusted inlay linkage.
Figure 120. Modification of  Metamorphic Series inlay patterning across the linked panel boundaries.



over time, informing a cyclic practice that shifted backwards and forwards between 
the collective and the individual. As “‘becoming’ is a practice of  change” (Smelik, 
2016, p. 167), this surface practice morphed in response to knowledge acquired at 
all development stages and was constantly in flux. Over time, these surfaces have 
unfolded (Ingold, 2013), recording the agency of  matter (Bolt, 2007) and a personal 
accumulation of  research knowledge.

Using the composite layering function allowed subtle alterations to the patterning, 
informing the behaviour of  the layered individual points (Figure 121). This 
stimulus of  the knitted ground or inlay pattern performance shifted the exertion 
of  neighbouring forces (Arantes, 2020b) on the X and Y axes, altering surface 
stresses and tensions. During the Metamorphic Series design process, the material 
force of  the knitted ground interacting with the knitted inlay pattern was visible 
as a traceable line. This trace disrupted the horizontal line, resulting in recumbent 
folding waves (Figure 122) in which the inlay followed the agency of  materials 
revealed along the convergent crest. The removal of  neighbouring inlay points 
exposed the material forces of  the horizontal and vertical ground that fostered 
dynamic, unbalanced knitted surface folding. The subtraction of  vertical inlay 
sections and the selected scale of  the links-links ground allowed the S-shaped 112

Figure 121. Composite view allows adjustment of  the stitch structure under the inlay pattern edges.

Figure 122. Inlay pattern following the 
recumbent folding waves of  the links-links 
ground.

Figure 123. Knitted surface topography 
with S-shaped folded ridges fracturing the 
inlay pattern.



vertical ridges to fracture the linear inlay patterning layout (Figure 123). The 
horizontal compressional forces generated an environment conducive to tight, 
overturned folds informed by heterogeneous surface behaviours. Singular loops and 
inlay picks formed alliances that altered the neighbouring encounters with material 
forces. The single edified the single, generating multiaxial matter activity within the 
entirety of  the surface. These surfaces propose a shift in the way we think about 
knitted textiles, from static to dynamic, inanimate to animate. The knitted surfaces 
evidenced in the Metamorphic Series panels utilise the fundamental ability of  
knit to perform, flex and unflex, fold and unfold (Thomsen, 2014) in response to 
material forces seen and unseen.

5.2.5 Assemblage of Single Surface 

As Lee (2020) recognises that surfaces “materialise the technologies that have 
created them” (p. 51), the Metamorphic Series surfaces portray the knowledge 
and the constraints of  the technology as physical interfaces. The knitted surface 
topographies showcase a technologically designed layering system of  applied 
material forces to instigate design conversations that encourage “a new way of  
seeing” (Celant, 2009, p. 214). The inlay embedded in the knitted ground is most 
successful when the design detail contains numerous single inlay picks and short-
length floats. The intricate arrangement of  patterns has the ability to “destabilize 
an internal ordering of  surface structure” (Jefferies, 2012, p. 131). My practice 
requires sizeable sections of  uninterrupted surface patterning for the mind to 
inform the eye and retain glimpses of  the removed design. As Professor of  Visual 
Arts Janis Jefferies (2012) denotes:
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Try to grasp the pattern. It defies you. Try to hold it, finger its details 
and you are denied. Try to let it ‘unfold’ itself  towards you, perhaps as 
a musical sequence, then as your eyes flirt and flit around the motifs, 
listen attentively to its quiet rhythms. (p. 128)

Minimal traces of  inlay patterning across the knitted surface follow the flow 
of  the materials, breaking the linearity of  the virtual grid. These trails of  inlay 
demonstrate the ability to share the material forces of  the stitch structures 
underneath, revealed as a visible surface trace. In the synthesis of  my practice, 
every construct navigates new understanding, with each surface unfolding as a site 
of  knowledge (Mäkelä, 2007; Nimkulrat, 2013), exhibiting fluctuating material 
behaviours’ that record matter’s agency (Barad, 2003).

The static, weave-like nature of  the knitted inlay alters the dynamics of  the folding 
links-links ground. In the Metamorphic Series panels, unfragmented sections of  
inlay affect the knitted surface material forces, informing stable planes within the 



transformative ground. This dominance relates to the horizontal and vertical 
subtractions of  the inlay pattern and the placement relationship to the scaled 
ground structures. Vertical disruptions are maximised with horizontal convergent 
material forces (Figure 124), and horizontal breaks create more fracturing when 
coupled with vertical convergence (Figure 125). Dormor (2020) states:
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The temporary bend in the cloth relies on its opening out, its 
movement, to reveal itself  and that which has been caught up in the 
fold. In many ways, it is unfolding that announces the presence of  
folding. (p. 11) 

The first prototype for the Metamorphic Series illustrated intermittent collisional 
boundaries, arising from an insufficient amount of  inlay patterning (Figure 126). 
The small amount of  inlay pattern significantly reduced the embedded weave in 
the knitted surface effect and generated a knit-dominant surface. The series used 
the diamond twill inlay as a weave signifier, positioned to conceal and reveal the 
pattern in response to the identified programming constraints. The overall visual 
aesthetic of  the solid sections of  the twill inlay is that of  a traditional woven fabric 
inserted into the knitted surface. The surface presents as an illusion, disrupting the 
viewer’s visual interpretation, and questioning the conundrum: How can a weave 
be contained internally in a knitted surface? The hybridity of  my fractured inlay 
knitted surface forces the viewer to attempt a pattern interpretation, visualising to 
some extent the unseen yet perceived pattern (Pepperell, 2019). Areas of  unbroken 
inlay patterning produced the most significant effect of  weave embedded in a 
knitted surface, allows viewers to focus on the woven aspect as a textile in its own 
right. The Metamorphic Series programming applied an unbalanced twill pattern; 
therefore, the knitted surface technical front and technical back afford alternative 
amounts of  inlay exposure (Figure 127).

These built inlay terrains are dynamic and dependent on programmed surface 
encounters (Grosz, 2001). The physical deformations of  the knitted ground 
subverted my programmed intent. In physical form the virtual angling of  the 
ground contours reduced due to the unstructured interplay of  material forces 
creating a horizontal linear partitioning effect. The angled block contouring was 
exaggerated on screen for the second prototype, to accentuate the delineation 
between active boundaries. The scale of  the links-links ground also modified the 
intensity of  the surface folds and torsions. The larger-scaled patterns contained 
more stable front and back bed areas, neutralising the deformative material forces. 
Digression from simple inlay designs into complex interactions of  the ground and 
inlay in the larger panels caused a programming glitch. The automatic software 
generated incorrect carrier directional movements. Instead of  a standard left to 
right followed by a right to left carrier movement, the software intermittently 
added two courses in the same direction directly after each other. Adjusting the 
programming shifted the issue rather than eliminating it. Technical support at the 
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Figure 124. Vertical convergent 

material forces.      .
Figure 125. Horizontal convergent 
material forces.

Figure 126. Metamorphic Series, 
first prototype, with intermittent 
patterning.

Technical front.	                                                Technical back.                    
Figure 127. Perspectives of the knitted surface inlay exposure.



Shima Seiki Mfg. Ltd. training facility suggested not breaking the inlay placement 
rules of  even courses and always aligning the inlay blocks starts and ends. However, 
my assemblages did not always fit this rule, so the extra directional courses became 
part of  the traces across the knitted surfaces.

As the development of  the Metamorphic Series progressed, multiple links-links 
ground sectioning fostered knitted surface displacement and fissures of  internal 
stresses, in which the “surface is volumised, creating multiple temporalities and 
spatialities” (Halliwell, 2020, p. 69). When the Metamorphic series panel one 
emerges from the knitting machine, the surface dynamics become visible once the 
horizontal tension of  the needle bed is released (Figure 128). The knitting machine 
deciphers the codes, knitted stitch by stitch, inlay pick by pick, building behavioural 
relationships through the assemblage of  these hybrid layers. The fluctuating 
landscape shifts, the matter has agency (Bolt, 2007) as the material forces influence 
the fragmented surface. The materials and inlay knitting technique engage in 
becoming with the capacity to transform (DeLanda, 2004; Kidd & Smitheram, 
2014). The released knitting deforms as the surface materialises, offering “an 
invitation to leap inside the hollow of  the fold, to see what happens. And to think 
inside the continuity of  the fold is to think in a continuous present” (Barnett, 1999, 
p. 32). Each elongated panel is a novel persona representing an embodiment of  
knowledge through addition-subtraction of  the inlay pattern and neighbouring 
knitted stitch properties (Arantes, 2020a). Shifting and morphing, the knitted 
surface inhabits alternative disruptions of  a linear plane. The knitted surfaces 
become transmitters of  knowledge, and contain personal connections as well as the 
making process employed.
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Figure 128. Metamorphic Series, panel one prototype emerging from the knitting machine.



5.2.6 Assemblage of Multiple Surfaces

The multiple surfaces encapsulate the heterogeneous material forces within and 
between each panel, communicating knowledge as physical variances of  “material 
consciousness” (Sennet, 2008, p. 123). Drawing across the panels, the inlay pattern 
is applied as a form of  mark making upon the knitted ground, where it traces my 
working process (Halliwell, 2020). Authors Cara McCarty and Matilda McQuaid 
(1998) note that “when cloth surfaces are sculptured, highly articulated, individual 
landscapes are formed by manipulating, and revealing the inner beauty of  the 
yarns” (p. 25). The Metamorphic Series used merino for the ground yarn, in 
varying shades of  grey, in a recollection of  sketching with graphite. High contrast 
inlay colours were applied during prototyping to increase the visibility of  the inlay 
patterning amid the fragmented ground. This colouration enables the eye to trace 
the single points of  inlay pattern across a multitude of  interactions

The links-links ground and inlay pattern navigate the multiple as interconnected 
topographical terrains across panels (Figure 129). Each designed surface identifies 
as an individual, with space between the panel edges permitting the formation of  
a distinct collective landscape. The singular panels in the series are adaptations 
of  each other. Each surface embodies knowledge variations, with inherited 
characteristics exhibiting a different persona in the surface series. Susanne Küchler 
(2020), Professor of  Anthropology and Material Culture at University College 
London, describes “attending to surfaces when surfaces are thresholds between 
the visible and the invisible” (p. 188). My surfaces navigate visible and invisible 
influences, shifting seamlessly between the virtual and actual, with each surface a 
knowledge contributor that informs the collective. 
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Figure 129. Metamorphic Series panels one and two display ground and inlay pattern navigating the multiple. 



The compositional relationship between the inlay and ground across multiples 
can only be accurately comprehended in the physical knitted surface. When 
programming the Metamorphic Series panels on-screen positionings were 
deliberately unbalanced, yet tangible ground material forces unpredictably equalise 
the sectional spacing in prototype panels (Figure 130). The multiaxial visible and 
invisible material forces alter the dichotomies of  surface encounters. The knitted 
surface is a pliable plane, the ground repositions and shifts. To counter this on-
screen adjustments observed the compressional direction of  material forces, 
encouraging a more organic inlay placement. An alternate landscape materialises 
as the agency of  matter (Bolt, 2007) settles, revealing and concealing the knitted 
surface topologies in response to the environment. For the final exhibition of  the 
Metamorphic Series, knowledge gained through the prototype panels informed 
the arbitrary inlay positioning that unfolds along the ground axis built from my 
landscape photographs.

The virtual flat programmed grid is incapable of  simulating the disruptive material 
properties. Physical knitted surfaces contain a level of  unpredictability that emerges 
from the structured design process. The knitted surface embraces unaligned 
stresses and material forces, which converge at the panel edges, generating biaxial 
compressional conditions. The interrelated edge conditions react differently 
due to individual points of  programmed materiality (Scott, 2015). Networks 
of  multiple intersections allow activation of  connected dynamic boundaries. 
Combinatory convergent and divergent material forces activate folded sites through 
the placement of  stitch structures. Complex asymmetrical folds emerge from the 
symmetrically repeated codes.  
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Figure 130. Exploring spacing of  the inlay pattern in Metamorphic Series panels one and two.



Sections of  inlay that connect across the panel edges illustrate similar material 
forces under variant conditions, as each panel displays different links-links ground 
layouts. The visual effect is continuous, but the interplay of  material forces is 
unique. Positional amendments of  the knitted inlay up or down the panel alter the 
active boundaries and the ensuing surface deformations. All the collective knitted 
surface design panels were affected when the inlay patterns shifted on the X or 
Y grid axis in response to compositional balance. This generative design process 
involved singular and collective revisions. Virtual to physical, and back to virtual, 
modifications occurred as I refined placement of  the integrated material forces 
within the Metamorphic Series elongated knitted surface topographies

The built knitted surface topographies include visual relief  of  surface in two ways. 
One method used links-links ground deformation without inlay interruption, and 
the other larger stabilised inlay areas. Both provide a visual reprieve from the 
other, allowing the viewer to focus on the signifying aspects of  the knitted hybrid 
surface. Depending on the pattern and amount of  inlay positioned in the surface, 
the knitted ground layer forces predominantly disrupt the landscape. However, the 
static nature of  the twill inlay can be programmed to change these forces, reducing 
the complex folds as solid inlay sections increase surface stability. Unfractured 
sections of  knitted inlay counterbalance the underlying knitted ground material 
forces. The level planes of  inlay amid the ground deformations facilitate the 
mapping of  weave-dominant areas of  unfractured pattern.

5.3 The Technical Design Fulcrum 

The length of  the panels in the Metamorphic Series increased from previous 
samples, significantly expanding the size of  the knitted surface. The scale of  the 
knitted links-links grounds and inlay patterns applied to the surface-building blocks 
built in previous practice and discussed in earlier chapters. Each component was 
permanently placed on a single layer when designing with old-format methods, 
making design modifications difficult. Therefore, the singular assemblage of  
each panel in the Metamorphic Series transpired in the automatic software 
environment, allowing separate layering of  each designed component. The links-
links and inlay designs were copied from the collective set-up and positioned on the 
relevant automatic software pages. The length of  the panel on-screen remained an 
impediment to seeing the entirety of  the surface within the digital grid. Continuous 
use of  the zoom function affected my ability to read the patterns as unbroken 
surfaces, impeding the visualisation of  the physical outputs. This impediment 
continued until physical prototypes emerged, and points of  reference developed 
through experience that fostered internal rendering of  the knitted surface 
topographies of  the Metamorphic Series. This developing ability to translate 
knit codes on-screen with the proportional physical knitted surface aided design 
decisions. 119



The composite pages function in the automatic software allowed simultaneous 
viewing of  the structure and inlay colour layers. In response to the underlying stitch 
loops, the assembled subtraction of  individual inlay points encouraged multiaxial 
zones of  interactivity (Halliwell, 2020). On the structure page, programmed 
knit codes changed to clear the horizontal perimeters of  the intarsia inlay. This 
amendment ensured that only front bed loops were situated on the edges, reducing 
knitting complications at these unstable turning points. At this stage, I checked the 
structure page for random colour codes (Figure 131) that sometimes remained from 
the colour-blocking development step. If  incorrect codes were present, the colour 
change function reallocated front or back single jersey knit structures to rectify the 
incorrect automatic programming.

Designs generated in old-format software can contain any amount of  inlay 
desired, similar to drawing on a page; however, numerous errors transpire during 
the technical processing stage due to the amount of  programmed data (Figure 
132). This practice experienced errors that had not previously been encountered 
by Shima Seiki technical experts, highlighting the technical design cusp of  this 
surface practice. One error involved the automatic software function, knitting assist, 
which highlighted knit error for technicians and was unable to operate due to the 
file size. The intended use of  the Shima Seiki knitting technology is by industry, 
for garments and blanket-sized pieces; therefore, the complexity and size of  the 
Metamorphic Series surface designs destabilised the design system, producing a 
series of  system errors. Being creative is not so much the desire to do something 
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Figure 131. Rectifying incorrect colour codes on stitch structure page during programming.

Figure 132. Software errors due to the programming complexity of  the Metamorphic Series panels. 



with the materials but sometimes listening to what wants to be dictated by the 
materials (Albers, 1944). In working with the inlay knitting machine, my technical 
capabilities led the design until personal knowledge developed enough to program 
on the edge of  possibility. For example, the on-screen page has a limited number of  
courses available to hold the coding. Therefore the length of  the final knitted panel 
is determined by the vertical expansion of  the digital knitting codes.

Finding the balance between designed output and technical constraints was critical 
to processing the knitting data, allowing the program to be transferred to the 
knitting machine. Initial prototype designs contained considerable inlay, prompting 
numerous software errors at the processing stages. These errors necessitated 
reduced inlay patterning in the knitted surface topography overall length. Digital 
technology has changed the maker’s role, enabling continuous reprogramming 
during making to test designs (Zoran, 2013). A trial-and-error approach to my 
practice led to an in-depth understanding of  the amount of  knitted inlay possible 
within the individual surfaces when extended to these extreme lengths. During 
these subtractive inlay patterning trials, I discovered that the vertical inlay needed 
to reduce due to the vertical on-screen expansion that occurs when developing the 
codes for knitting.

In addition, a sequential knitting process was employed, which divided the long 
panel into parts, allowing these to be loaded and knitted continuously. This 
sequential knitting process reduced the file size while maintaining the integrity 
of  the overall design aesthetic. Sequential knitting used single dots of  code 200 
in the L1 option line, allowing the KnitPaint software to divide the long panel 
into a sequence of  smaller interconnected parts. The knitting machine read the 
parts as separate .000 files but knitted a single consecutively linked surface. These 
surface designs involved programming with rather than against the discovered 
technological constraints. Each long panel contained twelve sequentially knitted 
sections and required nine hours of  knitting. The knitting machine ran slower to 
prevent knitted loops from dropping off the needles during the links-links and inlay 
transfers. The knitted surface deformation practice was teased out of  the materials 
and techniques, facilitating a process of  technological discovery.

5.4 Exhibiting the Metamorphic Series

The exhibited knitted surface topographies are textiles which let the yarns articulate 
knitted surfaces with no purpose other than their own orchestration, combining 
technique, technology and knowledge. The final exhibition of  the Metamorphic 
Series showcased the five collective panels suspended from the ceiling and draped 
along the ground (Figure 133). The designed patterning built from landscape 
imagery can be read singularly and across multiple panels. The panels allowed a 
symphony of  colliding texture and pattern, which articulated the potentiality of  121



the inlay technology, knitting techniques and knowledge acquired (Figure 134). 
Burbank and Anderson (2012) note, “in order to build topography, work must be 
done against gravity” (p. 26). The weight of  the Metamorphic Series has altered the 
surface textuality. To counter the gravitational pull, I would in the future, increase 
the number of  directional material force exchanges in suspended sections. 

The addition of  an open-ended tubular finish to each panel allowed the insertion 
of  an aluminium rod to display the surfaces in a state of  partial suspension. 
The suspension permits surface perspectives of  both the technical front and the 
technical back (Figure 135). Viewers experienced the double-faced knitted surfaces 
through visual and haptic interactions, allowing observation of  the inverse effect 
of  inlay. This inverse patterning evoked a transposed colour balance while also 
illustrating the traced pathway on the technical back through the knitted surface 
plane of  activity. The selection of  a neutral ground and chromatic inlay colour 
increased the effect of  inlay embedded in the knitted surface rather than visually 
floating on top. Several viewers referenced nature when engaging with the knitted 
surface topographies, seeing landscapes and textural convergence of  water 
tributaries.

The more significant areas of  links-links ground in the Metamorphic Series 
topographies facilitated recognition of  link-links in this research, expanding my 
knitted surface viewpoint beyond the initial inlay focus. As in Bruno’s notion of  
the surface “as a form of  contact that enables intimacy” (2014, p. 231), the viewer 
is encouraged to wander amidst the suspended knitted surface topographies, 
personally connecting with the active ‘surfaceness’ (Halliwell, 2020). The 
programmed horizontal and vertical material forces perform differently suspended 
(Figure 136) versus the relaxed folded state inhabiting the floor (Figure 137) 
demonstrating multiaxial surface fragmentations. The suspended knitted surface 
topographies are elongated with horizontal folds outstretched while vertical 
ones remain. Viewers interacted with the vertical and horizontal knitted surface 
topographies differently. The two-dimensional coded digital becomes a dynamic 
physical knitted surface that invites textural encounters. Fingertips explored 
the ground textures, whereas the suspended accordion folds were expanded 
and released, activating material behaviours. Academic Barbara Rauch (2020) 
describes:
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Surface qualities that ‘erupt’ as the digital manifests itself  as a material 
surface. The tactility of  the new surfaces offers a critical insight into 
how we understand a material object and the technology that made it 
come to life. (p. 59)

When hands interact with a surface, information relays about the physical attributes 
of  that surface (Johansson & Flanagan, 2009). By physically connecting with the 
knitted surface topographies, the viewer reads the programmed effects, fingers 
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Figure 133. Reading across the Metamorphic Series.
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Figure 134. Multiaxial patterning collisions 
across Metamorphic Series panels.           

Figure 135. Technical back view of  Metamorphic 
Series panels.

Figure 136. Suspended vertical folds.
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Figure 137. On the gallery floor multiaxial surface fragmentations.



traverse folds, engaging with the material forces. Touch relies on intuition to guide it 
rather than being a conscious action (Philpott, 2011). The caress is an unintentional 
forage, seeking the concealed while feeling the revealed knitted material forces. 
The Metamorphic Series of  knitted surface topographies are the manifestation of  
tactile matter, offering critical insight into my understanding of  the inlay knitting 
technology and material performances (Rauch, 2020).

5.5 Conclusion

The programming of  the Metamorphic Series panels occurred from three 
interrelated design perspectives: firstly, the design of  the five knitted panels as a 
single entity through interconnected links-links stitch structures and inlay patterned 
sections; secondly, the considered positioning of  relational material forces between 
each inlay pattern once overlaid into the ensuant links-links stitch structures; and 
thirdly the assemblage of  constructed material forces at the singular level within the 
grid; the interaction of  the inlay pick with the neighbouring knitted loop informing 
the knitted surface topography.

This research encompasses an alternative approach to building knitted surfaces. 
The theoretical context of  practice evolved in tandem with the analysis of  
making to understand the processes and assessment behind the emergent surface 
relationships. This chapter, Emergent Terrains, highlights boundaries between design 
and technology, fostering a design space in which the designer negotiates with the 
constraints of  the technology (Rauch, 2020). This practice naturally journeyed to 
this cusp as tacit creativity became positioned at this intersection of  knit technology 
and design. The exhibition of  the Metamorphic Series navigated this practice 
space, illustrating knit knowledge and the developed mode of  making in a synthesis 
of  practice.

The technological constraints encountered disrupted the design practice, informing 
the making process. “Making is not just a combination of  skills and hard work, it is 
an enquiry into the potential of  a chosen media” (Harris, 2005, p. 25). A synergetic 
environment emerged that transcended programming frustrations to a point where 
the design and technical spoke to each other influencing design decisions. The 
discovered technical framework necessitated adjustments of  the surface designs 
that embraced the unfolding technical constraints. As Albers (1944) states, “no 
limitations other than the fiat of  the material itself  are set. More than an active 
process, it is a listening for the dictation of  the material and a taking in of  the 
laws of  harmony” (p. 54). This statement aptly describes the connection formed 
throughout this material practice. The research builds on a deeper understanding 
of  the technological constraints and design possibilities explored through 
connections to geomorphic language and a devised mode of  making.
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6.1 Introduction 

In nature, tectonic forces draw upon the earth’s terrain. Every landscape holds a 
story of  landform creation; with traces of  the people and place carved into the 
contours, shifting surfaces capture time in layered deposits. Similarly, I sketch upon 
the dynamic knitted surface, patterning with knowledge and tacitly embedding 
self  and the inspirational landscape into the design. This research investigated 
how the hybrid knit-weave technique of  inlay could be used as an ontological 
investigative medium to build knitted surface topographies through the assemblage 
of  heterogeneous material forces. The surface becomes an interrelation of  
relationships, where the assemblage process fractures patterns through ground 
disruptions. The emergent mode of  making combining links-links material forces 
with inlay embraces systematic surface behaviours and layered material forces 
in collaboration with technological constraints. Although built as an assemblage 
of  elements, each knitted surface topography retains an ambiguity in the design 
equation. This unstructured design component arises from the intersections of  
material forces informing this temporal mapping process (Küchler, 2020).

 6.2 Making with Materiality

The synergetic approach to design using the surface-building blocks integrates 
surface, technique, technology and materials forces. This practice contributes to the 
digital knitting research environment by increasing awareness of  the potentialities 
of  links-links and inlay knitting techniques. Research in this thesis re-imagines 
craft-based textile techniques through blended interdisciplinary making with 
fields outside textile design such as fashion, product, spatial or interior design. 
The research primarily focused on approaches that follow the material properties 
(Arantes, 2020a), building knitted surface topographies that reference terrain 
characteristics of  the Coromandel Peninsula landscape. The surface topography 
of  knitting allows for the continuous deformation of  zones, with arranged stitches 

Chapter 6: Unfolded Findings

[W]hat is really at stake, is a new kind of  surface ontology which 
replaces the opposition of  inside and outside, invisible and visible, 
immaterial and material, with a complementary relation that thrives 
on transformation rather than distinction. (Küchler, 2008, p. 116)
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generating structural material forces that fracture the surface plane. The hybridity 
of  the inlay technique allows singular surface points where the inlaid yarn is 
captured and controlled by the knitted loop, influencing neighbouring points and 
altering surface dynamics. By utilising programmed materiality (Scott, 2015), 
the inlay knitting mimics the ground movements with the pattern distorted by 
underlying material forces. 

The layering of  surface-building blocks utilises material forces to activate knitted 
surface interactions between singular points of  the collective. The inlay surfaces 
foster the performances of  matter, releasing emergent material properties and 
capacities (DeLanda, 2015). The materials have agency, moving and reacting to 
their own dynamic rhythm as they transform the surface (Lange-Berndt, 2015). 
Manipulation of  this material agency allows crafting with material affordances 
(McCullough, 1996) through the assemblage of  heterogeneous material forces. 
Utilising bodily knowledge (Merleau-Ponty, 1965), surface sections are constructed 
as stabilised or destabilised planes through vertical and horizontal subtraction 
of  inlay patterning. The inlay yarn traverses the knitted surface, programmed to 
minimise or accentuate traces between interconnecting intarsia inlay patterns. The 
patterning breaks the linear grid as the eye seeks to reconstruct disrupted repeating 
inlay sections. 

This investigation developed surfaces that apply single and double bed inlay 
methods to demonstrate a range of  applications of  the inlay knitting technique. 
This scope of  the capabilities of  inlay knitting technology opens up creative 
opportunities and encourages design shifts away from all-over single jersey 
patterning. Intarsia inlay and the exposure of  inlay in the double bed surfaces 
change the inherent knit properties in specific sections. Knit or weave behavioural 
characteristics dominate the surface. Sectional positioning of  the inlay knitting 
permits variable surface properties that depend on the combinatory design choices 
of  ground stitch structures, inlay patterns and materials. In this practice, material 
performances were layered to stabilise or destabilise the knitted surface conditions 
during the act of  becoming other.

My knitted surface topographies use three yarns selected for their material 
performances and inter-reactive states. New materials continuously emerge; 
future yarns offer opportunities to alter surface material characteristics. The 
selected materials “not only enable and constrain action, they also unfold through 
collaborations with people, workspaces, and even each other” (Rosner, 2012, p. 
1155). Pemotex yarn permits engineered convergent material contractions that 
result in solidified surface sections. The surfaces showcase the links-links, inlay 
knitting techniques, and interconnected material affordances (McCullough, 1998), 
instigating new ways of  building temporal knitted surfaces. Our bodies are a means 
to navigate the unarticulated aspects of  the world. This tacit knowing relies on 
engagement and interaction with the making and the made.
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6.3 The Edge of Technicality

During the design of  the multiple-panel series, approaches evolved that aided 
comprehension of  the virtual, allowing conversion of  scale from photograph to 
screen to surface. The practice investigated repeating motifs, and variations of  
panel size and pattern scale, to examine effects on the knitted surface. Prototyping 
the series of  extra-long panels resulted in new approaches to digital programming 
using divisional grids to aid the interpretation of  proportion. The scale of  the 
repeating patterns increased my understanding of  the intersecting material 
alliances. Due to less effective collisional material forces, a links-links ground with a 
too-large pattern resulted in a flat plane. Exploring extremely long panels instigated 
a design space at the edge of  the capabilities of  the Shima Seiki Mfg. Ltd. inlay 
knitting technologies. This previously unexplored intersection is where technology 
and design impose constraints upon each other, forming a co-alliance with the 
designer and materials.

Designers often view the constraints of  digital knitting technology as a barrier to 
design rather than as a tool. Personal knowledge, perspective and positioning have 
significantly influenced my trajectory in this project as a knit designer with extensive 
technical programming knowledge. This allowed the practice to extend beyond 
all-over inlay surfaces by including old-format programming. This programming 
knowledge fostered an environment in which inlay techniques outside of  automatic 
software constraints were developed. Double bed inlay knits are only achievable by 
coding complex package programming in old-format software. Personal in-depth 
technical knit understanding also provided an alternative approach to designing 
multiple panels, combining attributes from the automatic and old-format software. 

 

6.4 Personal Reflections

This research was a technique-led journey, a meandering of  tributaries of  
technical-design knowledge and self, rather than a practice purely focused on 
producing artistic artefacts. Technique-led experimentations contributed to surface 
outcomes, utilising aspects of  the practice and context. The interconnecting 
theoretical strands have influenced the practice. At times I struggled to balance 
my inclination to remain entrenched in the technical environment with an innate 
desire to design creatively. However, this crossroad in practice is my recognised 
environment, with my structured nature significantly influencing the designed 
knitted surface outputs. As Ingold (2013) notes, making becomes a “correspondence 
between maker and material” (p. xi). Interactive and intuitive collaborations formed 
between materials, technology and designer. This research practice involved a series 
of  exploratory exercises that at times travelled into unknown territory before my 
need to avoid confusion reigned the practice back to a structured environment. 
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Hopefully, others reading my thesis will be able to respond to these glimpses and 
pick up these pathways into the unknown, extending the research potentiality. 

Tacit knowledge acquired from digital and physical environments manifested 
as knitted surfaces. McCullough (1998) states, “human beings, like things, have 
become interfaces in a technological world” (pp. 233–234). Tacit intuition 
embraced layers of  bodily knowledge acquired through reflective practice and 
engagement with the technique and knitted surfaces. The knitted surfaces unfolded 
over time, exhibiting visible traces of  the technique’s material forces, technological 
constraints and gestures of  bodily knowledge. This research practice operates 
within discovered technological constraints to allow the design to unfold while 
following the material and stitch structure behaviours. Although the research was 
technique-led design, this flipped at times to practice led because of  technical 
aspects encountered at the edge of  the technology’s abilities. The digital-physical 
making process has become so embedded in my practice that it is a way of  thinking 
design in which “the distinction between the digital and the non-digital is no longer 
useful” (Rauch, 2020, p. 51). 

6.5 Significance of the Study 

The findings of  this practice are significant to textile design research and practice 
community and beneficial to designers outside of  the textile field. The methodology 
outlined in this thesis offers an alternative approach to knitting technologies for 
various disciplines such as fashion, interior and product design. The mode of  
making developed from a structured investigation of  repeating pattern, scale, 
materials, links-links and inlay knitting techniques exploring surface behaviours. 
The methodology and methods framework could be replicated or adapted for other 
knitting techniques such as rib or tuck stitch, affording future creative practice. The 
generated surface-building blocks provide a visual and haptic resource enabling the 
maker to become a participant working with the material performances (Ingold, 
2013). The layering of  design elements specifically activates intersecting material 
forces on singular and multiple levels, building alliances between the knitting 
techniques and material behaviours (Oxman, 2012). The materials are no longer 
mute as they navigate the convergent material forces. These surfaces exist as knitted 
surfaces significant for their assembled material behaviours. Instead of  artefacts 
for an exhibition, the surfaces become critical sites of  material practice, illustrating 
technique, technical exploration and designer knowledge.

This research draws on geomorphic language to analyse links-links and inlay 
knitted surface movements and inform the design practice. Geomorphic 
terminology was applied to understand material forces and design a knitted surface, 
offering an original contribution to the knit research environment. The geomorphic 
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language and emergent methodology explore the design potential of  the inlay 
knitting technology. Digital two-dimensional codes conceal the physical knitted 
surface’s three-dimensional materiality and behavioural properties. This research 
provides a resource for designers by understanding how two knitting techniques 
interact and adopting geomorphic language to support the mapping of  resultant 
material forces and textural surface qualities. 

This thesis adds to current research on inlay and links-links knitting techniques. 
As the inlay knitting technique is a relative newcomer to digital knitting, there is 
a gap in the digital knit research environment that this research occupies. Recent 
shifts to a more technological workspace caused by the global pandemic have 
highlighted research opportunities that support designers’ understanding of  two-
dimensional versus three-dimensional environments. Practice discussed in this 
thesis bridges the complexities of  the digital-physical knit environment, providing a 
vehicle for engagement with a knitted surface by multiple disciplines. This research 
presents the complex knitting technologies as step-by-step creative practice using 
surface-building blocks to inform decision making. The ability to assemble material 
forces and relational alliances in targeted placements is significant to future design 
opportunities. The targeted stabilising or destabilising of  areas allows the knitted 
surface to exhibit paradoxical attributes such as sections of  reinforcement combined 
with areas of  flexibility, which are two desired attributes for many product design 
objects.

6.6 Future Directions

While this is the conclusion of  the thesis, this is also a beginning point, a position 
from which to build other pathways of  practice that extend on the knowledge 
acquired and documented here. There is scope for developing a deeper design 
connection to the geomorphic language in relation to the knitted surface analysis 
and design with knitted surfaces created to mimic the geomorphological movements 
of  landforms. Questions begin to emerge in this thesis about connections between 
language and knitted surfaces which can be expanded upon in future research. 
How much can land surface structures and language parallel knitted surfaces? Can 
the relationship between geomorphic language be translated into a collaboration 
with scientists from Earth science disciplines to investigate knitting topographic 
data? The terminology in this thesis is a starting point to continue to build upon 
increasing designer articulation and understanding of  knitted surface movements.

This practice builds on existing knit research to provide an alternative design 
methodology while adding to discourse in digital-crafting digital-craft practice 
exploring the relationship between two-dimensional and three-dimensional design 
environments.  There remains significant potential to expand on design factors 
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touched on during prototyping that sat outside the scope of  this study. These under-
utilised developments relate to inlay knitting with multiple colours, variations of  
ground stitch structures and knitted dimensional forms. The inclusion of  additional 
carriers for multiple alternative yarns and colours, the insertion of  e-textiles and 
shaping options offer opportunities to expand this area of  research. Opportunities 
also exist to extend this research through alternative materials, variations of  the 
stitch structures, and inlay patterning applied. 

The textile hybridity of  the inlay knitting technique allows singular surface points 
where the inlaid yarn is captured and controlled by the knitted loop to influence 
neighbouring points, altering the surface dynamics. The intarsia inlay allows 
specific placements of  additional yarn. Therefore, the material properties can be 
manipulated, generating stabilised targeted areas. The mode of  making developed 
in this research can be applied to knitted garment form-building or other knitting 
techniques using the surface-building block approach to design. Designed links-
links with inlay knitted surfaces could also be employed to create interior products 
with the haptic used in therapeutic sensory products, reconnecting people to the 
physical world and promoting wellbeing. In addition, the craft-based aspect of  
this practice could appeal to bespoke makers who often create specific surface 
designs using personalised patterning to define their origin. The inlay techniques 
discussed in this thesis mimic traditional woven-look patterning through a digital 
design and production process. This manufacturing process fosters the bespoke 
individualisation of  craftsmanship but proposes a more time-efficient customised 
making process through digital-crafting.

Further to these outlined potentials, the findings contain a creative approach 
to knitted surface design replicable in an educational setting. Teaching practice 
could expand on the step-by-step technical knitting instructions provided in the 
Appendices, allowing multiple disciplines creative access to the knit technologies. 
This thesis offers a starting point for future interdisciplinary developments 
rather than an end. The knitted surface topographies materialise the agency of  
matter, making tangible the intangible, programmed material forces as surfaces 
become transmitters of  knowledge. Each sample from the Shima Seiki Mfg. Ltd. 
N.SRY123LP inlay knitting machine is a new persona, fostering the temporal 
nature of  knit and signifying endless opportunities for knitted surface design.
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Shima Seiki Mfg. Ltd. design system that expands 
programmed knit designs using a series of  
predetermined development instructions.

Mechanism that selects needles for knitting and 
transports yarn carriers across the needle bed

Generating colliding compressional surface movement 
towards each other

Horizontal row of  interconnected looped stitches

Shima Seiki Mfg. Ltd. term – a computerised image 
of  the knit design as registered coloured packages

Shima Seiki Mfg. Ltd. term – a computerised image 
of  the knit design as expanded knitting information 
applying the compressed patterns registered coded 
colours

Generating surface movement away from each other

A knitting technique that knits on two needle beds to 
create a knitted textile

Weaving term for a single warp thread

Length of  thread or yarn that lies across the front or 
back of  a knitted or woven surface

Knitting term used to calculate per inch the number 
of  knitting needles on a needle bed

Glossary

Automatic software

Carriage

Convergent forces

Course

Compressed pattern

Developed pattern

Divergent forces

Double bed knitting

End

Float

Gauge
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A knitted base built from stitch structures

Inlaid yarn lies horizontally across the needle bed, it is 
not knitted into the stitch.

A sectional knitting technique used to incorporate 
blocked areas of  contrasting colour or pattern

Front face of  single jersey knitting

Shima Seiki Mfg. Ltd. term - the technical design 
system for programming for the Shima Seiki Mfg. Ltd. 
knitting technology

Textile technique that creates a fabric or garment 
through the interlocking of  connected loops formed 
on needles using a continuous yarn

Single knitted stitch formed by a continuous yarn

Surface movements arising from interactive influences 
generated by fibre properties and behaviours. Also 
referred to as tectonic forces

Shima Seiki Mfg. Ltd. term - the technical 
programming page set-up for generating complex knit 
designs using coded packages to develop for knitting.

Shima Seiki Mfg. Ltd. term - used to store the 
technical knitting information for controlling each 
knitted course

Shima Seiki Mfg. Ltd. term – a programmed 
component comprised of  sequenced knitting 
instructions used to colour code compressed patterns

Weaving term for a single point of  a weft thread

Reverse face of  single jersey knitting

Shima Seiki Mfg. Ltd. knitting software for 
programming digitally knitted textiles and garments

Ground	

Inlay knitting

Intarsia

Knit Stitch

KnitPaint programme

Knitting

Loop

Material forces

Old-format

Option lines

Package

Pick

Purl stitch

SDS-One Apex3
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Knitting technique that knits on one needle bed to 
create a fabric

Knitting technique that creates a front faced knitted 
fabric

Programming registered colour that contains knitting 
information

Knitted stitches used to create surface texture or 
pattern

Activated fibres that contract with applied heat

Method of  moving a stitch from the original needle 
position to an adjacent needle

Generating surface movement up and down

Knitting technique that knits on the front and back 
bed forming a pocket between two surfaces

Vertical rows of  interconnected looped stitches

Single bed knitting

Single jersey

Stitch code

Stitch structures

Thermo-reactive yarn

Transfer stitch

Transformative forces

Tubular jacquard

Wales



APPENDIX A. 
GEOMORPHIC KNITTED SURFACE TERMINOLOGY 

TERM DEFINITION FORCES KNITTED SURFACE EXAMPLE 

CONVERGENT Forces pushing 
towards or 
moving 
together  

COMPRESSION Vertical Convergent           Horizontal Convergent 

DIVERGENT Forces pulling 
outward or 
moving apart 

TENSION 

TRANSFORM Forces sliding 
areas past 
each other up 
and down 
direction or 
twisting / 
torsions 

SHEARING 

CREST or PEAK The highest 
point of the 
fold, the 
upfolded arch 

COMPRESSION 

TROUGH or DIP The lowest 
point of the 
fold, the 
downfold arch 

COMPRESSION 

SUBDUCTION 
ZONE 

One area is 
pushed under 
the other 

COMPRESSION 
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FOLD Bending or 
crumpling of 
surface caused 
by 
compressional 
tectonic forces 

COMPRESSION 

RECUMBENT 
FOLD 

Bending or 
wrinkling or 
flexures that 
occurs on a 
horizontal axis 
plane 

COMPRESSION 

SYMMETRICAL 
(SIMPLE) FOLD  

Balanced fold 
that has even 
pressure from 
all directions 

COMPRESSION 

ASYMMETRICAL 
FOLD 

Unbalanced 
fold that has 
more pressure 
from one or 
more 
directions 

COMPRESSION 

TIGHT FOLDS Folds that are 
close together 

COMPRESSION 

BROAD FOLDS Folds that are 
a distance 
apart 

COMPRESSION 
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COMPLEX 
FOLDS 

Applied 
compressional 
forces that 
become more 
unequal from 
two or more 
directions 

COMPRESSION 

ACTIVE 
BOUNDARIES 

Intersections 
of forces 

ALL SURFACE 
FORCES 

FAULT A breakage 
zone 

ALL SURFACE 
FORCES 

Adapted from terminology in Physical geography, by J. F. Peterson, D. Slack, and R .E. Gabler, 2017, Cengage Learning. 
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• STEP 2. Set Up New Swatch in Automatic

Software

• Input Gauge & Select all needle

• Input Ground loop size (if known from swatch or

use default)

• Select hem type

• Input hem loop size (if known from swatch or use

default)

• Set hem size (cm or number of courses)

• Click > Next

• STEP 1. Set Up New Swatch in Automatic 

Software

• File > New

• Set up f le name

• Browse to f nd correct folder

• Set Machine: N.SRY123LPSV 14

• Size of panel: width and height

• Click > OK

• STEP 3. Set Up New Swatch in Automatic

Software

• Edit Base

• Options to change the hem type and the waste

type

• Click > Next

• STEP 4. Set Up New Swatch in Automatic

Software

• Line Setting

• Leave as default

• Click > Next

APPENDIX B.
How to Build an All-over Inlay Knitted Surface
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•	 STEP 6. Set Up New Swatch in Automatic 

Software 

•	 Colour page

•	 Leave as default (can adjust later if want more 

colours added)

•	 Default is set for one ground colour and one 

waste colour

•	 Click > Next

•	 STEP 5. Set Up New Swatch in Automatic 

Software 

•	 Allocation 

•	 Select Carrier type = Swing (KSW1) or Non 

Swing (KSW0) 

•	 Select Carriers to use

•	 14 = N (Inlay) 13=KSW0 (Ground) 12 = KSW0 

(Waste) 

•	 Click > OK

•	 STEP 7. Set Up New Swatch in Automatic 

Software 

•	 Carrier Allocation Result

•	 Click > OK

•	 STEP 8. Set Up New Swatch in Automatic 

Software 

•	 Structure page

•	 The default is a red code = front bed single jersey

•	 Hem is the codes for the hem set up in step 2
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•	 STEP 10. Create Inlay Pattern

•	 Develop the inlay base unit for repeating 

pattern to the right of red line (this is outside the 

developing area, use it to draw like a blank page)

•	 Zoom in to see grid & use a bright colour so it is 

easy to see the design

•	 STEP 9. Create Inlay Pattern

•	 Inlay Colour Page  

•	 Click > Inlay 

•	 Opens up Inlay Colour page this is used to set up 

the inlay pattern

•	 STEP 11. Create Inlay Pattern 

•	 Click > Base pattern repeat tool

•	 Click > Base pattern area

•	 Drag an area box around the unit repeat pattern 

•	 Click > Ok

•	 STEP 12. Create Inlay Pattern 

•	 Click > Repeat Area

•	 Drag an area box around the unit repeat pattern

•	 Inlay must start 1 course up from the bottom 

and finish 1 course from the top of the swatch

•	 Inlay must sit inside side edges by minimum of 

two needles

•	 Click >OK
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•	 STEP 14. Create Inlay Pattern 

•	 Click > Exec

•	 Fills with the repeat of the base unit in the set 

area 

•	 Click > Cancel

•	 STEP 13. Create Inlay Pattern 

•	 Select colour to repeat over with  pull down tab 

on Add icon

•	 Select black ground colour

•	 If there are other colours in the list remove them 

(click the Delete All icon)

•	 STEP 15. Automatic Software Development

•	 Click > Next

•	 STEP 16. Automatic Software Development

•	 Carrier Allocation Result 

•	 Click > OK
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•	 STEP 18. Automatic Software Development 

•	 S paint pattern making

•	 Do you want to perform package development 

continuously?

•	 Click > Yes

•	 STEP 17. Automatic Software Development

•	 Name Overwrite

•	 Click > Yes

•	 STEP 19. Automatic Software Development

•	 Move Cable Separation - Leave all settings as 

default

•	 Click > Exec

•	 STEP 20. Automatic Software Processing

•	 Click > Automatic Processing

•	 Bed Length = 120

•	 Machine = SV & Gauge = 14

•	 Carrier Option = Extension

•	 Knitting = All Needle

•	 Click > Execute Auto
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•	 STEP 22. Automatic Software Processing 

•	 Select Field

•	 Click > Inside the Field image

•	 Click > OK

•	 STEP 21. Automatic Software Processing

•	 Select Structure Pattern

•	 Click > Inside the Structure image

•	 Click > OK

•	 STEP 23. Automatic Software Processing

•	 Click > Auto Processing (RHS menu)

•	 Set Auto Process Parameters

•	 Fixed Data Tab > Check Set Up and Waste 

Carriers

•	 STEP 24. Automatic Software Processing

•	 Carrier tab 

•	 Carrier 8 Left and Right (never adjust)

•	 Carriers 14 & 13 & 12 in use from the left 
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•	 STEP 26. Automatic Software Processing

•	 Yarn Type tab 

•	 Carrier 14 = Thick 

•	 Carrier 13 & 12 = Normal

•	 Click > Execute

•	 STEP 25. Automatic Software Processing

•	 Carrier Type tab

•	 Carrier 14 = N = Normal = Inlay carrier

•	 Carrier 13 & 12 = KSW0 = Non swing = Ground 

& Waste

•	 STEP 27. Automatic Software Processing

•	 Data Output

•	 Click > OK

•	 STEP 28. Automatic Software Processing 

Completed

•	 Knit Simulation

•	 Click > Simulation Start

•	 Click > Knitting assist

•	 The file is OK to knit if no issues or fix if issues 

shown

•	 Copy .000 file to usb to knit



DESCRIPTION

DATE KNITTED

GROUND YARN 

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

INLAY YARN

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

MACHINE

HEAT METHOD

ISSUES

INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT

FORCES EVIDENT

FLAT SURFACE PLANE. NO FOLDING. NO VISIBLE MOVEMENT THE INLAY IS DOMINANT IN THE KNIT. STABLE WITH REDUCED STRETCH X & Y AXIS. LONGER FLOATS IN 200% ALLOW SLIGHTLY MORE STRETCH. TECHNICAL BACK IS THE PATTERN INVERSE. 
TECHNICAL BACK OF REGULAR TWILL 1 & 2 MIRROR ON Y AXIS.

FORCES ARE BALANCED. SYMMETRICAL SURFACE. THE INLAY IS DOMINANT. 

KISS

COTTON with NYLON CORE

1/16

1

14

SINGLE JERSEY KNITTED BASE WITH INLAY

11.10.19

BLOCK TWILL100% BLOCK TWILL 200% TWILL REGULAR 1 TWILL REGULAR 2

SRY123 LPSV 14G

STEAM

NO ISSUES YARN RUNS WELL

WOOLYARNS

WOOL / ACRYLIC

2/36

1

13

APPENDIX C. 
Inlay Pattern Surface-building Block Library
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DESCRIPTION

DATE KNITTED

GROUND YARN 

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

INLAY YARN

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

MACHINE

HEAT METHOD

ISSUES

INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH

TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT

FORCES EVIDENT

14

SINGLE JERSEY KNITTED BASE WITH INLAY

11.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36

1

13

KISS

COTTON with NYLON CORE

1/16

1

SRY123 LPSV 14G

STEAM

NO ISSUES YARN RUNS WELL

FLAT SURFACE PLANE. NO FOLDING. NO VISIBLE MOVEMENT THE INLAY IS DOMINANT IN THE KNIT. STABLE WITH REDUCED STRETCH X & Y AXIS. LONGER FLOATS IN 200% ALLOW SLIGHTLY MORE STRETCH. TECHNICAL BACK IS THE PATTERN INVERSE. TWILL IN 
TECHNICAL BACK OF REGULAR TWILL 3 MIRRORS ON Y AXIS.

FORCES ARE BALANCED. SYMMETRICAL SURFACE. THE INLAY IS DOMINANT. 

REGULAR TWILL 3 DORNICK TWILL 100% DORNICK TWILL 200% PLAIN DICED 1
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DESCRIPTION

DATE KNITTED

GROUND YARN 

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

INLAY YARN

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

MACHINE

HEAT METHOD

ISSUES

INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH

TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT

FORCES EVIDENT

14

SINGLE JERSEY KNITTED BASE WITH INLAY

11.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36

1

13

KISS

COTTON with NYLON CORE

1/16

1

DIAMOND TWILL 1 DIAMOND TWILL 2 200%DIAMOND TWILL 2DIAMOND TWILL 1 200% in X axis only

SRY123 LPSV 14G

STEAM

NO ISSUES YARN RUNS WELL

FLAT SURFACE PLANE. NO FOLDING. NO VISIBLE MOVEMENT THE INLAY IS DOMINANT IN THE KNIT. STABLE WITH REDUCED STRETCH X & Y AXIS. LONGER FLOATS IN 200% ALLOW SLIGHTLY MORE STRETCH. TECHNICAL BACK IS THE PATTERN INVERSE. 

FORCES ARE BALANCED. SYMMETRICAL SURFACE. THE INLAY IS DOMINANT. 
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DESCRIPTION

DATE KNITTED

GROUND YARN 

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

INLAY YARN

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

MACHINE

HEAT METHOD

ISSUES

INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH

TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT

FORCES EVIDENT

14

SINGLE JERSEY KNITTED BASE WITH INLAY

11.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36

1

13

KISS

COTTON with NYLON CORE

1/16

1

SRY123 LPSV 14G

STEAM

NO ISSUES YARN RUNS WELL

FLAT SURFACE PLANE. NO FOLDING. NO VISIBLE MOVEMENT THE INLAY IS DOMINANT IN THE KNIT. STABLE WITH REDUCED STRETCH X & Y AXIS. LONGER FLOATS IN 200% ALLOW SLIGHTLY MORE STRETCH. ANGLE OF TWILL IN TECHNICAL BACK OF 
IIREGULAR TWILL MIRRORS ON Y AXIS.

FORCES ARE BALANCED. SYMMETRICAL SURFACE. THE INLAY IS DOMINANT.  TECHNICAL BACK IS THE PATTERN INVERSE. 

DIAMOND TWILL 3 IRREGULAR TWILL 1CRYSTAL TWILL 1 200%CRYSTAL TWILL 1
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DESCRIPTION

DATE KNITTED

GROUND YARN 

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

INLAY YARN

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

MACHINE

HEAT METHOD

ISSUES

INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH

TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT

FORCES EVIDENT

14

SINGLE JERSEY KNITTED BASE WITH INLAY

11.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36

1

13

KISS

COTTON with NYLON CORE

1/16

1

SRY123 LPSV 14G

STEAM

NO ISSUES YARN RUNS WELL

FLAT SURFACE PLANE. NO FOLDING. NO VISIBLE MOVEMENT THE INLAY IS DOMINANT IN THE KNIT. STABLE WITH REDUCED STRETCH X & Y AXIS. TECHNICAL BACK IS THE PATTERN INVERSE. 

FORCES ARE BALANCED. SYMMETRICAL SURFACE. THE INLAY IS DOMINANT. 

PLAIN CREPE 1 PLAIN CREPE 4PLAIN CREPE 3PLAIN CREPE 2
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DESCRIPTION

DATE KNITTED

GROUND YARN 

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

INLAY YARN

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

MACHINE

HEAT METHOD

ISSUES

INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH INLAY CODE REPEAT UNIT SWATCH

TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT

FORCES EVIDENT

14

SINGLE JERSEY KNITTED BASE WITH INLAY

11.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36

1

13

KISS

COTTON with NYLON CORE

1/16

1

SRY123 LPSV 14G

STEAM

NO ISSUES YARN RUNS WELL

FLAT SURFACE PLANE. NO FOLDING. NO VISIBLE MOVEMENT THE INLAY IS DOMINANT IN THE KNIT. STABLE WITH REDUCED STRETCH X & Y AXIS. LONGER FLOATS IN 200% ALLOW SLIGHTLY MORE STRETCH. ALL TWILL ANGLES ARE MIRRORED IN Y AXIS. PLAIN CREPE 5 
IS THE ONLY TECHNICAL BACK WITH SIGNIFICANT CHANGE DUE TO LONG FLOATS BETWWEN ANGLED SINGLE POINTS OF INLAY.  TECHNICAL BACK IS THE PATTERN INVERSE. 

FORCES ARE BALANCED. SYMMETRICAL SURFACE. THE INLAY IS DOMINANT. 

PLAIN CREPE 5 PLAIN GRID 2 PLAIN GRID 1 
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE SQUARE BLOCK 100% SQUARE BLOCK 200% SQUARE BLOCK 300% SQUARE BLOCK 400% SQUARE BLOCK 500%

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK

SURFACE MOVEMENT
GOOD QUALITY AND HANDLE, LESS SURFACE 
MOVEMENT DUE TO MORE STABLE AREAS AND 
FEWER CHANGES OF STITCH STRUCTURE

FORCES EVIDENT

SQUARE BLOCK REPEAT

21.9.19

WOOLYARNS

WOOL / ACRYLIC

2/36

1

13

252 x 282

CONVERGENT FORCES IN MULTIPLE DIRECTIONS CAUSING SURFACE MOVEMENTS UP (CRESTS) 
AND DOWN (TROUGHS). TORSIONS ARE OCCURING ON DIAGONAL SIDES OF THE SQUARES THIS 
IS FORCING THE FABRIC UP AND DOWN.TOWARDS THE CENTRE OF THE PANEL THE 
COMPRESSIONAL FORCES FROM THE LEFT AND RIGHT COLLIDE 

CONVERGENT FORCES IN MULTIPLE DIRECTIONS HOWEVER LESS MOVEMENT THAN SMALLER SCALES SAMPLES NOT AS INTERESTING VISUALLY DUE 
TO THE INCREASED STABLE AREAS OF KNITTING THE OPPOSING FORCES HAVE REDUCED AND THE SURFACE IS NOT AS TEXTURAL A

SLIGHTLY LOOSE KNITTING NEED TO TIGHTEN UP STITCH QUALITY. SLIGHTLY RAISED SURFACE. MULTI DIRECTIONAL MOVEMENT. 

SRY123 LPSV 14G

STEAMED 

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A SQUARE ARRANGEMENT WITH A BLOCK REPEATING PATTERN TO SEE HOW THE KNIT REACTS / FOLDS. 

SLIGHTLY LOOSE KNITTING NEED TO TIGHTEN UP STITCH QUALITY.  STEAM THEREFORE RELAXATION OF YARN, LOSES SOME DEFINITION OF SURFACE TACTILITY

NO ISSUES YARN RUNS WELL

APPENDIX D. 
Links-Links Pattern Surface-building Block Library
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE SQUARE BRICK 100% SQUARE BRICK 200% SQUARE BRICK 300% SQUARE BRICK 400% SQUARE BRICK 500%

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK

SURFACE MOVEMENT
CLEARLY DEFINED ANTICLINES AND SYNCLINES 
AND A TIGHT FOLDED VERTICAL WAVE EFFECT. 

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

THE FOLDED CRESTS HAVE MOVED FURTHER APART AND SIT FLATTER, BROADER FOLDS. THERE ARE VARYING LEVELS OF RAISED AREAS CREATED BY THE STAGGERED PURL STRUCTURES  BETWEEN 
THE VERTICAL WAVES OF KNIT STITCHES. 

HORIZONTAL CONVERGENT FORCES CREATE 'S" VERTICAL WAVES FROM RAISED PURL STITCHES. 

13

252 x 282

SRY123 LPSV 14G

STEAMED 

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A SQUARE ARRANGEMENT WITH A BRICK REPEATING PATTERN TO SEE HOW THE KNIT REACTS / FOLDS. 

GOOD STITCH QUALITY AND HANDE.   STEAM THEREFORE RELAXATION OF YARN, LOSES SOME DEFINITION OF SURFACE TACTILITY

1

SQUARE BRICK REPEAT

21.9.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE SQUARE HALF DROP 100% SQUARE HALF DROP 200% SQUARE  HALF DROP 300% SQUARE HALF DROP 400% SQUARE HALF DROP 500%

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK

SURFACE MOVEMENT d

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

THE FOLDED PURL CRESTS MOVE FURTHER APART AND SIT FLATTER, BROADER FOLDS. STILL SYMMETRICAL APPEARANCE WITH TWISTED EFFECT ON THE HORIZONTAL WAVE SECTIONAL EDGES

VERTICAL CONVERGENT FORCES ARE CAUSING THE FABRIC TO FOLD A HORIZONTAL WAVE OF PURL STITCHES

13

252 x 282

SRY123 LPSV 14G

STEAMED 

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A SQUARE ARRANGEMENT WITH A HALF DROP REPEATING PATTERN TO SEE HOW THE KNIT REACTS / FOLDS. 

GOOD STITCH QUALITY AND HANDE.   STEAM THEREFORE RELAXATION OF YARN, LOSES SOME DEFINITION OF SURFACE TACTILITY

1

SQUARE HALF-DROP REPEAT

21.9.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE HORIZONTAL REC BLOCK 100% HORIZONTAL REC BLOCK 200% HORIZONTAL REC BLOCK 300% HORIZONTAL REC BLOCK 400% HORIZONTAL REC BLOCK 500%

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK

SURFACE MOVEMENT

 SLIGHTLY RAISED TEXTURAL SURFACE. TIGHT 
FOLDS AND SMALL TWISTS. SCALE IS TOO 
SMALL, VISUALLY 'MESSY'. TECHNICAL BACK IS 
SAME BUT ANGLE DIRECTION FLIPS.

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

RAISED TEXTURAL SURFACE GENERATED THROUGH FOLDS AND TWISTS.   BROAD FOLDS WITH TORSIONS / TWISTS OCCURING ON DIAGONAL SIDES OF THE RECTANGLES THIS IS FORCING THE 
FABRIC INTO CRESTS AND TROUGHS.  MULTI DIRECTIONAL SURFACE MOVEMENTS. TECHNICAL BACK IS SAME BUT ANGLED DIRECTION FLIPS.

VERTICAL CONVERGENT FORCES CAUSING TIGHT SHORT FOLDS SHIFTING INTO SLIGHTLY BROADER FOLDS AS THE SCALE INCREASES. THE COMPRESSIONAL FORCES ARE UNBALANCED. 

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A RECTANGLE ARRANGEMENT WITH A BLOCK REPEATING PATTERN TO SEE HOW THE KNIT REACTS / FOLDS. 

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

HORIZONTAL RECTANGLE BLOCK REPEAT

30.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE HORIZONTAL REC BRICK 100% HORIZONTAL REC BRICK 200% HORIZONTAL REC BRICK 300% HORIZONTAL REC BRICK 400% HORIZONTAL REC BRICK 500%

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK

SURFACE MOVEMENT
 SLIGHTLY RAISED TEXTURAL SURFACE. MULTI 
DIRECTIONAL MOVEMENT. SCALE IS TOO 
SMALL, VISUALLY 'MESSY'.

FORCES EVIDENT
CONVERGENT FORCES CAUSING TIGHT SHORT 
FOLDS. 

NO ISSUES YARN RUNS WELL

 SLIGHTLY RAISED TEXTURAL SURFACE. MULTI DIRECTIONAL MOVEMENT. FABRIC HAS A DEFINITE DISTORTED SLANT ON SURFACE FACE. HEM VISIBLY DISTORTED ASYMMETRICALLY. THE 
COMPRESSIONAL FORCES ARE UNBALANCED CREATING  UNEVEN SURAFCE MOVEMENTS. THE TWISTS GENERATED HAVE AN APPEALING TACTILITY AND THE FOLDS HIDE MORE FABRIC

CONVERGENT FORCES. TORSIONS / TWISTS ARE OCCURING ON DIAGONAL SIDES OF THE RECTANGLES THIS IS FORCING THE FABRIC UP AND DOWN IN FOLDS. 

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A RECTANGLE ARRANGEMENT WITH A BRICK REPEATING PATTERN TO SEE HOW THE KNIT REACTS / FOLDS. 

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

HORIZONTAL RECTANGLE BRICK REPEAT

30.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE HORIZONTAL REC HALF DROP 100% HORIZONTAL REC HALF DROP 200% HORIZONTAL REC HALF DROP 300% HORIZONTAL REC HALF DROP 400% HORIZONTAL REC HALF DROP 500%

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK

SURFACE MOVEMENT
SCALE IS TOO SMALL, VERY TIGHT SMALL FOLDS 
AND TWISTS. THESE TWISTS ARE ALIGNING 
VERTICALLY. TEXTURALLY FLATTENED SURFACE 

 SLIGHTLY RAISED TEXTURAL SURFACE. TWISTS 
ARE ALIGNING VERTICALLY WITH SLIGHT ANGLE. 

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

 RAISED TEXTURAL SURFACE. BROADER FOLDS AND LARGER TWISTS. TWISTS ARE LINEAR ALIGNING VERTICALLY WITH SLIGHT ANGLE. 

VERTICAL CONVERGENT FORCES ARE INCREASING THE FABRIC WIDTH AND REDUCING THE LENGTH

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A RECTANGLE ARRANGEMENT WITH A HALF DROP REPEATING PATTERN TO SEE HOW THE KNIT REACTS / FOLDS. 

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

HORIZONTAL RECTANGLE HALF DROP REPEAT

30.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT FOR 100% VERTICAL REC BLOCK 100% VERTICAL REC BLOCK 200% VERTICAL REC BLOCK 300% VERTICAL REC BLOCK 400% VERTICAL REC BLOCK 500%

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK

SURFACE MOVEMENT

 RAISED TEXTURAL SURFACE. TORSIONS 
GENERATED BY POINT OF STITCH STRUCTURE 
CHANGE.MULTI DIRECTIONAL MOVEMENT. HEM 
VISIBLY DISTORTED ASYMMETRICALLY

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

CONVERGENT FORCES IN MULTIPLE DIRECTIONS. THE COMPRESSIONAL FORCES ARE UNBALANCED FROM LEFT AND RIGHT SIDES

 SLIGHTLY RAISED TEXTURAL SURFACE. MULTI DIRECTIONAL MOVEMENT. 100% SCALE IS TOO 
SMALL, VISUALLY 'MESSY'. SMALL TORSIONS GENERATED BY POINT OF STITCH STRUCTURE 
CHANGE.

 RAISED TEXTURAL SURFACE. TORSIONS GENERATED BY POINT OF STITCH STRUCTURE CHANGE. 
MULTI DIRECTIONAL MOVEMENT. FABRIC HAS A DEFINITE SLANT ON SURFACE FACE. TECHNICAL 

BACK IS SAME BUT ANGLE DIRECTION FLIPS.

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A RECTANGLE ARRANGEMENT WITH A BLOCK REPEATING PATTERN TO SEE HOW THE KNIT REACTS / FOLDS. 

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

VERTICAL RECTANGLE BLOCK REPEAT

21.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE VERTICAL REC BRICK 100% VERTICAL REC BRICK 200% VERTICAL REC BRICK 300% VERTICAL REC BRICK 400% VERTICAL REC BRICK 500%

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK

SURFACE MOVEMENT

VERY TEXTURAL APPEARANCE.  TIGHT FOLDS. 
FLATTENED SURFACE DUE TO THE CLOSE SET 
PURL RIDGES. THE SURFACE SECTIONS 
CONCERTINA TOGETHER.

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

COMPRESSIONAL MOVEMENT IN THE HORIZONTAL DIRECTION IS CAUSING EVEN VERTICAL LINEAR VISUAL EFFECT. 

 SLIGHTLY RAISED TEXTURAL SURFACE. MOSTLY BALANCED FOLDED MOVEMENT. FOLDS BECOME BROAD IN 500% SCALE. THE WIDTH OF THE KNIT SIGNIFICANTLY REDUCES AS THE LENGTH 
ELONGATES. HORIZONTAL CONVERGENT FORCES RESULT IN TIGHTLY FOLDED RIDGES OF PURL TEXTURED SURFACE AND ALTERNATIVELY FLIPPED KNIT SECTIONS. THE SURFACE SECTIONS 
CONCERTINA TOGETHER. TECHNICAL BACK IS SAME BUT ANGLE DIRECTION OF PURL RIDGE FLIPS.

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A RECTANGLE ARRANGEMENT WITH A BRICK REPEATING PATTERN TO SEE HOW THE KNIT REACTS / FOLDS. 

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

VERTICAL RECTANGLE BRICK REPEAT

21.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE VERTICAL REC HALF DROP 100% VERTICAL REC HALF DROP 200% VERTICAL REC HALF DROP 300% VERTICAL REC HALF DROP 400% VERTICAL REC HALF DROP 500%

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK

SURFACE MOVEMENT

CLEARLY DEFINED ANTICLINES AND SYNCLINES 
AND A TIGHT FOLDED HORIZONTAL PURL WAVE 
EFFECT. THE FOLDS FLIP FACING DOWN OR UP 
THE FABRIC DEPENDING ON IF SWITCHING 
STITCH STRUCTURE FROM KNIT TO PURL OR 
PURL TO KNIT

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

ANTICLINES AND SYNCLINES AND A FOLDED WAVE EFFECT. INCREASED SCALE CAUSES THE FOLDED CRESTS TO MOVE  APART AND SIT FLATTER, IN BROADER FOLDS. TWISTED EFFECT ON THE 
WAVE SIDE EDGES. SURFACE IS MORE OPEN DUE TO THE INCREASED KNIT AND PURL STABLE AREAS

VERTICAL CONVERGENT FORCES ARE FORCING THE FABRIC TO FOLD ALONG THE STAGGERED LINES OF KNIT CREATING A  HORIZONTAL WAVE OF PURL STITCHES, A 3D CRESTED SURFACE

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A RECTANGLE ARRANGEMENT WITH A HALF DROP REPEATING PATTERN TO SEE HOW THE KNIT REACTS / FOLDS. 

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

VERTICAL RECTANGLE HALF DROP REPEAT

21.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE DIAMOND BLOCK 100% DIAMOND BLOCK 200% DIAMOND BLOCK 300% DIAMOND BLOCK 400% DIAMOND BLOCK 500%

TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK TECHNICAL FRONT & BACK

SURFACE MOVEMENT

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

A CRIMPED APPEARANCE. MOVEMENT IN THE VERTICAL AND HORIZONTAL DIRECTIONS. SIMILAR 
TO TRIANGLE BLOCK 100 EXCEPT A BIT LESS COMPRESSED. THIS SAMPLE IS A BIT 'MESSY' 
VISUALLY.

CONVERGENT FORCES IN HORIZONTAL DIRECTION. THE COMPRESSIONAL FORCES ARE REDUCED AND MORE UNBALANCED IN LARGER SCALES

MORE OPEN STRUCTURAL APPEARANCE. REDUCED SURFACE MOVEMENTTHAT  IS IRREGULAR. THIS SAMPLE IS TOO FLAT TO GENERATE THE 
SURFACE MOVEMENT THE PROJECT REQUIRES

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A VERTICAL DIAMOND (LONGER LENGTH THAN WIDTH) BLOCK REPEAT ARANGEMENT TO SEE HOW THE KNIT REACTS / FOLDS

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

DIAMOND BLOCK REPEAT

21.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE DIAMOND BRICK 100% DIAMOND BRICK 200% DIAMOND BRICK 300% DIAMOND BRICK 400% DIAMOND BRICK 500%

TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

MORE CONVERGENT FORCES THAN DIAMOND BRICK 100 IN VERTICAL DIRECTIONS CAUSING 
REGULAR  SURFACE MOVEMENT WITH GENERATION OF FOLDS ON A HORIZONTAL PLANE.  THESE 
FOLDS ARE A TIGHT CONCERTINA WITH GOOD ELASTICITY, HOLD AND RECOVERY BUT NOT 
MUCH TACTILITY

 THIS SAMPLE IS FAIRLY FLAT SURFACE APPEARANCE WITH PUCKERED MOVEMENT. IT HAS FEWER CONVERGENT FORCES DUE TO THE LARGER 
AREAS / RATIOS OF THE SAME KNIT STRUCTURE AND THEREFORE REDUCED OPPOSING FORCE AREAS.

CONVERGENT FORCES IN VERTICAL DIRECTION. THE COMPRESSIONAL FORCES ARE REDUCED AND MORE UNBALANCED IN LARGER SCALES

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A VERTICAL DIAMOND (LONGER LENGTH THAN WIDTH) BRICK REPEAT ARANGEMENT TO SEE HOW THE KNIT REACTS / FOLDS

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

DIAMOND BRICK REPEAT

21.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE DIAMOND HALF DROP 100% DIAMOND HALF DROP 200% DIAMOND HALF DROP 300% DIAMOND HALF DROP 400% DIAMOND HALF DROP 500%

TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

ON THE TECHNICAL FACE A TIGHTLY FOLDED HONEYCOMB OF RAISED SURFACE RIDGES. ZIG 
ZAGS IN THE VERTICAL DIRECTION. ON THE TECHNICAL BACK THE VERTICAL LINEAR APPEARANCE 
HAS ARROW HEAD-LIKE APPEARANCE. GOOD DIMENSIONALITY AND RECOVERY.

DISTORTED TEXTURED SURFACE, UNSTRUCTURED LESS DEFINED MOVEMENT. CRUMPLED APPEARANCE WITH LARGER UNPREDICATABLE OVERTURN 
FOLDS. SHEARING FORCES AS THE UNEQUAL FORCES SLIDE THE MATERIAL  IN MULTIAXIS DIRECTIONS AT ANGLES

HORIZONTAL CONVERGENT FORCES FROM THE SIDES. VERTICAL WAVES CREATED. COMPLEX 
FOLDS. SCALE 100% HAS BALANCED FORCES

UNEVEN OPPOSING CONVERGENT FORCES  WITHIN THE SURFACE. 

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

DIAMOND HALF-DROP REPEAT

21.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36

1

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A VERTICAL DIAMOND (LONGER LENGTH THAN WIDTH) HALF DROP REPEAT ARANGEMENT TO SEE HOW THE KNIT REACTS / FOLDS
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE TRIANGLE BLOCK 100% TRIANGLE BLOCK 200% TRIANGLE BLOCK 300% TRIANGLE BLOCK 400% TRIANGLE BLOCK 500%

TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT
A CRIMPED APPEARANCE. MOVEMENT IN THE 
VERTICAL AND HORIZONTAL DIRECTIONS

THE SURFACE IS FOLDING. DOMINANT PLEATS 
ARE IN OPPOSITE DIRECTION TO THE BASE, DUE 
TO TRIANGLE BECOMING WIDER AND SHORTER 
PROPORTIONALLY

FORCES EVIDENT

CONVERGENT FORCES IN HORIZONTAL AND 
VERTICAL DIRECTIONS CAUSING SURFACE 
MOVEMENTS UP AND DOWN AND GENERATING 
FOLDS IN A VERTICAL PLANE, THESE ARE 
TIGHTER FOLDS TOWARDS THE HEM. THIS 
SAMPLE IS A BIT 'MESSY' VISUALLY.

NO ISSUES YARN RUNS WELL

THE SURFACE IS FOLDING LARGER OVERFOLDS, THESE WAVES ARE FORMING FROM SIDE TO SIDE WITH VERTICAL SUBDUCTIONS. HERE ARE TWISTS 
THAT OCCUR IN THE INTERCHANGE AREAS OR TIPS / POINTS OF THE PURL TRIANGLES. THE SHAPING STEPS ARE MORE VISIBLE ON THE TECHNICAL 
BACK AS STITCH DETAILS. TECHNICAL BACK THE TRIANGLE FLIPS ON X AXIS

CONVERGENT FORCES STRONGER IN THE VERTICAL DIRECTIONS CAUSING FOLDS IN A HORIZONTAL PLANE. THE SAMPLE HAS BEEN COMPRESSED DOWN IN LENGTH INCREASING WIDTH. FORCES 
REDUCE AS SCALE INCREASES

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A TRIANGLE BLOCK REPEAT ARANGEMENT TO SEE HOW THE KNIT REACTS / FOLDS

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

TRIANGLE BLOCK REPEAT

21.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36

174



DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH 
QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE TRIANGLE BRICK 100% TRIANGLE BRICK 200% TRIANGLE BRICK 300% TRIANGLE BRICK 400% TRIANGLE BRICK 500%

TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT
A CRIMPED APPEARANCE. RESULTS IN A TIGHTLY 
FOLDED PURL TEXTURED SURFACE

MOVEMENT IN THE VERTICAL DIRECTIONS. 
RESULTS IN A TIGHTLY FOLDED PURL TEXTURED 
SURFACE WITH A WAVE LIKE APPEARANCE DUE 
TO SMALL CREST TIPS

FORCES EVIDENT

NO ISSUES YARN RUNS WELL

MOVEMENT IN THE VERTICAL DIRECTIONS. RESULTS IN A FOLDED PURL TEXTURED SURFACE WITH A WAVE LIKE APPEARANCE DUE TO SMALL CREST 
TIPS

CONVERGENT FORCES IN VERTICAL DIRECTIONS CAUSING SURFACE MOVEMENTS UP AND DOWN AND GENERATING A TIGHT SERIES OF SMALL FOLDS WHERE THE KNIT IS PUSHED UNDER THE PURL 

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A TRIANGLE BRICK REPEAT ARANGEMENT TO SEE HOW THE KNIT REACTS / FOLDS

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

TRIANGLE BRICK REPEAT

21.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36
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DESCRIPTION

DATE KNITTED

YARN COMPANY

         COMPOSITION

          COUNT

          NUMBER OF ENDS

          CARRIER

NEEDLES x COURSES

MACHINE

HEAT METHOD

REASON FOR KNITTING

ANALYSIS OF HANDLE / STITCH QUALITY

ISSUES

CODE REPEAT UNIT 100% SCALE TRIANGLE HALF DROP 100% TRIANGLE HALF DROP 200% TRIANGLE HALF DROP 300% TRIANGLE HALF DROP 400% TRIANGLE HALF DROP 500%

TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT TECHNICAL FRONT

TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK TECHNICAL BACK

SURFACE MOVEMENT

A CRIMPED APPEARANCE. MOVEMENT IN THE 
VERTICAL DIRECTIONS. RESULTS IN A TIGHTLY 
FOLDED PURL TEXTURED SURFACE. THE 
SURFACE SECTIONS CONCERTINA CLOSELY 
TOGETHER

FORCES EVIDENT
HORIZONTAL CONVERGENT FORCES ACROSS 
THE FABRIC 

VERTICAL CONVERGENT FORCES I

13

252 x 282

SRY123 LPSV 14G

UNSTEAMED

TO EXPLORE THE COMBINATION OF KNIT & PURL IN A TRIANGLE HALF DROP REPEAT ARANGEMENT TO SEE HOW THE KNIT REACTS / FOLDS

GOOD STITCH QUALITY AND HANDE.  HANDLE IS CRISP AND CRUNCHY WITH THE STITCH DEFINITION CLEAR AND SHARP DUE TO NO STEAM THEREFORE NO RELAXATION OF YARN

1

TECHNICAL FRONT HAS MOVEMENT IN THE VERTICAL & HORIZONTAL DIRECTIONS. RESULTS IN A BROADER STAGGERED FOLDED PURL SURFACE WITH PARALLEL STAGGERED  'S' WAVES DIVIDING 
THE SURAFCE AREAS OF REPEAT DUE TO THE DROP OF THE KNIT AND PURL OPPOSING FORCES COLLIDINGI N SMALL AREAS. TECHNICAL BACK HAS STAGGERED FOLDS. SHAPING STEPS VISIBLE ON 
REVERSE

TRIANGLE HALF DROP REPEAT

21.10.19

WOOLYARNS

WOOL / ACRYLIC

2/36

NO ISSUES YARN RUNS WELL
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•	 STEP 1. Select Photographic Image  

•	 STEP 3. Set Up a New Swatch in Automatic 

Software KnitPaint

•	 File > New

•	 Set up swatch the length and width required

•	 See Appendix E. How to Set up an All-Over 

Inlay Swatch 

       Steps 1-8

•	 STEP 4. Structure Page Sectional Division

•	 Draw directly on screen the divisions from the 

photograph

•	 This example uses linear division (straight lines)

•	 STEP 2. Divisions of Landscape

•	 Draw by hand sections for geometrics ground 

patterns

•	 If creating a small swatch only use part of the 

photograph

APPENDIX E.
How to Build an Intarsia Inlay Knitted Surface Topography



178

•	 STEP 6. Fill with Links-Links Ground Patterns

•	 Select ground patterns and scales from the Links-

Links Surface-building Block library (digital 

imagery or physical swatches)

•	 Or design pattern repeat unit on-screen to the 

right of red line

•	 STEP 5. Colour Block Sections

•	 Select a different colour for each section (or if 

using the same geometric ground more than 

once = use the same colour) 

•	 Use the Fill tool to fill each section with colour

•	 File > Save File as colour block version

 (It is easier to exchange links-links grounds in future 

iterations if you retain this as a separate file)

•	 STEP 7. Links-Links Ground Patterns

•	 Copy > Point the base unit for repeat from the 

corresponding KnitPaint digital file

•	 Place the base units to the right of the red line 

next to the colour it will fill

•	 STEP 8. Links-Links Ground Patterns 

•	 Fill colour blocks with links-links patterns 

•	 Use Base Pattern Repeat tool

•	 Click > Base pattern area

•	 Drag an area box around the unit repeat pattern 

•	 Click > Ok
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•	 STEP 10. Links-Links Ground Patterns 

•	 Click >Delete All to clear colours in Repeat Area

•	 Click > Add > use tab to add the colour to repeat 

onto

•	 Select only the colour required

•	 STEP 9.  Links-Links Ground Patterns 

•	 Click > Repeat Area

•	 Drag an area box around the area to repeat 

pattern into

•	 Click >OK

•	 STEP 11. Links-Links Ground Patterns 

•	 To fill with the inks-links repeat pattern

•	 Click > Exec

•	 STEP 12. Links-Links Ground Patterns 

•	 Repeat Steps 8 - 11 to fill all colour blocked areas 

with pattern

•	 Click > Cancel when completed
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•	 STEP 14. Set Up Inlay Pattern

•	 Select inlay pattern from Inlay Pattern Surface-

building Block Library (digital imagery or 

physical swatch)

•	 Or design pattern repeat unit on-screen to the 

right of red line

•	 STEP 13. Set Up Inlay Pattern 

•	 Open Inlay Colour Page

•	 STEP 15. Set Up Inlay Pattern

•	 Copy the base unit for repeat from the 

corresponding KnitPaint digital file

•	 Place the base unit to the right of the red line 

•	 STEP 16. Set Up Inlay Pattern

•	 Draw coloured blocks to fill with inlay repeating 

pattern

•	  The first block must be positioned on an even 

numbered course from the bottom of the panel

•	 There must be even number of courses between 

the blocks

•	 All blocks must contain an even number of 

courses
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•	 STEP 18. Set Up Inlay Pattern 

•	 Subtraction of inlay pattern 

•	 Use the Clear tool with colour black

•	 Vertical subtractions can be any amount but 

need to consider the floats between areas

•	 Horizontal subtractions must be even numbered 

amounts and have even numbered courses 

between inlay sections

•	 STEP 17. Set Up Inlay Pattern

•	 Use Base Pattern Repeat tool to fill with the inlay 

base unit repeat (see Steps 8-10 with geometric 

repeat)

•	 Must set the repeat area for inlay 2 needles in 

from both side edges

•	 Click > Exec

•	 Click > Cancel

•	 STEP 19. Check Inlay Positioning

•	 Use Area tool to check the inlay subtraction is 

correctly positioned 

•	 Check the number of course between sections 

and all the horizontal sections in a block

•	 STEP 20. Adjust Inlay Pattern Edges

•	 On the Structure page

•	 Click > Composite > pull down tab and select 

Colour Inlay page

•	 Use slider to adjust the opacity
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•	 STEP 22. Automatic Software Development  

•	 Click > Next

•	 STEP 21. Clear Stitch Structure on Vertical 

Inlay Edges 

•	 Change the structure 2 needle inside and outside 

the inlay pattern to front bed single jersey knit 

•	 Change on edges Code 2 = Green to Code 1 = 

Red 

•	 This prevents tearing at the intarsia inlay edge in 

the knitting stage

•	 STEP 23. Automatic Software Development

•	 Carrier Allocation Result

•	 Click > OK

•	 STEP 24. Automatic Software Development

•	 Warning Overwrite file

•	 Click > OK 

•	 S paint pattern making

•	 Click > Yes
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•	 STEP 26. Automatic Software Development

•	 This is the Developed page 

•	 This shows all the carrier information and the 

different pages that make up the programming 

information for the knit

•	 STEP 25. Automatic Software Development

•	  S paint pattern making

•	 Do you want to perform package development 

continuously?

•	 Click > Yes

•	 STEP 27. Automatic Software Processing

•	 Click > Automatic Software Process

•	 For full Automatic Software Processing steps for an 

automatic software  inlay swatch refer to Appendix 

B. Steps 20 - 28

•	 STEP 28. Automatic Software Processing 

Completed

•	 Click > Simulation start

•	 Click> Knitting assist

•	 Click > OK

•	 Copy .000 file to usb for knitting
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• STEP 1. Select Photographic Image

• Select an image with mutliple intersections

• Draw by hand sectional divisions for inlay

patterns

• If creating a small swatch only use part of the

photograph

• STEP 3. Set Up Rib Ground

• Select > Ground type > Wide rib

• Set the rib > e.g. 2x2

• Click > Next

• STEP 4. Set Up Rib Ground

• Do you want to use the same hem type as rib

pattern on the left edge of ground?

• Click > Yes

• See Appendix E. Steps 1-8 for completion of set

up of new swatch

• STEP 2. Set Up a New Swatch in Automatic

Software

• File >New

• Set up swatch size

• Click > Next

APPENDIX F.
How to Build a Rib Intarsia Inlay Knitted Surface Topography
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•	 STEP 5. Structure Page 

•	 Struacture page displays a rib ground stitch 

structure

•	 STEP 7. Set Up Inlay

•	 Frame inlay area

•	 Use Line tool to frame all the inlay edges to 

contain the colour when using the Fill tool

•	 STEP 8. Set Up Inlay

•	 Inlay Colour page sectional division

•	 Draw directly on screen the divisions from the 

photograph

•	 This example uses contoured division (curved 

lines)

•	 STEP 6. Set Up Inlay Pattern 

•	 Open Inlay > Inlay Colour page
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•	 STEP 10. Set Up Inlay 

•	 Clear the inlay swatch edges

•	 Inlay must sit inside side edges by minimum of 

two needles

•	 Inlay must start 1 course up from the bottom and 

finish 1 course from the top of the swatch (or start 

on an even course and finish on an odd course0

•	 Change edges and any remaining contour lines 

•	 STEP 9. Set Up Inlay 

•	 Select 2 colours (inlay & inverse inlay areas) 

•	 Leave plain rib area black

•	 Use Fill tool to colour sections (each area must 

be enclosed)

•	 File > Save File as colour block version

 (It is easier to exchange inlay patterns in future 

iterations if you retain this as a separate file)

•	 STEP 11. Set Up Inlay 

•	 Colour Blocked for Inlay Pattern Fill

•	 STEP 12. Select Inlay Pattern

•	 Select inlay pattern from Inlay Surface-building 

Block library (digital imagery or physical swatch) 
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• STEP 14. Set Up Inverse Inlay

• Use Area tool > drag around the inlay repeat

unit

• Click > OK

• Use Copy tool > Arrow > Execute > Up >

Cancel > Cancel

• This ensures the inlay and inlay inverse will

align vertically

• STEP 13. Set Up Inlay

• Use Copy tool > Point

• Select and copy the base unit for repeat from the

corresponding KnitPaint digital file

• Place the base units to the right of the red line

next to the colour it will fill

• STEP 15. Set Up Inlay

• Set up inverse inlay pattern

• Select the inlay base unit repeat to be converted

to inverse inlay

• Use Area tool > Drag to select > OK

• Use Colour Change tool > Colour Exchange >

Multi

• Set the inlay colour to change to black

• Set the black to change to inlay colour

• Click > Exec

• STEP 16. Set Up Inlay

• Inlay pattern & inverse inlay pattern repeat units
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• STEP 18. Set Up Inlay

• Repeat Area > Drag a box over the entire swatch

area

• Click > OK

• STEP 17. Set Up Inlay

• Base Pattern Repeat tool

• Set Base Pattern Area > drag over inlay unit

repeat only

• Click > OK

• STEP 19. Set Up Inlay

• Delete All to clear colours in Repeat Area

• Click > Add icon > use tab to add the colour to

repeat onto

• Select only the colour required

• Click > Exec

• STEP 20. Set Up Inlay

• Fills all areas of the same colour with the selected

pattern
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•	 STEP 22. Automatic Software Development

•	 Click > Next

•	 STEP 21. Set Up Inlay 

•	 Repeat Steps 17-20 to fill with Inverse Inlay 

pattern

•	 STEP 23. Automatic Software Development

•	 Carrier Allocation result > OK

•	 STEP 24. Automatic Software Development

•	 Warning Overwrite file

•	 Click > Yes

•	 S Paint Pattern Making

•	 Do you want to perform package development 

continuously?

•	 Click > Yes
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•	 STEP 26. Automatic Software Development

•	 This is the Developed page

•	 STEP 25. Automatic Software Development

•	  Move, Cable Spearation

•	 Leave as default settings

•	 Click > Exec

•	 STEP 23. Automatic Software Processing

•	 Click > Automatic Software Setting

•	 Click > Execute Auto

•	 For full Automatic Processing settings for an inlay 

swatch refer to Appendix B. Steps 20 - 28

•	 STEP 24. Automatic Software Processing 

Completed

•	 Click > Simulation start

•	 Click> Knitting assist

•	 Click > OK

•	 Copy .000 file to usb for knitting
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•	 STEP 1. Select Photographic Image  

•	 STEP 3. Set Up an Old-format Page in KnitPaint

•	 Use Create page > Set up a basic old-format 

swatch the size required using correct packages 

then add option lines (information on basic 

swatch set up is available in the Shima Seiki 

KnitPaint Help menu)

•	 This is the Compressed Pattern

•	 STEP 4. Create the Design Pattern

•	 Use Copy tool > Drag area over the Compressed 

Pattern

•	 Use Arrow Up

•	 Click > Cancel

•	 This is the Design Pattern where the ground and 

inlay codes are assembled

•	 STEP 2. Divisions of Landscape

•	 Draw by hand sectional divisions for geometrics 

ground patterns

•	 If creating a small swatch only use part of the 

photograph

APPENDIX G.
How to Build a Double Bed Inlay Knitted Surface Topography
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•	 STEP 6. Colour Block Sections

•	 Select a different colour for each section (or if 

using the same geometric ground more than 

once = use the same colour) 

•	 Use the Fill tool to fill each section with colour

•	 Use Copy tool > Arrow > Left 

•	 Place the copy of the colour blocked stage to the 

left of the actual design pattern (It is easier to 

exchange geometric grounds in future iterations 

if you retain this as a separate copy)

•	 STEP 5. Draw Divisions from Photograph

•	 Draw on the Design Pattern the section linear 

divisions

•	 Use Line tool > Line mode > Free

•	 Use colour code 201 (this is the double bed 

ground PAK code colour) & only draw onto the 

colour code 200 

•	 STEP 7.  Select Geometric Ground Patterns

•	 Select patterns and scales from the Links-Links 

Surface-building Block library (digital imagery 

or physical swatches)

•	 Place the pattern repeat unit on-screen to the left 

of the compressed pattern and design pattern

•	 STEP 8. Change to PAK Colour Codes 

•	 You must change the colour codes of the 

geometric patterns to 200 & 201 for the double 

bed knitting PAKs

•	 Use Colour Change tool > Colour Exchange > 

Multi

•	 Exchange colour code 1 = 200 & 2=201

•	 Click > Exec then Click > Cancel
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•	 STEP 10. Fill with Geometric Patterns

•	 Click > Repeat Area

•	 Drag an area box around the area to repeat the 

pattern into on the DesignPpattern

•	 Click > OK

•	 STEP 9. Fill with Geometric Patterns

•	 Use > Base Pattern Repeat Tool 

•	 Click > Base pattern area

•	 Drag an area box around the unit repeat pattern 

•	 Click > OK

•	 STEP 11. Fill with Geometric Patterns 

•	 Click >Delete All to clear colours in Repeat Area

•	 Click > Add > use tab to add the colour to repeat 

onto

•	 Select only the colour required to pattern copy 

on to

•	 STEP 12. Fill with Geometric Patterns

•	 To complete the fill with the geometric pattern

•	 Click > Exec
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•	 STEP 14. Set Up Inlay Pattern

•	 Select inlay pattern from Inlay Surface-building 

Block library (digital imagery or physical swatch)

•	 Or design pattern repeat unit on-screen to the 

left of the Compressed Pattern

•	 STEP 13. Fill with Geometric Patterns

•	 Repeat Steps 9 - 12 to fill all colour blocked areas 

with pattern

•	 Click > Cancel when completed

•	 STEP 15. Creating Inlay Pattern Directly On-

screen

•	 The double bed inlay must use the colour codes 

from the PAK

•	 Colour codes for this example are set as 202/ 203 

/ 3 & 3

•	 These muse be in the correct order

•	 Each group of 4 codes = 1 inlay exposed point

•	 These groups must be surrounded by a minimum 

of one grid square of colour code 0 on all sides

•	 Create the base unit repeat

•	 STEP 16. Set Up Inlay Pattern

•	 Create the full inlay design to the left of 

compressed pattern

•	 Set up a frame the size of the swatch to define the 

pattern area

•	 Use Clear tool > Set up inlay blocks to position 

pattern

•	 Inlay must be a minimum of 2 needles in from 

the edges of textile
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•	 STEP 18. Set Up Inlay Pattern

•	 Check all inlay is 4 code groups

•	 Use the Clear tool to remove partial groups

•	 Tick Colour 0 = black > to remove any part 

coded colours

•	 STEP 17. Set Up Inlay Pattern

•	 Use Base Pattern Repeat tool to fill with the inlay 

base unit repeat (see Steps 9-11 with geometric 

repeat)

•	 Click > Exec

•	 Click > Cancel

•	 STEP 19. Set Up Inlay Pattern

•	 Subtraction of inlay pattern 

•	 Use the Clear tool with colour black

•	 Vertical subtractions must remove full PAK code 

groups

•	 Horizontal subtractions must remove full PAK 

code groups

•	 STEP 20. Set Up Inlay Pattern

•	 Position inlay on top of ground geometrics in 

Design Pattern 

•	 Use Area tool > drag a box around the inlay set 

up > OK

•	 Use Copy tool > Point Set 

•	 Select Upper > Clear Colour > Colour 0 = black 

•	 Click > Execute
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•	 STEP 22. Set Up Inlay Pattern

•	 Check all inlay pattern edges

•	 Clear around the inlay > Change the ground to 

code 200 anywhere there is are inlay codes

•	 1 course above and below

•	 2 needles on the side edges

•	 Use Fill tool & Line tool

•	 STEP 21. Set Up Inlay Pattern

•	 The inlay and ground geometrics are now 

positioned together on the same layer

•	 STEP 23.  Pattern Development

•	 Copy the compressed pattern

•	 Use Area tool > drag a box over the Compressed 

Pattern > OK

•	 Use Copy tool > Arrow > Right

•	 Click > Cancel

•	 STEP 24. Pattern Developentt

•	 Save the Package (PAK) files

•	 Click PACK > Package File Parameter
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•	 STEP 26. Pattern Development

•	 Click > Exec

•	 Drag an area around the packages

•	 Click > OK

•	 STEP 25. Pattern Development

•	 Browse and set up a PAK folder > OK

•	 File name = PACK

•	 File No. = 1

•	 Tick > Draw code

•	 Tick > Package table auto make

•	 File name = FREE

•	 Tick > Multiple storage area

•	 Tick > Bottom start X-direction

•	 STEP 27.  Pattern Development

•	 Click > Create Pk. List

•	 Click > Cancel

•	 STEP 28. Pattern Development > Set up L3 Bar 

•	 Click > PACK > Package Development
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•	 STEP 30. Pattern Development > Set up L3 Bar 

•	 Normal tab

•	 Select > Paint Colour

•	 Option line draw method > Normal

•	 Compress > Normal

•	 Select > Loads on same window

•	 STEP 29. Pattern Development > Set up L3 Bar 

•	 Area pop up box > Click inside the Design 

Pattern 

•	 Click > OK

•	 STEP 31. Pattern Development > Set up L3 Bar 

•	 Colour Composition Tab

•	 Select > Group 7 (User Setting)

•	 STEP 32. Pattern Development > Set up L3 Bar 

•	 L3Bar colour code number = 41 

•	 Select > Group 7 (User setting) 

•	 Click > Add > pull down tab

•	 Set up colour 3 knits as a stitch code 3

•	 201 > colour 201 becomes stitch code 52 
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•	 STEP 34. Pattern Development > Set up L3 Bar 

•	 L3Bar colour code number = 43 

•	 Select > Group 7 (User setting) 

•	 Click > Add > pull down tab

•	 Set up colour 202 > colour 202 becomes stitch 

code 21

•	 Set up colour 203 > colour 203 becomes sticth 

code 34

•	 STEP 33. Pattern Development > Set up L3 Bar 

•	 L3Bar colour code number = 42 

•	 Select > Group 7 (User setting) 

•	 Click > Add > pull down tab

•	 Set up colour 201 > colour 201 becomes stitch 

code 51 (front knit 

•	 STEP 35. Pattern Development > Set up L3 Bar 

•	 L3Bar colour code number = 44 

•	 Select > Group 7 (User setting) 

•	 Click > Add > pull down tab

•	 Set up colour 202 > colour 202 becomes stitch 

code 31

•	 Set up colour 203 > colour 203 becomes sticth 

code 24

•	 STEP 36. Pattern Development > Set up L3 Bar 

•	 Click > Save Config (below Load config)

•	 Browse and find file folder

•	 Name of file

•	 Click > Save

•	 Click > Save Config (below Set Arrea)

•	 Click > Cancel
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•	 STEP 38. Package Development

•	 Composition Colour tab

•	 Load Cofig

•	 Find file > Select > Open

•	 Check correct information is in L3Bar Code No.

•	 STEP 37. Package Development  

•	 PACK > Package Development

•	 Click > Inside Compressed Pattern > OK

•	 STEP 39. Package Development

•	 Normal Tab 

•	 Click > Area

•	 Click > Inside Design Pattern > OK

•	 Click > Exec

•	 STEP 40. Package Development

•	 This creates the Epanded Pattern 
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•	 STEP 42. Automatic Processing

•	 Check Carriers Tab

•	 Need a minimum of 2 carriers for ground 

•	 Need 1 inlay carrier

•	 Need Carrier 8 & 18 (do not touch set up)

•	 Click > Execute

•	 STEP 41. Automatic Processing

•	 Click > Automatic Software Process 

•	 Click > Execute auto

•	 Click > Inside the Expanded Pattern > OK

•	 STEP 43. Automatic Processing

•	 Check Carrier TYpe tab

•	 Inlay carrier = N

•	 Ground Carriers = KSW0 (non swing) or KSW1 

(swing)

•	 Click > Execute

•	 Click > OK

•	 STEP 44. Automatic Processing Completed

•	 Click > Simulation start

•	 Click> Knitting assist

•	 Click > OK

•	 Copy .000 file to usb for knitting

•	 Save old-format > Save (Over write) 
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•	 STEP 1. Select Photographic Image  

•	 STEP 3. Divisions of Landscape

•	 Draw by hand sections for geometrics ground 

patterns

•	 STEP 3. Set Up Ground in Old-format

•	 Use Create page 

•	 Set width and height required

•	 Click > Exec

•	 STEP 2. Divisions of Landscape

•	 Separate the image into the number of vertical 

panels in the series

•	 Separate the image into four horizontal sections 

to help with on screen proportion

APPENDIX H.
How to Build an Intarsia Inlay Knitted Surface Topography Series
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•	 STEP 6. Set Up Ground in Old-format

•	 Divide Horizontally into Sections

•	 Use Line tool > divide horizontally into four 

even parts

•	 Save old-format > Save (Over write)  Blank Panel 

Set-Up

•	  Saving as a separate files during the process will 

allow you to use for the inlay panel set-up

•	 STEP 5. Set Up Ground in Old-format 

•	 Divide into Vertical Individual Panels

•	 Use Clear tool > draw rectangle half the length 

and the full width required for the multiple panels

•	 Use colour 0 = black > 2 needle width to separate 

into individual panels

•	 STEP 7. Set Up Ground in Old-format

•	 Draw Sections from Photograph

•	 Fill panels with a ground colour

•	 Draw across the mutilple panels the section 

divisions

•	 Draw half the panel only

•	 Use Line tool > Line mode > Free

•	 Save old-format > Save (Over write) > Geo 

Sections

•	 STEP 8. Set Up Ground in Old-format

•	 Colour block half the panel only

•	 Select a different colour for each ground 

geometric (or if using the same geometric ground 

more than once = use the same colour multiple 

times) 

•	 Use the Fill tool to fill each section with colour 

Select Geometrics
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•	 STEP 11. Set Up Ground in Old-format 

•	 Select ground links-links patterns

•	 Select patterns and scales from the Links-Links 

Surface-building Block library (digital imagery 

or physical swatches)

•	 STEP 10.  Set Up Ground in Old-format

•	 To colour block the full length of the panels

•	 Use Area tool > select around the colour blocked 

section 

•	 Click > OK

•	 Use Copy tool > Mirror > Arrow > Up

•	 Blend any odd intersections of colour blocking

•	 Save old-format > Save (Over write) > Colour 

Block Ground

•	 STEP 11. Set Up Ground in Old-format

•	 Place the links-links pattern repeat unit on-

screen to the right of the multiple panels next to 

the colour to fill  

•	 STEP 12. Set Up Ground in Old-format 

•	 Fill with links-links grounds

•	 Use Base Pattern Repeat Tool 

•	 Click > Base pattern area

•	 Drag an area box around the unit repeat pattern 

•	 Click > OK
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•	 STEP 14. Set Up Ground in Old-format

•	 Click >Delete All to clear colours in Repeat Area

•	 Click > Add > use tab to add the colour to repeat 

onto

•	 Select only the colour required to pattern copy 

onto

•	 STEP 13. Set Up Ground in Old-format

•	 Click > Repeat Area

•	 Drag an area box around the multiple panels

•	 Click > OK

•	 STEP 15. Set Up Ground in Old-format

•	 To complete the fill 

•	 Click > Exec

•	 STEP 16. Set Up Ground in Old-format

•	 Repeat Steps 12 - 15 to fill all colour blocked 

areas with geometric pattern

•	 Click > Cancel when completed

•	 Save old-format > Save (Over write) > Multiple 

Panel Grounds
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•	 STEP 18. Generate Inlay Positioning in 

Photoshop

•	 Image > Mode > Greyscale

•	 Discard Colour Information > Discard

•	 STEP 17. Generate Inlay Positioning in 

Photoshop

•	 Open image in Photoshop

•	 Separate the image into the number of vertical 

panels in the series

•	 Separate the image into four horizontal sections 

to help with on screen proportion

•	 STEP 19. Generate Inlay Positioning in 

Photoshop

•	 Use Image > Adjustments > Posterize

•	 Adjust to suit design

•	 STEP 20. Generate Inlay Positioning in 

Photoshop

•	 Print off the image and hand draw the positioning 

of the blocks of inlay 
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•	 STEP 22. Multiple Panel Inlay Set-Up in Old-

format

•	 Select inlay pattern from Inlay Surface-building 

Block library (digital imagery or physical swatch)

•	 Or design pattern repeat unit on-screen to the 

right of the multiple panels

•	 STEP 21. Multiple Panel Inlay Set-Up in Old-

format

•	 File > Open File > Blank Panel Set Up

•	 Frame the vertical panels with lines

•	 Use Line tool > divide horizontally into four 

even parts

•	 STEP 23. Multiple Panel Inlay Set-Up in Old-

format

•	 Place the inlay pattern repeat unit on-screen to 

the right of the multiple panels 

•	 Check the pattern repeat

•	 STEP 24. Multiple Panel Inlay Set-Up in Old-

format

•	 Transfer inlay position from image

•	 Colour block half the panel only

•	 The first block must be on an even numbered 

course from the bottom of the panel with an even 

number of courses between the blocks

•	 Clear all the panel side edges a minimum of 2 

needles

•	 All blocks must contain an even number of 

courses
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•	 STEP 26. Multiple Panel Inlay Set-Up in Old 

Format

•	 Use Base Pattern Repeat tool to fill with the inlay 

base unit repeat (see steps 12-16)

•	 Click > Exec

•	 Click > Cancel

•	 Check all panel edges minimum of 2 needles in 

are clear of inlay

•	 STEP 25. Multiple Panel Inlay Set-Up in Old 

Format

•	 Use Area tool > select colour blocked section > 

Click > OK

•	 Use Copy tool > Mirror > Arrow > Up

•	 Check positioning of the inlay in full length for 

even courses between blocks

•	 Save old-format > Save (Over write) > Colour 

Block Inlay

•	 STEP 27. Multiple Panel Inlay Set-Up in Old 

Format

•	 Subtraction of inlay pattern across panels

•	 Use the Clear tool with Colour 0 = black

•	 Vertical subtractions can be any amount but 

need to consider the floats between areas

•	 Horizontal subtractions must be even numbered 

amounts and have even numbered courses 

between inlay sections

•	 Save old format > Save (Over write) >Multiple 

Panel Inlay

•	 STEP 28. Surface Assemblage in Automatic 

Software

•	 Set Up a New Swatch in Automatic Software 

KnitPaint

•	 File > New

•	 Set up swatch the length and width required for 

1 panel

•	 See Appendix E. How to Set up an All-Over 

Inlay Swatch  Steps 1-8

•	 This is the Automatic Software Panel file
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•	 STEP 30. Surface Assemblage in Automatic 

Software

•	 Switch to the Automatic Software Panel file > 

Structure page 

•	 On the Structure page place the copy of the 

links-links ground panel

•	 STEP 29. Surface Assemblage in Automatic 

Software

•	 Go to the Multiple Panel Grounds page in old 

format 

•	 Use Area tool > select 1 panel > OK

•	 Use Copy tool > Point set > Execute

•	 STEP 31. Surface Assemblage in Automatic 

Software

•	 Go to the Multiple Inlay Panel page in old format 

•	 Use Area tool > drag a box to select 1 panel > 

OK

•	 Use Copy tool > Point set > Execute

•	 STEP 32. Surface Assemblage in Automatic 

Software 

•	 Switch to the Automatic Software Panel file > 

Inlay Colour page 

•	 On Inlay > Colour Inlay page place the copy of 

the inlay panel 
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•	 STEP 34. Surface Assemblage in Automatic 

Software

•	 Clear stitch structure on vertical inlay edges 

•	 Change on edges code 2 = green to code 1 = red 

•	 Change the structure 2 needle inside and outside 

the inlay pattern to front bed single jersey knit

•	 This prevents tearing at the intarsia inlay edge in 

the knitting stage

•	 STEP 33. Surface Assemblage in Automatic 

Software

•	 Check inlay pattern edges on the Structure Page

•	 Click > Composite > pull down tab and select 

Colour Inlay

•	 Use the slider to adjust the opacity

•	 STEP 35. Atomatic Software Development 

•	 Click > Next to start automatic software 

development

•	 STEP 36. Atomatic Software Development 

•	 Overwrite warning > OK

•	 This step takes considerable time as the file is so 

large please leave the computer to process
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•	 STEP 38. Atomatic Software Development 

•	 Move Cable Separation - Leave all settings as 

default

•	 Click > Exec

•	 STEP 37. Atomatic Software Development 

•	 S paint pattern making

•	 Click > Yes

•	 STEP 39. Sequential Knitting

•	 On the developed page in R1 add a single 200 

code for each segment of sequential knitting 

•	 The code 200  must be on an odd course so the 

knitting machine is knitting from the left hand 

side

•	 Place code 200 on single bed knitting only not 

inlay areas

•	 STEP 40.  Automatic Software Processing

•	 Click > Automatic Software Setting

•	 Click > Execute Auto
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•	 STEP 42. Automatic Software Processing

•	 Click > inside Field pattern >OK

•	 STEP 41. Automatic Software Processing

•	 Click > inside Structure pattern > OK

•	 STEP 43. Automatic Software Processing

•	 Auto Process parameters

•	 Check Fixed Data tab > Check Set up & Waste 

yarn carriers

•	 STEP 44. Automatic Software Processing

•	 Carrier tab

•	 Carrier 8 in use from the left and right (never 

adjust)

•	 Carriers 14 & 13 & 12 in use from the left 
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•	 STEP 46. Automatic Software Processing

•	 Yarn Type tab 

•	 Carrier 14 = Thick 

•	 Carrier 13 & 12 = Normal

•	 Click > Execute

•	 STEP 45. Automatic Software Processing

•	 Carrier tab

•	 Carrier 14 = N = Normal = Inlay carrier

•	 Carrier 13 & 12 = KSW0 = Non swing = Ground 

& Waste

•	 STEP 47. Automatic Software Processing

•	 Output data > OK

•	 This will pop up for every sequential file >

•	 Click > OK for each file

•	 STEP 48. Automatic Software Processing 

Completed

•	 Click > Simulation start

•	 The sequential files are listed

•	 Do not use Knitting Assist if the file is too large

•	 Copy .000 file to usb for knitting
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